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Preface
Rational ClearCase, a configuration management system, is designed to help software
development teams track the objects used in software builds. You can use base
ClearCase to create a customized configuration management environment, or you can
adopt the Unified Change Management (UCM) process.

About This Manual

This manual shows project managers how to set up and manage a configuration
management environment for their development team using either UCM or the
customizable features of base ClearCase.

Product-Specific Features

This manual describes Rational ClearCase and Rational ClearCase LT. ClearCase LT
does not include all features available in ClearCase. In addition, some user interfaces
are different in the two products. This manual uses the following label to call out
differences: Product Note. When used outside of a Product Note section, ClearCase
refers to both products.

Organization

The manual is divided into two parts:

■ Part 1: Working in UCM. Read this part if you plan to use UCM to implement your
team’s development process.

■ Part 2: Working in Base ClearCase. Read this part if you plan to use the base
ClearCase features to implement a customized development process for your
team.
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ClearCase Documentation Roadmap

More Information
Command Reference
Online documentation

Help files

Installation Guide

Administrator’s Guide
(Rational ClearCase/

Rational ClearCase LT)

Administrator’s Guide
(Rational ClearCase MultiSite)

Platforms Guide
(See online documentation)

Project 
Management

Orientation

Software
Development

Build 
Management Administration

Managing Software Projects

Introduction

Release Notes
(See online documentation)

Online tutorials

Developing Software

Building Software

OMAKE Guide
(Windows platforms)
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ClearCase LT Documentation Roadmap

More Information
Command Reference
Online documentation

Help files

Administration

Project 
Management

Orientation

Software
Development

Installation Guide (Rational Desktop Products)

Installation Guide (Rational Server Products)

Installation Guide (UNIX)

Administrator’s Guide

Managing Software Projects

Introduction

Release Notes
(See online documentation)

Online tutorials

See online documentation
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ClearCase Integrations with Other Rational Products

Integration Description Where it is documented

Base ClearCase-
ClearQuest

Associates change requests
with versions of ClearCase
elements.

ClearCase: Developing Software

ClearCase: Managing Software
Projects

ClearQuest: Administrator’s Guide

Base ClearCase-Apex Allows Apex developers to
store files in ClearCase.

Installing Rational Apex (UNIX)

Base ClearCase-
ClearDDTS

Associates change requests
with versions of ClearCase
elements.

ClearCase ClearDDTS Integration

Base ClearCase-
PurifyPlus

Allows developers to invoke
ClearCase from PurifyPlus.

PurifyPlus Help

Base ClearCase-
RequisitePro

Archives RequisitePro projects
in ClearCase.

RequisitePro User’s Guide

RequisitePro Help

Base ClearCase-Rose Stores Rose models in
ClearCase.

Rose Help

Base ClearCase-
Rose RealTime

Stores Rose RealTime models in
ClearCase.

Rose RealTime Toolset Guide

Rose RealTime Guide to Team
Development

Base ClearCase-SoDA Collects information from
ClearCase and presents it in
various report formats.

Using Rational SoDA for Word

Using Rational SoDA for Frame

SoDA Help

Base ClearCase-XDE Stores XDE models in
ClearCase

XDE Help

UCM-ClearQuest Links UCM activities to
ClearQuest records.

ClearCase: Developing Software

ClearCase: Managing Software
Projects

ClearQuest: Administrator’s Guide

UCM-PurifyPlus Allows developers to invoke
ClearCase from PurifyPlus.

PurifyPlus Help
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Typographical Conventions

This manual uses the following typographical conventions:

■ ccase-home-dir represents the directory into which the ClearCase Product Family
has been installed. By default, this directory is /opt/rational/clearcase on UNIX and
C:\Program Files\Rational\ClearCase on Windows.

■ cquest-home-dir represents the directory into which Rational ClearQuest has been
installed. By default, this directory is /opt/rational/clearquest on UNIX and
C:\Program Files\Rational\ClearQuest on Windows.

■ Bold is used for names the user can enter; for example, command names and
branch names.

■ A sans-serif font is used for file names, directory names, and file extensions.

UCM-RequisitePro Allows RequisitePro
administrators to create
baselines of RequisitePro
projects in UCM, and to create
RequisitePro projects from
baselines.

RequisitePro User’s Guide

RequisitePro Help

Using UCM with Rational Suite

UCM-Rose Stores Rose models in
ClearCase.

Rose Help

Using UCM with Rational Suite

UCM-Rose RealTime Associates activities with
revisions.

Rose RealTime Toolset Guide

Rose RealTime Guide to Team
Development

UCM-SoDA Collects information from
ClearCase and presents it in
various report formats.

Using Rational SoDA for Word

Using Rational SoDA for Frame

SoDA Help

UCM-TestManager Stores test assets in ClearCase. Rational TestManager User’s Guide

TestManager Help
Using UCM with Rational Suite

UCM-XDE Stores XDE models in
ClearCase

XDE Help

UCM-XDE Tester Stores XDE Tester Datastores in
ClearCase

XDE Tester Help

Integration Description Where it is documented
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■ A sans-serif bold font is used for GUI elements; for example, menu names and
names of check boxes.

■ Italic is used for variables, document titles, glossary terms, and emphasis.

■ A monospaced font is used for examples. Where user input needs to be
distinguished from program output, bold is used for user input.

■ Nonprinting characters appear as follows: <EOF>, <NL>.

■ Key names and key combinations are capitalized and appear as follows: SHIFT,
CTRL+G.

■ [ ] Brackets enclose optional items in format and syntax descriptions.

■ { } Braces enclose a list from which you must choose an item in format and syntax
descriptions.

■ | A vertical bar separates items in a list of choices.

■ ... In a syntax description, an ellipsis indicates you can repeat the preceding item
or line one or more times. Otherwise, it can indicate omitted information.

Note: In certain contexts, you can use “...” within a pathname as a wildcard, similar
to “*” or “?”. For more information, see the wildcards_ccase reference page.

■ If a command or option name has a short form, a “medial dot” ( ⋅ ) character
indicates the shortest legal abbreviation. For example:

lsc⋅heckout 

Online Documentation

The ClearCase Product Family (CPF) includes online documentation, as follows:

Help System: Use the Help menu, the Help button, or the F1 key. To display the contents
of the online documentation set, do one of the following:

■ On UNIX, type cleartool man contents

■ On Windows, click Start > Programs > Rational Software > Rational ClearCase >
Help

■ On either platform, to display contents for Rational ClearCase MultiSite, type
multitool man contents

■ Use the Help button in a dialog box to display information about that dialog box or
press F1.
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Reference Pages: Use the cleartool man and multitool man commands. For more
information, see the man reference page.

Command Syntax: Use the –help command option or the cleartool help command.

Tutorial: Provides a step-by-step tour of important features of the product. To start the
tutorial, do one of the following:

■ On UNIX, type cleartool man tutorial

■ On Windows, click Start > Programs > Rational Software > Rational ClearCase >
ClearCase Tutorial

PDF Manuals: Navigate to:

■ On UNIX, ccase-home-dir/doc/books

■ On Windows, ccase-home-dir\doc\books

Customer Support

If you have any problems with the software or documentation, please contact Rational
Customer Support by telephone, fax, or electronic mail as described below. For
information regarding support hours, languages spoken, or other support information,
click the Support link on the Rational Web site at www.rational.com.

Your
location

Telephone Facsimile Electronic mail

North
America

800-433-5444
toll free or
408-863-4000
Cupertino, CA

408-863-4194
Cupertino, CA
781-676-2460
Lexington, MA

support@rational.com

Europe,
Middle
East, and
Africa

+31-(0)20-4546-200
Netherlands

+31-(0)20-4546-201
Netherlands

support@europe.rational.com

Asia Pacific 61-2-9419-0111
Australia

61-2-9419-0123
Australia

support@apac.rational.com
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1Choosing Between
UCM and Base
ClearCase
Before you can start to use Rational ClearCase to manage the version control and
configuration needs of your development project, you need to decide whether to use
the out-of-the-box Unified Change Management (UCM) process or base ClearCase.
This chapter describes the main differences between the two methods from the project
management perspective.

The rest of this manual is organized into two parts. Part 1 describes how to manage a
project using UCM. Part 2 describes how to manage a project using the various tools in
base ClearCase.

Differences Between UCM and Base ClearCase

Base ClearCase consists of a set of powerful tools to establish an environment in which
developers can work in parallel on a shared set of files, and project managers can
define policies that govern how developers work together.

UCM is one recommended method of using ClearCase for version control and
configuration management. UCM is layered on base ClearCase. Therefore, it is possible
to work efficiently in UCM without having to master the details of base ClearCase.

UCM offers the convenience of an out-of-the-box solution; base ClearCase offers the
flexibility to implement virtually any configuration management solution that you
deem appropriate for your environment.

Branching and Creating Views

Base ClearCase uses branches to enable parallel development. A branch is an object that
specifies a linear sequence of versions of an element. Every element has one main
branch, which represents the principal line of development, and may have multiple
subbranches, each of which represents a separate line of development. For example, a
project team may use the main branch for new development work while using a
subbranch simultaneously for fixing a bug.

Subbranches can have subbranches. For example, a project team may designate a
subbranch for porting a product to a different platform. The team may then decide to
create a bug-fixing subbranch off that porting subbranch. Base ClearCase allows you
1



to create complex branch hierarchies. Figure 1 illustrates a multilevel branch hierarchy.
As a project manager in such an environment, you need to ensure that developers are
working on the correct branches. Developers work in views. A view is a work area for
developers to create versions of elements. Each view includes a config spec, which is a
set of rules that determines which versions of elements the view selects.

Figure 1 Branching Hierarchy in Base ClearCase

As project manager, you tell developers which rules to include in their config specs so
that their views access the appropriate set of versions.

UCM uses branches also, but you do not have to manipulate them directly because it
layers streams over the branches. A stream is a ClearCase object that maintains a list of
activities and baselines and determines which versions of elements appear in a
developer’s view. In UCM, a typical project contains one integration stream, which
records the project’s shared set of elements, and multiple development streams, in which
developers work on their parts of the project in isolation from the team. The project’s
integration stream uses one branch. Each development stream uses its own branch.
You can create a hierarchy of development streams, and UCM creates the branching
hierarchy to support those streams.

Although most customers use ClearCase to implement a parallel development
environment, UCM and base ClearCase also support serial development. In base
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ClearCase, you implement a serial development environment by having all developers
work on the same branch. In UCM, you create a single-stream project, which contains
one stream, the integration stream. All developers work on the integration stream
rather than on development streams. We recommend serial development only for very
small project teams whose developers work together closely.

As project manager of a UCM project, you need not write rules for config specs.
Streams configure developers’ views to access the appropriate versions on the
appropriate branches.

Using Components to Organize Files

As the number of files and directories in your system grows, you need a way to reduce
the complexity of managing them. In UCM you use components to simplify the
organization of your files and directories. The elements that you group into a
component typically implement a reusable piece of your system architecture. By
organizing related files and directories into components, you can view your system as
a small number of identifiable components, rather than one large set of directories and
files.

Creating and Using Baselines

A baseline identifies one version of every element in one or more components. You use
baselines to identify the set of versions of files that represent a project at a particular
milestone. For example, you may create a baseline called beta1 to identify an early
snapshot of a project’s source files.

Baselines provide two main benefits:

■ The ability to reproduce an earlier release of a software project

■ The ability to tie together the complete set of files related to a project, such as
source files, a product requirements document, a documentation plan, functional
and design specifications, and test plans

UCM automates the creation process and provides additional support for performing
operations on baselines. In base ClearCase, you can create the equivalent of a baseline
by creating a version label and applying that label to a set of versions.

In UCM, baseline support appears throughout the user interface because UCM
requires that you use baselines. When developers join a project, they must first
populate their work areas with the contents of the project’s recommended baseline.
This method ensures that all team members start with the same set of shared files. In
addition, UCM lets you set a property on the baseline to indicate the quality level of
the versions that the baseline represents. Examples of quality levels include “project
builds without errors,” “passes initial testing,” and “passes regression testing.” By
Chapter 1 - Choosing Between UCM and Base ClearCase 3



changing the quality-level property of a baseline to reflect a higher degree of stability,
you can, in effect, promote the baseline.

Managing Activities

In base ClearCase, you work at the version and file level. UCM provides a higher level
of abstraction: activities. An activity is a ClearCase object that you use to record the
work required to complete a development task. For example, an activity may be to
change a graphical user interface (GUI). You may need to edit several files to make the
changes. UCM records the set of versions that you create to complete the activity in a
change set. Because activities appear throughout the UCM user interface, you can
perform operations on sets of related versions by identifying activities rather than
having to identify numerous versions.

Because activities correspond to significant project tasks, you can track the progress of
a project more easily. For example, you can determine which activities were completed
in which baselines. If you use the UCM-ClearQuest integration, you gain additional
project management control, such as the ability to assign states and state transitions to
activities. You can then generate reports by issuing queries such as “show me all
activities assigned to Pat that are in the Ready state.”

Enforcing Development Policies

A key part of managing the configuration management aspect of a software project is
establishing and enforcing development policies. In a parallel development
environment, it is crucial to establish rules that govern how team members access and
update shared sets of files. Such policies are helpful in two ways:

■ They minimize project build problems by identifying conflicting changes made by
multiple developers as early as possible.

■ They establish greater communication among team members.

These are examples of common development policies:

■ Developers must synchronize their private work areas with the project’s
recommended baseline before delivering their work to the project’s shared work
area.

■ Developers must notify other team members by e-mail when they deliver work to
the project’s shared work area.

In base ClearCase, you can use tools such as triggers and attributes to create
mechanisms to enforce development policies. UCM includes a set of common
development policies, which you can set through the GUI or command-line interface
4 Managing Software Projects



(CLI). You can set these policies at the project and stream levels. In addition, you can
use triggers and attributes to create new UCM policies.
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2Understanding UCM
This chapter provides an overview of Unified Change Management (UCM), which is
available with Rational ClearCase. Specifically, it introduces the main UCM objects and
describes the tasks involved in managing a UCM project. Subsequent chapters describe
in detail the steps required to perform these tasks.

Overview of the UCM Process

In UCM, your work follows a cycle that complements an iterative software
development process. Members of a project team work in a UCM project. A project is
the object that contains the configuration information needed to manage a significant
development effort, such as a product release. A project contains one main shared
work area and typically multiple private work areas. Private work areas allow
developers to work on activities in isolation. The project manager and integrator are
responsible for maintaining the project’s shared work area. Work within a project
progresses as follows:

1 You create a project and identify an initial set of baselines of one or more
components. A component is a group of related directory and file elements, which
you develop, integrate, and release together. A baseline is a version of one or more
components.

2 Developers join the project by creating their private work areas and populating
them with the contents of the project’s baselines.

3 Developers create activities and work on one activity at a time. An activity records
the set of files that a developer creates or modifies to complete a development task,
such as fixing a bug. This set of files associated with an activity is known as a
change set.

4 When developers complete activities, and build and test their work in their private
work areas, they share their work with the project team by performing deliver
operations. A deliver operation merges work from the developer’s private work
area to the project’s shared work area.
9



5 Periodically, the integrator builds the project’s executable files in the shared work
area, using the delivered work.

6 If the project builds successfully, the integrator creates new baselines. In a separate
work area, a team of software quality engineers performs more extensive testing of
the new baselines.

7 Periodically, as the quality and stability of baselines improve, the integrator
adjusts the promotion level attribute of baselines to reflect appropriate milestones,
such as Built, Tested, or Released. When the new baselines pass a sufficient level of
testing, the integrator designates them as the recommended set of baselines.

8 Developers perform rebase operations to update their private work areas to include
the set of versions represented by the new recommended baselines.

9 Developers continue the cycle of working on activities, delivering completed
activities, updating their private work areas with new baselines.

Figure 2 illustrates the connection between the project management, development, and
integration cycles. This manual describes the steps performed by project managers and
integrators. See Developing Software for information about the steps performed by
developers.
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Figure 2 Project Manager, Developer, and Integrator Work Flows
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Creating the Project

To create and set up a project, you must perform the following tasks:

■ Create a repository for storing project information
■ Create components that contain the set of files the developers work on
■ Create baselines that identify the versions of files with which the developers start

their work

To use UCM with Rational ClearQuest, you must perform additional setup steps.

Creating a PVOB

ClearCase stores file elements, directory elements, derived objects, and metadata in a
repository called a versioned object base (VOB). In UCM, each project must have a
project VOB (PVOB). A PVOB is a special kind of VOB that stores UCM objects, such
as projects, activities, and change sets. A PVOB must exist before you can create a
project. Check with your site’s ClearCase administrator to see whether a PVOB has
already been created. For details on creating a PVOB, see Creating the Project VOB
(Windows) on page 76 or Creating the Project VOB (UNIX) on page 77.
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Organizing Directories and Files into Components

As the number of files and directories in your system grows, you need a way to reduce
the complexity of managing them. Components are the UCM mechanism for
simplifying the organization of your files and directories. The elements that you group
into a component typically implement a reusable piece of your system architecture. By
organizing related files and directories into components, you can view your system as
a small number of identifiable components, rather than as one large set of directories
and files.

The directory and file elements of a component reside physically in a VOB. The
component object resides in a PVOB. Within a component, you organize directory and
file elements into a directory tree. In Figure 3, the directory trees for the GUI, Admin,
and Reports components appear directly under the VOB’s root directory. You can
convert existing VOBs or directory trees within VOBs into components, or you can
create a component from scratch. For details on creating a component from scratch, see
Creating Components for Storing Elements on page 79. For details on converting a VOB
into a component, see Making a VOB into a Component on page 91.

Figure 3 VOB Containing Multiple Components

Shared and Private Work Areas

A work area consists of a view and a stream. A view is a directory tree that shows a
single version of each file in your project. A stream is a ClearCase object that maintains
a list of activities and baselines and determines which versions of elements appear in
your view.

VOBPVOB

Project A 

GUI 
Admin 

Reports 

Project B 

/Dev

GUI

Admin

Reports
Chapter 2 - Understanding UCM 13



A project contains one integration stream, which records the project’s baselines and
enables access to shared versions of the project’s elements. The integration stream and
a corresponding integration view represent the project’s main shared work area.

In a typical project, each developer has a private work area, which consists of a
development stream and a corresponding development view. The development stream
maintains a list of the developer’s activities and determines which versions of elements
appear in the developer’s view.

When you create a project from the UCM GUI, ClearCase creates the integration stream
for you. If you create a project from the command-line interface, you need to create the
integration stream explicitly. Developers create their development streams and
development views when they join the project. See Developing Software for information
on joining a project.

Stream Hierarchies

In the basic UCM process, the integration stream is the project’s only shared work area.
You may want to create additional shared work areas for developers who are working
together on specific parts of the project. You can accomplish this by creating a hierarchy
of development streams. For example, you can create a development stream and
designate it as the shared work area for developers working on a particular feature.
Developers then create their own development streams and views under the
development stream for this feature. The developers deliver work to and rebase their
streams to recommended baselines in the feature’s development stream. See Choosing
a Stream Strategy on page 34 for details on development stream hierarchies.

Single-Stream Projects

Although most customers use UCM to implement a parallel development
environment, UCM also supports serial development by letting you create a
single-stream project. A single-stream project contains one stream, the integration
stream. All developers work on the integration stream rather than on development
streams. Each developer has their own view. We recommend serial development only
for very small project teams whose developers work together closely. See Choosing a
Stream Strategy on page 34 for details on single-stream projects.

Starting from a Baseline

After you create project components or select existing components, you must identify
and recommend the baseline or baselines that serve as the starting point for the team’s
developers. A baseline identifies one version of every element visible in a component.
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Figure 4 shows baselines named BL1 and BL2 that identify versions in component A
and component B, respectively.

When developers join the project, they populate their work areas with the versions of
directory and file elements represented by the project’s recommended baselines.
Alternatively, developers can join the project at a feature-specific development stream
level, in which case they populate their work areas with the development stream’s
recommended baselines. This practice ensures that all members of the project team
start with the same set of files.

If your project team works on multiple components, you may want to use a composite
baseline. A composite baseline selects baselines in other components. In Figure 5, the PB1
composite baseline selects baselines BL1 and BL2 of components A and B, respectively.
The Proj component does not contain any elements of its own. It contains only the
composite baseline that selects the recommended baselines of the project’s
components. By using a composite baseline in this manner, you can identify one
baseline to represent the entire project.

Figure 4 Baselines of Two Components
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Figure 5 Composite Baseline

Setting Up the UCM-ClearQuest Integration

You can use UCM without Rational ClearQuest, the change request management tool,
but the integration with ClearQuest adds significant project management and activity
management capabilities. When you set up a UCM project to work with ClearQuest,
the integration links all project activities to ClearQuest records. You can then take
advantage of UCM-ClearQuest’s state transition model and ClearQuest’s query,
reporting, and charting features. These features allow you to do the following:

■ Assign activities to developers
■ Use states and state transition rules to manage activities
■ Generate reports based on database queries
■ Select additional development policies to be enforced

To set up the UCM-ClearQuest integration:

1 Enable a ClearQuest schema to work with UCM or use a predefined UCM-enabled
schema.

2 Create or upgrade a ClearQuest user database to use the schema.

3 Enable your UCM project to work with ClearQuest.
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See Overview of the UCM-ClearQuest Integration on page 23 for additional information
about the integration.

Setting Policies

UCM includes a set of policies that you can set to enforce development practices
among members of the project team. By setting policies, you can improve
communication among project team members and minimize the problems you may
encounter when integrating their work. For example, you can set a policy that requires
developers to update their work areas with the project’s latest recommended baseline
before they deliver work. This practice reduces the likelihood that developers will need
to work through complex merges when they deliver their work. For a description of all
policies you can set in UCM, see Chapter 4, Setting Policies. You can set policies on
projects and streams.

In addition to the set of policies that UCM provides, you can create triggers on UCM
operations to enforce customized development policies. See Chapter 8, Using Triggers
to Enforce Development Policies for details about creating triggers.
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Assigning Work

This task is optional and is possible only if you use the UCM-ClearQuest integration.
As project manager, you are responsible for identifying and scheduling the high-level
tasks for your project team. In some organizations, the project manager creates
activities and assigns them to developers. In other organizations, the developers create
their own activities. See Assigning Activities on page 97 for details on creating and
assigning activities in ClearQuest.

Creating a Testing Stream

In your role as integrator, you are responsible for building the work delivered by
developers, creating baselines, and testing those baselines. When you make baselines
in the integration stream, you lock the stream to prevent developers from delivering
work. This practice ensures that you work with a static set of files. It is acceptable to
perform quick validation tests of the new baselines in the integration stream. However,
we recommend that you do not lock the integration stream for a long time because you
will create a backlog of deliveries. To perform more rigorous testing, such as regression
testing, you should create a development stream to be used solely for testing baselines.
See Creating a Development Stream for Testing Baselines on page 101 for details on creating
a testing stream.
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Building Components

Before you make new baselines, build the components in the integration stream by
using the current baselines plus any work that developers have delivered to the stream
since you created the current baselines. Lock the integration stream before you build
the components to ensure that you work with a static set of files. If the build succeeds,
you can make baselines that select the latest delivered work. If your project uses
feature-specific development streams, perform this task on those streams as well as on
the integration stream.

MultiSite Consideration

Product Note: Rational ClearCase LT does not currently support Rational ClearCase
MultiSite.

In most cases, developers complete the deliver operations that they start. If your
project uses ClearCase MultiSite, you may need to complete some deliver operations
before you can build the components. Many ClearCase customers use MultiSite, a
product layered on ClearCase, to support parallel software development across
geographically distributed project teams. MultiSite lets developers work on the same
VOB concurrently at different locations. Each location works on its own copy of the
VOB, known as a replica.

To avoid conflicts, MultiSite uses an exclusive-right-to-modify scheme, called
mastership. VOB objects, such as streams and branches, are assigned a master replica. The
master replica has the exclusive right to modify or delete these objects.

In a MultiSite configuration, a team of developers may work at a remote site, and the
project’s integration stream may be mastered at a different replica than the developers’
development streams. In this situation, the developers cannot complete deliver
operations to the integration stream. As integrator, you must complete these deliver
operations. UCM provides a variation of the deliver operation called a remote deliver.
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When UCM determines that the integration stream is mastered at a remote site, it
makes the deliver operation a remote deliver, which starts the deliver operation but
does not merge any versions. You then complete the deliver operation at the remote
site.

For details on completing remote deliver operations, see Finding Work That Is Ready to
Be Delivered on page 109.

Making a New Baseline

To ensure that developers stay in sync with each other’s work, make new baselines
regularly. A new baseline includes the work developers have delivered to the
integration stream since the last baseline. If your project uses feature-specific
development streams, perform this task on those streams as well as on the integration
stream. In some environments, the lead developer working on a feature may assume
the role of integrator for a feature-specific development stream. To make a new
baseline:

1 Make sure that the integration stream is locked to prevent developers from
delivering work while you create the baseline. Developers can continue to work on
activities in their development streams.

2 Verify the stability of the project by testing its components.

3 Make the baseline.

4 Unlock the integration stream so that developers can deliver work.

After your team of software quality engineers tests the new baseline more extensively
and determines that it is stable, make the baseline the recommended baseline.
Developers then update their work areas with the new baseline by performing a rebase
operation, which merges files and directories from the integration stream or
feature-specific development stream to their development streams.
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Figure 6 illustrates a rebase operation from baseline BL1 to BL2. For details on making
baselines, see Creating a New Baseline on page 110.

Figure 6 Rebase Operation

Recommending the Baseline

As work on your project progresses and the quality and stability of the components
improve, change the baseline’s promotion level attribute to reflect important
milestones. The promotion level attribute typically indicates a level of testing. For
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example, Figure 7 shows the evolution of baselines through three levels of testing; the
BL8 baseline is ready for production.

When baselines pass the level of testing required to be considered stable, make them
the recommended set of baselines. Developers then rebase their development streams
to the recommended baselines. You can set a policy that requires developers to rebase
their development streams to the set of recommended baselines before they deliver
work. This policy helps to ensure that developers update their work areas whenever a
baseline passes an acceptable level of testing.

For details on recommending baselines, see Recommending the Baseline on page 114.

Figure 7 Promoting Baselines
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Monitoring Project Status

ClearCase provides several tools to help you track the progress of your project:

■ The UCM-ClearQuest integration includes six ClearQuest queries, which you can
use to retrieve information about activities in your project. For example, you can
see all activities that are in an active state or all active activities assigned to a
particular developer. In addition, you can create customized ClearQuest queries.

■ The Compare Baselines GUI compares any two baselines of a component and
displays the differences in activities and versions associated with each baseline.
You can use this feature to determine when a particular feature was included in a
baseline.

■ The Component Tree Browser (Windows only) displays the baseline history of a
component. The GUI includes a feature that lets you filter the display so that you
see only specified streams or baselines at or above a specified promotion level.

■ The ClearCase Report Builder and Report Viewer (Windows only) let you generate
and view reports specific to your project environment. The Report Builder
provides a set of reports organized by ClearCase object, such as project, stream,
element, and view. In addition, you can customize the procedures used to generate
and display reports.

See Monitoring Project Status on page 116 for details on using these tools.

Overview of the UCM-ClearQuest Integration

This section describes the following UCM-ClearQuest integration concepts:

■ Association of UCM and ClearQuest objects
■ UCM-enabled schema
■ Queries

Project 
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project
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■ State types

Associating UCM and ClearQuest Objects

Setting up the integration links UCM and ClearQuest objects. Figure 8 shows the
bidirectional linking of these objects.

Figure 8 Association of UCM and ClearQuest Objects in Integration

When you enable a project to link to a ClearQuest user database, the integration stores
a reference to that database in the project’s PVOB.

ClearQuest User Database 1PVOB

Project 1 

Project 2

Activity 1

ClearQuest User Database 2
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Every project enabled for ClearQuest is linked to a project record of record type
UCM_Project in the ClearQuest user database.

Every activity in a project enabled for ClearQuest is linked to a record in the database.
An activity’s headline is linked to the headline field in its corresponding ClearQuest
record. If you change an activity’s headline in ClearCase, the integration changes the
headline in ClearQuest to match the new headline, and the reverse is also true.
Similarly, an activity’s ID is linked to the ID field in its ClearQuest record.

It is possible for a ClearQuest user database to contain some records that are linked to
activities and some records that are not linked. In Figure 8, ClearQuest User Database
1 contains a record that is not linked to an activity. You may encounter this situation if
you have a ClearQuest user database in place before you adopt UCM. As you create
activities, the integration creates corresponding ClearQuest records. However, any
records that existed in that user database before you enabled it to work with UCM
remain unlinked. In addition, UCM does not link a record to an activity until a
developer sets work to that record.

UCM-Enabled Schema

In ClearQuest, a schema is the definition of a database. To use the integration, you must
create or upgrade a ClearQuest user database that is based on a UCM-enabled schema.
A UCM-enabled schema contains certain fields, scripts, actions, and state types.
ClearQuest includes two predefined UCM-enabled schemas, which you can use. You
can also enable a custom schema or another predefined schema to work with UCM. For
details on UCM-enabled schemas, see Deciding Which Schema to Use on page 49.

State Types

ClearQuest uses states to track the progress of change requests from submission to
completion. A state represents a particular stage in this progression. Each movement
from one state to another is a state transition. The integration uses a particular state
transition model. To implement this model, the integration uses state types. A state
type is a category of states that UCM uses to define state transition sequences. You can
define as many states as you want, but all states in a UCM-enabled record type must
be based on one of the following state types:

■ Waiting
■ Ready
■ Active
■ Complete

Multiple states can belong to the same state type. However, you must define at least
one path of transitions between states of state types as follows: Waiting to Ready to
Active to Complete. For details on state types, see Setting State Types on page 68.
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Queries in a UCM-Enabled ClearQuest Schema

A UCM-enabled schema includes six queries. When you create or upgrade a
ClearQuest user database to use a UCM-enabled schema, the integration installs these
queries in two subfolders of the Public Queries folder in the user database’s
workspace. These queries make it easy for developers to see which activities are
assigned to them and for project managers to see which activities are active in a
particular project. For details on these queries, see Querying ClearQuest User Databases
on page 120
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3Planning the Project
This chapter describes the issues you need to consider in planning to use one or more
UCM projects as your configuration management environment in Rational ClearCase.
We strongly recommend that you write a configuration management plan before you
begin creating projects and other UCM objects. After you create your plan, see
Chapter 6, Setting Up the Project for information on how to implement it.

Using the System Architecture as the Starting Point

Essential to developing and maintaining high-quality software is the definition of the
system’s architecture. The Rational Unified Process states that defining and using a
system architecture is one of the six best practices to follow in developing software. A
system architecture is the highest level concept of a system in its environment. The
Rational Unified Process states that a system architecture encompasses the following:

■ The significant decisions about the organization of a software system

■ The selection of the structural elements and their interfaces of which the system is
composed, together with their behavior as specified in the collaboration among
those elements

■ The composition of the structural and behavioral elements into progressively
larger subsystems

■ The architectural style that guides this organization, these elements, and their
interfaces, their collaborations, and their composition

A well-documented system architecture improves the software development process.
It is also the ideal starting point for defining the structure of your configuration
management environment.

Mapping System Architecture to Components

Just as different types of blueprints represent different aspects of a building’s
architecture (floor plans, electrical wiring, plumbing, and so on), a good software
system architecture contains different views to represent its different aspects. The
Rational Unified Process defines an architectural view as a simplified description (an
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abstraction) of a system from a particular perspective or vantage point, covering
particular concerns and omitting entities that are not relevant to this perspective.

The Rational Unified Process suggests using five architectural views. Of these, the
implementation view is most important for configuration management. The
implementation view identifies the physical files and directories that implement the
system’s logical packages, objects, or modules. For example, your system architecture
may include a licensing module. The implementation view identifies the directories
and files that make up the licensing module.

From the implementation view, you should be able to identify the set of UCM
components you need for your system. Components are groups of related directory
and file elements, which you develop, integrate, and release together. Large systems
typically contain many components. A small system may contain one component.

Deciding What to Place Under Version Control

In deciding what to place under version control, do not limit yourself to source code
files and directories. The power of configuration management is that you can record a
history of your project as it evolves so that you can re-create the project quickly and
easily at any point in time. To record a full picture of the project, include all files and
directories connected with it. These include, but are not limited to the following:

■ Source code files and directories
■ Model files, such as Rational Rose files
■ Libraries
■ Executable files
■ Interfaces
■ Test scripts
■ Project plans
■ Compilers, other developer tools, and system header files
■ System and user documentation
■ Requirements documents

Mapping Components to Projects

After mapping your system architecture to a set of components and identifying the full
set of files and directories to place under version control, you need to determine
whether to use one project or multiple projects. In general, think of a project as the
configuration management environment for a project team working on a specific
release. Team members work together to develop, integrate, test, and release a set of
related components. For many systems, all work can be done in one project. For some
systems, work must be separated into multiple projects. In deciding how many projects
to use, consider the following factors:
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■ Amount of integration required
■ Whether you need to develop and release multiple versions of the product

concurrently

Amount of Integration

Determine the relationships between the various components. Related components
that require a high degree of integration belong to the same project. By including
related components in the same project, you can build and test them together
frequently, thus avoiding the problems that can arise when you integrate components
late in the development cycle.

Need for Parallel Releases

If you need to develop multiple versions of your system in parallel, consider using
separate projects, one for each version. For example, your organization may need to
work on a patch release and a new release at the same time. In this situation, both
projects use mostly the same set of components. (Note that multiple projects can
modify the same set of components.) When work on the patch release project is
complete, you integrate it with the new release project.

If you anticipate that your team will develop and release numerous versions of your
system over time, you may want to create a mainline project. A mainline project serves
as a single point of integration for related projects over a period of time. See Chapter 9,
Managing Parallel Releases of Multiple Projects for additional information about using a
mainline project.

Example

Figure 9 shows the initial set of components planned for the Transaction Builder
system. A team of 30 developers work on the system. Because a high degree of
integration between components is required, and most developers work on several
components, the project manager included all components in one project.
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Figure 9 Components Used by Transaction Builder Project

Organizing Components

After you map your system architecture to an initial set of components and determine
which projects will access those components, refine your plan by performing the
following tasks:

■ Decide how many VOBs to use
■ Identify any additional components
■ Define the component directory structures
■ Identify read-only components

Deciding How Many VOBs to Use

ClearCase lets you store multiple components in a VOB. If your project uses a small
number of components, you may want to use one VOB per component. However, if
your project uses many components, you may want to store multiple components in
several VOBs. A VOB can store many versions of many elements. It is inefficient to use
a VOB to store one small component.

Keep in mind the following restrictions:
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■ A component’s root directory must be the VOB’s root directory or one level
beneath it. A component includes all directory and file elements under its root
directory. For example, in Figure 10, Libs cannot be a component.

■ You cannot nest components. For example, in Figure 10, GUI, Admin, and Reports
can be components only if Dev is not a component.

■ If you make a component at the VOB’s root directory, that VOB can never contain
more than that one component. For this reason, we recommend that you create
components one level beneath the VOB’s root directory. Doing so allows you to
add components to the VOB in the future.

■ Whether you make a component at the VOB’s root directory or one level beneath
it, the component’s name must be unique within its PVOB.

Figure 10 Storing Multiple Components in a VOB

Identifying Additional Components

Although you should be able to identify nearly all necessary components by
examining your system architecture, you may overlook a few. For example:

System
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Defining the Directory Structure

After you complete your list of components, you need to define the directory structures
within those components. We recommend that you start with a directory structure
similar to the one shown in Table 1; then modify the structure to suit your system’s
needs.

In Table 1, Component_1 through Component_n refers to the components that map to
the set of logical packages in your system architecture.

Project baseline
component

If you plan to use a composite baseline that selects baselines from
all of the project’s components, we recommend that you store the
composite baseline in its own component. See Identifying a Project
Baseline on page 37 for details.

Testing
component

Consider using a separate component for storing files related to
testing the system. This component includes files such as test
scripts, test results and logs, and test documentation.

Deployment
component

At the end of a development cycle, you need a separate component
to store the generated files that you plan to ship with the system or
deploy inhouse. These files include executable files, libraries,
interfaces, and user documentation.

Tools component In addition to placing source files under version control, it is a good
idea to place your team’s developer tools, such as compilers, and
system header files under version control.

Table 1 Recommended Directory Structure for Components

Component Directories Typical contents

System plans Project plans, mission
statement, and so on

requirements Requirements documents

models Rose files, other
architecture documents

documentation System documentation
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Component_1 through
Component_n

requirements Component requirements

models Component model files

source Source files for this
component

interfaces Component public
interfaces

binaries Executable and other
binary files for this
component

libraries Libraries used by this
component

tests Test scripts and related
documents for this
component

Test scripts Test scripts

results Test results and logs

documentation Test documentation

Deployment binaries Deployed executable files

libraries Deployed libraries

interfaces Deployed interfaces

documentation User documentation

Tools compilers Developer tools such as
Visual InterDev and
Rational Rose

headers System header files

Project baseline none Composite baseline that
selects baselines from all
components in the project

Table 1 Recommended Directory Structure for Components

Component Directories Typical contents
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Identifying Read-Only Components

When you create a project, you must indicate whether each component is modifiable
in the context of that project. In most cases, you make them modifiable. However, in
some cases you want to make a component read-only, which prevents project team
members from changing its elements. Components can be used in multiple projects.
Therefore, one project team may be responsible for maintaining a component, and
another project team may use that component to build other components.

For example, in Figure 11, Project A team members maintain a set of library files.
Project B team members reference some of those libraries when they build their
components. In Project A, the cm_libs component is modifiable. In Project B, the same
component is read-only. With respect to the cm_libs component, Project A and Project
B have a producer-consumer relationship.

Figure 11 Using a Read-Only Component

Choosing a Stream Strategy

The basic UCM process uses the integration stream as the project’s sole shared work
area. Developers join the project by using the integration stream’s recommended
baselines to populate their development streams; deliver completed work to the
integration stream where the integrator incorporates the work into new baselines; and
rebase their development streams to the new recommended baselines. Depending on
the size of your project and the number of developers working on it, this process may
be a good choice for your team.
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Stream Hierarchies

Alternatively, you can use UCM’s development stream hierarchy feature to create
multiple shared work areas within a project. This approach supports a project
organization that consists of small teams of developers where each team develops a
specific feature.

For example, in Figure 12, the project manager created a development stream called
Permissions_dev for two developers who are working on a permissions feature. The
developers, Pat and Pedro, joined the project at the Permissions_dev level rather than
at the integration stream level. They deliver completed work to the Permissions_dev
stream. Periodically, the integrator or lead developer responsible for managing the
Permissions_dev stream incorporates the delivered work into new baselines, and the
developers rebase their development streams to those new baselines.

When the two developers finish working on the permissions feature, they deliver their
last work to the Permissions_dev stream. The integrator incorporates their delivered
work into a final set of baselines and delivers those baselines to the integration stream.

Figure 12 Using a Feature-Specific Development Stream
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Single-Stream Projects

For most customers, a parallel development environment consisting of private and
shared work areas makes sense. However, small teams of developers working together
closely may prefer a serial development environment. UCM supports this by letting
you create a single-stream project. A single-stream project contains one stream, the
integration stream, and does not allow users to create development streams. When
developers join a single-stream project they create a view attached to the integration
stream.

You may want to use a single-stream project during the initial stage of development
when several developers want to share code quickly. When the development effort
expands and you need a parallel development environment, you can create a
multiple-stream project based on the final baselines in the single-stream project.

The main advantages of single-stream projects are as follows:

■ Developers working in dynamic views see each other’s work as soon as they check
in their files. Developers working in snapshot views see each other’s work as soon
as they check in their files and update their views. In a multiple-stream project,
developers see each other’s changes only during deliver and rebase operations.

■ Developers have a simplified work environment. Because all work is done on the
integration stream, developers do not need to maintain a development stream and
two views, one attached to the development stream and one attached to the
integration stream. In addition, developers do not need to perform deliver or
rebase operations.

■ Your role as integrator is simplified. Because developers work on the same stream
and see each other’s changes immediately, you do not need to create baselines
frequently. In contrast to a multiple-stream project, developers do not depend on
baselines to integrate their work. The primary purpose of baselines in a
single-stream project is to identify major milestones.

The main disadvantages of single-stream projects are as follows:

■ Developers have limited support for sharing files simultaneously. Although
ClearCase allows multiple developers to check out an element in the same stream
at the same time, only one developer can reserve the checkout. A reserved checkout
guarantees the developer’s right to check in a new version of the element. All
other developers must check out the element as unreserved, which means that they
cannot check in their versions until after the reserved checkout has been checked
in or canceled. Developers with unreserved checkouts must merge their changes
with the changes made by the reserved checkout.

■ Because changes are shared as soon as developers check in their files, developers
assume the full responsibility for testing their work and must be extremely vigilant
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to ensure that they do not introduce bugs to the project. In contrast, a
multiple-stream project allows the integrator or a software quality engineering
team to perform extensive testing of new baselines on a dedicated testing stream
and recommend baselines only after they pass those tests.

■ Because changes are shared as soon as developers check in their files, developers
might keep files checked out longer than they would in a multiple-stream project.
If a view is lost, all changes made but not checked in that view are also lost.
Therefore, we recommend that you have your ClearCase administrator back up
views for single-stream projects frequently.

Read-Only Streams

During the evolution of a project, you might need to provide some users with access to
baselines while ensuring that they do not make any changes to components. You can
address this requirement by creating a Read-Only development stream for those users.
You cannot make baselines in Read-Only streams, nor can you create child streams
beneath them. You can create view-private files, such as derived objects in Read-Only
streams.

Common use cases for Read-Only streams include the following:

■ Your quality engineering team needs to build and test a particular configuration.

■ Your customer support team needs access to a library that was built in a previous
release.

■ Your release engineering team needs to create a release based on a combination of
old and new baselines.

Specifying a Baseline Strategy

After you organize the project’s components, determine your strategy for creating
baselines of those components. The baseline strategy must define the following:

■ A project baseline
■ When to create baselines
■ How to name baselines
■ The set of promotion levels
■ How to test baselines

Identifying a Project Baseline

In your role as integrator, you are responsible for telling developers which baselines to
use when they join the project and when they rebase their development streams. You
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could keep track of a list of baselines, one for each component. However, a more
efficient practice is to use a composite baseline to represent the project baseline. A
composite baseline selects baselines from other components.

For example, in Figure 13, Project A uses a composite baseline, PA, to select baselines
in the GUI and Admin components. Project B also uses a composite baseline, PB.
Baselines that are selected by a composite baseline are referred to as members.

After you create a composite baseline to represent the project baseline, the next time
you invoke the make baseline operation on the component that contains the project
baseline, UCM performs the operation recursively. If a component that contributes to
the composite baseline has changed since its latest baseline, UCM creates a new
baseline in that component. For example, assume that developers made changes to
files in the GUI component after the integrator created the 1 baseline. The next time
you make a new project baseline, UCM creates a new baseline in the GUI component
that incorporates the changed files, and the new project baseline selects the new GUI
baseline.

A composite baseline can select other composite baselines. For example, if your system
is so large that it consists of multiple projects, you may want to use a composite
baseline to represent the system baseline. In Figure 13, SB is a composite baseline that
selects the PA and PB baselines of Project A and Project B, respectively.

In addition to using a composite baseline to represent the project, you can use multiple
composite baselines within the same project. When working with multiple composite
baselines, you can encounter situations where two composite baselines select different
baselines of the same component. When this happens, you need to resolve the conflict
by choosing one of the member baselines. To avoid these conflicts, we recommend that
you choose a simple baseline design, rather than one that uses a complex hierarchy of
composite baselines. See Resolving Baseline Conflicts on page 115 for details about
baseline conflicts.

Like all baselines, a composite baseline must belong to a component. However, that
component does not need to contain any of its own elements. For example, in
Figure 13, the System_component, ProjA_Comp, and ProjB_Comp components
consist only of their composite baselines. When you create a component to be used
solely for housing a composite baseline, you can specify an option that directs UCM to
make the component without creating a root directory in a VOB. Such a component can
never contain its own elements.
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Figure 13 Using a System-Level Composite Baseline

When to Create Baselines

At the beginning of a project, you must identify the baseline or baselines that represent
the starting point for new development. As work on the project progresses, you need
to create new baselines periodically.

Identifying the Initial Baseline

If your project represents a new version of an existing project, you probably want to
start work from the latest recommended baselines of the existing project’s components.
For example, if you are starting work on version 3.2 of the Transaction Builder project,
identify the baselines that represent the released, or production, versions of its version
3.1 components.
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If you are converting a base ClearCase configuration to a project, you can make
baselines from existing labeled versions. Check whether the latest stable versions are
labeled. If they are not, you need to create a label type and apply it to the versions that
you plan to include in your project. See Making a Baseline from a Label on page 91 for
details about creating and applying a label type.

Ongoing Baselines

After developers start working on the new project and making changes, create
baselines on the integration stream and on any feature-specific development streams
on a frequent (nightly or weekly) basis. This practice has several benefits:

■ Developers stay in sync with each other’s work.

It is critical to good configuration management that developers have private work
areas where they can work on a set of files in isolation. Yet extended periods of
isolation can cause problems. Developers are unaware of each other’s work until
you incorporate delivered changes into a new baseline, and they rebase their
development streams.

■ The amount of time required to merge versions is minimized.

When developers rebase their development streams, they may need to resolve
merge conflicts between files that the new baseline selects and the work in their
private work areas. When you create baselines frequently, they contain fewer
changes, and developers spend less time merging versions.

■ Integration problems are identified early.

When you create a baseline, you first build and test the project by incorporating
the work delivered since the last baseline. By creating baselines frequently, you
have more opportunities to discover any serious problems that a developer may
introduce to the project inadvertently. By identifying a serious problem early, you
can localize it and minimize the amount of work required to fix the problem.

If you are working in a single-stream project, you do not need to create baselines
frequently. Developers see each other’s changes as soon as they check in files; they do
not rebase to the latest recommended baselines. The primary purpose of baselines in a
single-stream project is to identify major project milestones, such as the end of an
iteration or a beta release.

Defining a Naming Convention

Because baselines are an important tool for managing a project, define a meaningful
convention for naming them. You may want to include some or all of the following
information in a baseline name:
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■ Project name
■ Milestone or phase of development schedule
■ Date created

For example: V4.0TRANS_BL2_June12.

UCM includes a set of templates that you can use to implement a baseline naming
convention within a project. See Setting a Baseline Naming Template on page 84 for
details.

Identifying Promotion Levels to Reflect State of Development

A promotion level is an attribute of a baseline that you can use to indicate the quality
or stability of the baseline. ClearCase provides the following default promotion levels:

■ Rejected
■ Initial
■ Built
■ Tested
■ Released

You can use some or all of the default promotion levels, and you can define your own.
The levels are ordered to reflect a progression from lowest to highest quality. You can
use promotion levels to help you recommend baselines to developers. The
Recommended Baselines dialog box displays baselines that have a promotion level
equal to or higher than the one you specify. You can use this feature to filter the list of
baselines displayed in the dialog box. Determine the set of promotion levels for your
project and the criteria for setting each level.

Planning How to Test Baselines

Typically, software development teams perform several levels of testing. An initial test,
known as a validation test, checks to see that the software builds without errors and
appears to work as it should. A more comprehensive type of testing, such as regression
testing, takes much longer and is usually performed by a team of software quality
engineers.

When you make a new baseline, you need to lock the integration stream to prevent
developers from delivering additional changes. This allows you to build and test a
static set of files. Because validation tests are not exhaustive, you probably do not need
to lock the integration stream for a long time. However, more extensive testing requires
substantially more time.

Keeping the integration stream locked for a long time is not a good practice because it
prevents developers from delivering completed work. One solution to this problem is
to create a development stream to be used solely for extensive testing. After you create
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a new baseline that passes a validation test, your testing team can rebase the
designated testing development stream to the new baseline. When the baseline passes
the next level of testing, promote it. When you are confident that the baseline is stable,
make it the recommended baseline so that developers can rebase their development
streams to it.

For information on creating a testing development stream, see Creating a Development
Stream for Testing Baselines on page 101. For information on testing baselines, see Testing
the Baseline on page 113.

Planning PVOBs

ClearCase stores UCM objects such as projects, streams, activities, and change sets in
project VOBs (PVOBs). PVOBs can also function as administrative VOBs. You need to
decide how many PVOBs to use for your system and whether to take advantage of the
administrative capabilities of the PVOB.

Deciding How Many PVOBs to Use

Product Note: This section does not apply to Rational ClearCase LT because that
product allows for only one PVOB per server.

Projects that use the same PVOB have access to the same set of components. If
developers on different projects need to work on some of the same components, use
one PVOB for those projects. For example, Figure 14 shows concurrent development of
two versions of the Webotrans product. While most members of the team work on the
4.0 release in one project, a small group works on the 4.0.1 release in a separate project.
Both projects use the same components, so they use one PVOB.
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Figure 14 Related Projects Sharing One PVOB

Consider using multiple PVOBs only when if your projects are so large that PVOB
capacity becomes an issue.

Understanding the Role of the Administrative VOB

An administrative VOB stores global type definitions. VOBs that are joined to the
administrative VOB with AdminVOB hyperlinks share the same type definitions
without having to define them in each VOB. For example, you can define element
types, attribute types, hyperlink types, and so on in an administrative VOB. Any VOB
linked to that administrative VOB can then use those type definitions to make
elements, attributes, and hyperlinks.

If you currently use an administrative VOB, you can associate it with your PVOB by
creating an AdminVOB hyperlink between the PVOB and the administrative VOB. On
Windows, the VOB Creation Wizard creates the AdminVOB hyperlink for you. On
UNIX, use the cleartool mkhlink command to create the AdminVOB hyperlink.
Thereafter, when you create components, ClearCase creates AdminVOB hyperlinks
between the VOBs that store the components’ root directories and the administrative
VOB so that the components can use the administrative VOB’s global type definitions.

If you do not currently use an administrative VOB, do not create one. When you create
components, ClearCase makes AdminVOB hyperlinks between the VOBs that store
the components’ root directories and the PVOB, and the PVOB assumes the role of
administrative VOB.

GUI Admin GUI Admin

Webotrans
PVOB
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For details on administrative VOBs and global types, see the Administrator’s Guide for
Rational ClearCase.

Using Multiple PVOBs

Although we recommend using one PVOB for all your projects, your organization
might have multiple PVOBs. If projects in one PVOB need to modify components in
other PVOBs, your ClearCase administrator needs to identify one PVOB to serve as a
common administrative VOB for the PVOBs and the component VOBs.

In Figure 15, PVOB1 and PVOB2 use PVOB3 as their administrative VOB. The arrows
from the PVOBs and the component VOBs represent AdminVOB hyperlinks to
PVOB3. Because the component VOBs and the PVOBs share a common administrative
VOB, all three projects can modify all three components.

For PVOBs that do not share a common administrative VOB, a project may select a
component from another PVOB but the component will be Read-Only within that
project.

In Figure 15, a PVOB serves as an administrative VOB. As an alternative, you can link
PVOBs and component VOBs to an administrative VOB. This approach might be
appropriate if your development team is moving from base ClearCase to UCM and
you currently use an administrative VOB.

If you plan to use multiple PVOBs, create the PVOB that will serve as the
administrative VOB first. When you create the other PVOBs, specify the first PVOB as
the administrative VOB.
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Figure 15 Using One PVOB as an Administrative VOB for Multiple PVOBs

Identifying Special Element Types

The concept of element types allows ClearCase to handle each class of elements
differently. An element type is a class of file elements. ClearCase includes predefined
element types, such as file and text_file, and lets you define your own. When you
create an element type for use in UCM projects, you can specify a mergetype attribute,
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which determines how deliver and rebase operations handle merging of files of that
element type.

When ClearCase encounters a merge situation during a deliver or rebase operation, it
attempts to merge versions of the element. ClearCase requires user interaction only if
it cannot reconcile differences between the versions. For certain types of files, you may
want to impose different merging behavior.

Nonmerging Elements

Some types of files never need to be merged. For these files, you may want to ensure
that no one attempts to merge them accidentally. For example, the deployment, or
staging, component contains the executable files that you ship to customers or install
in-house. These files are not under development; they are the product of the
development phase of the project cycle. For these types of files, you can create an
element type and specify never merge behavior.

Note: If you fail to specify never merge behavior for these elements, developers may
encounter problems when they attempt to deliver work to the project’s integration
stream. Developers create executable files when they build and test their work prior to
delivering it. If these files are under version control as derived objects, they are included
in the current activity’s change set. During a deliver operation, ClearCase attempts to
merge these executable files to the integration stream unless the files are of an element
type for which never merge behavior is specified.

Nonautomerging Elements

For some types of files, you may want to merge versions manually rather than let
ClearCase merge them. One example is a Visual Basic form file, which is a generated
text file. Visual Basic generates the form file based on the form that a developer creates
in the Visual Basic GUI. Rather than let ClearCase change the form file during a merge
operation, you want to regenerate the form file from the Visual Basic GUI.

For these types of files, you can create an element type and specify user merge
behavior. For information on creating element types, see Chapter 15, Using Element
Types to Customize File Element Processing, and the mkeltype reference page in the
Command Reference.

Defining the Scope of Element Types

When you define an element type, its scope can be ordinary or global. By default, the
element type is ordinary; it is available only to the VOB in which you create it. If you
create the element type in an administrative VOB and define its scope as global, other
VOBs that have AdminVOB hyperlinks to that administrative VOB can use the
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element type. If you want to define an element type globally, and you do not currently
use a separate administrative VOB, define the element type in the PVOB.

Planning How to Use the UCM-ClearQuest Integration

Before you can set up the UCM-ClearQuest integration, you need to make some
decisions, which fall into two general categories:

■ How to map PVOBs to ClearQuest user databases
■ Which schema to use for the ClearQuest user databases

Mapping PVOBs to ClearQuest User Databases

This section describes three issues that you need to consider in deciding how many
PVOBs to use for projects that link to ClearQuest user databases.

MultiSite Requirement

If you use ClearCase MultiSite, all PVOB replicas must have access to the ClearQuest
user database. If you have multiple PVOBs linked to either an administrative VOB or
a PVOB acting as an administrative VOB, all of the PVOBs and administrative VOBs in
the hierarchy must be replicated to all sites.

Projects Linked to Same Database Must Have Unique Names

Although UCM allows you to create projects with the same name in different PVOBs,
you cannot link those projects to the same ClearQuest user database. Figure 16
illustrates this naming requirement.
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Figure 16 Projects in Multiple PVOBs Linked to the Same ClearQuest Database

Use One Schema Repository for Linked Databases

If some developers on your team work on multiple projects, we recommend that you
store the schemas for the ClearQuest user databases that are linked to those projects in
one schema repository, as shown in Figure 17. This allows developers to switch
between projects easily. If you store the schemas in different schema repositories,
developers must use the ClearQuest Maintenance Tool to connect to a different schema
repository whenever they switch projects.
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Figure 17 Using the Same Schema Repository for Multiple ClearQuest
Databases

Deciding Which Schema to Use

To use the integration, you must create or upgrade a ClearQuest user database that is
based on a UCM-enabled schema. A UCM-enabled schema meets the following
requirements:

■ The UnifiedChangeManagement package has been applied to the schema. A
package contains metadata, such as records, fields, and states, that define specific
functionality. Applying a package to a schema provides a way to add functionality
quickly so that you do not have to build the functionality from scratch.

■ The UnifiedChangeManagement package has been applied to at least one record
type. This package adds fields and scripts to the record type, and adds the Unified
Change Management tab to the record type’s forms. Figure 18 shows the Unified
Change Management tab.

■ The UCMPolicyScripts package has been applied to the schema. This package
contains the scripts for three ClearQuest development policies that you can
enforce.
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ClearQuest includes two predefined UCM-enabled schemas:
UnifiedChangeManagement and Enterprise. You can start using the integration right
away by using one of these schemas, or you can use the ClearQuest Designer and the
ClearQuest Package Wizard to enable a custom schema or another predefined schema
to work with UCM. You can also use one of the predefined UCM-enabled schemas as
a starting point and then modify it to suit your needs.

Figure 18 UCM Tab of Record Form for a UCM-Enabled Record Type

Overview of the UnifiedChangeManagement Schema

The UnifiedChangeManagement schema includes the following record types:

■ BaseCMActivity
This is a lightweight record type that you can use to store information about
activities that do not require additional fields. Figure 19 shows the Main tab of the
BaseCMActivity record form. You may want to use this record type as a starting
point and then modify it to include additional fields and states.

■ Defect
This record type is identical to the record type of the same name that is included in
ClearQuest’s other predefined schemas, with one exception: it is enabled to work
with UCM. The Defect record type contains more fields and form tabs than the
BaseCMActivity record type to allow you to record detailed information.

■ UCMUtilityActivity
This record type is not intended for general use. The integration uses this record
type when it needs to create records for itself, such as when you link a project that
contains activities to a ClearQuest user database. You cannot modify this record
type.
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Figure 19 Main Tab of Record Form for the BaseCMActivity Record Type

Enabling a Schema for UCM

If you decide not to use one of the predefined UCM-enabled schemas, you need to do
some additional work to enable your schema to work with UCM. Before you can do
this, you need to answer the following questions:

■ Which record types are you enabling for UCM? You do not need to enable all
record types in your schema, but you can link only records of UCM-enabled record
types to activities.

■ For each UCM-enabled record type:

❑ Which state type does each state map to? You must map each state to one of the
four UCM state types: Waiting, Ready, Active, Complete. See Setting State Types
on page 68.

❑ Which default actions are you using to transition records from one state to
another? See State Transition Default Action Requirements for Record Types on
page 69.

❑ Which policies do you want to enforce? The integration includes policies that
you can set to enforce certain development practices. You can also edit the policy
scripts to change the policies. See Chapter 4, Setting Policies for details.
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4Setting Policies
UCM includes policies that you can set to enforce certain development practices within
a project. Some policies are available only if you enable the project to work with
Rational ClearQuest. In addition to the policies that UCM supplies, you can create your
own policies by using triggers on UCM operations. For information on using triggers,
see Chapter 8, Using Triggers to Enforce Development Policies.

Components and Baselines

This section describes the policies related to components and baselines.

Modifiable Components

In most cases, you want components to be modifiable. For information on when to use
read-only components, see Identifying Read-Only Components on page 34.

Default Promotion Level for Recommending Baselines

Recommended baselines are the set of baselines that project team members use to rebase
their development streams. In addition, when developers join the project, their
development work areas are initialized with the recommended baselines. When you
recommend baselines, the Recommend Baselines dialog box lists the latest baselines
that have promotion levels equal to or higher than the promotion level that you specify
as the default promotion level for recommending baselines.

Default View Types

When developers join a project, they use the Join Project Wizard to create their
development views, integration views, and development streams. They use a
development view and a development stream to work in isolation from the project
team. They use an integration view to build and test their work against the latest work
delivered to the integration stream or feature-specific development stream by other
developers.
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Rational ClearCase provides two kinds of views: dynamic and snapshot. Specify which
type of view to use as the default for development and integration views. When
developers join the project, they may choose to accept or reject the default view types.
The Join Project Wizard uses the default values the first time that a developer creates
views for a project. Thereafter, the wizard uses the developer’s most recent selections
as the default view types.

Product Note: Rational ClearCase LT supports only snapshot views.

Dynamic views use the ClearCase multiversion file system (MVFS) to provide
immediate, transparent access to files and directories stored in VOBs. On Windows,
ClearCase maps a dynamic view to a drive letter in Windows Explorer. Snapshot views
copy files and directories from VOBs to a directory on your computer.

We recommend that you use dynamic views as the default view type for integration
views. Dynamic views ensure that when developers deliver work to the integration
stream or feature-specific development stream, they build and test their work against
the latest work that other developers have delivered since the last baseline was created.
Snapshot views require developers to copy the latest delivered files and directories to
their computer (a snapshot view update operation), which they may forget to do.

Permissions to Modify Projects and Streams

This section describes policies that control who can modify the project and stream
objects.

Allow All Users to Modify the Project

By default, this policy is disabled, meaning that only the project owner, PVOB owner,
or a privileged user can make changes to the project object. To allow all users to modify
the project object, enable this policy.

Allow All Users to Modify the Stream and Its Baselines

By default, this policy is disabled, meaning that only the stream owner, PVOB owner,
or a privileged user can make changes to the stream or any baselines created in it. To
allow all users to modify the stream and its baselines, enable this policy. You can set
this policy to apply to all streams within the project or you can set it on a per-stream
basis.
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Deliver Operations

This section describes the policies that affect deliver operations. You can set these
policies to apply to all streams within the project or you can set the policies on a
per-stream basis. When a developer starts a deliver operation, UCM checks the policy
settings on the target stream and the project. If the target stream’s policy setting is
different than its project’s policy setting, the project’s setting takes precedence.

Allow Deliveries from Stream with Pending Checkouts

This policy allows developers to deliver work to the target stream even if some files
remain checked out in the source stream. If you do not set this policy, developers must
check in all files in their source streams before delivering work. You may want to
require developers to check in files to avoid the following situation:

1 A developer completes work on an activity, but forgets to check in all of the files
associated with that activity.

2 The developer works on other activities.

3 Having completed several activities, the developer delivers them to the target
stream. Because the files associated with the first activity are still checked out, they
are not included in the deliver operation. Even though the developer may build
and test the changes successfully in the development work area, the changes
delivered to the target may fail because they do not include the checked-out files.

Rebase Before Deliver

This policy requires developers to rebase their source streams to the target stream’s
current recommended baselines before they deliver work to the target stream. The goal of
this policy is to have developers build and test their work in their development work
areas against the work included in the most recent stable baselines before they deliver
to the target stream. This practice minimizes the amount of merging that developers
must do when they perform deliver operations.

Deliver Operations to Nondefault Targets

As shown in Figure 20, you can create a hierarchy of development streams. Such a
hierarchy allows you to designate a development stream as a shared area for
developers working on a particular feature. Developers who work on that feature
deliver work to the feature-specific development stream.
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Figure 20 Default and Nondefault Deliver Targets in a Stream Hierarchy

Within a stream hierarchy, streams have an ancestor-descendant relationship. In
Figure 20, the integration stream and the Feature1 development stream are ancestors
of the Developer1 and Developer2 development streams. Feature1, Developer1, and
Developer2 are descendants of the integration stream. A stream’s immediate ancestor
is its parent stream. A stream’s immediate descendant is its child stream.

Because a project can contain a set of complex development stream hierarchies, a
development stream may deliver to numerous target streams within the project. In
addition, streams may deliver to streams in other projects. The default target for a
deliver operation from a development stream is that stream’s parent stream.
Developers may also deliver to nondefault target streams. The arrows in Figure 20
illustrate default and nondefault deliver targets. The following policies apply only to
nondefault target streams.
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Allow Deliveries from Streams in Other Projects

Set this policy to control whether streams accept deliveries from streams in other
projects. See Chapter 9, Managing Parallel Releases of Multiple Projects, for examples of
when you may want to deliver work from one project to another.

Allow Deliveries That Contain Changes in Foundation Baselines

UCM uses foundation baselines to configure a stream’s view. A view attached to a stream
selects the versions of elements identified by the stream’s foundation baselines plus the
versions of elements associated with any activities created in the stream. For example,
in Figure 21, 1 is the foundation baseline for the Feature1 development stream. The X
baseline is the foundation baseline for the Developer1 development stream.

If the developer working in the Developer1 stream delivers work to the integration
stream, the deliver operation includes the activities created in the Developer1 stream
plus the files represented by the X foundation baseline. The integrator responsible for
the integration stream may want to receive work that the developer working in the
Developer1 stream has completed; however, the integrator may be unaware that the
deliver operation also contains changes made in the X baseline. You may want to set
this policy to Disabled so that target streams do not accept deliver operations that
contain changes in the source stream’s foundation baselines.

UCM contains two versions of this policy: one for interproject deliver operations, and
one for intraproject deliver operations.
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Figure 21 Delivering Changes Made in a Foundation Baseline

Allow Deliveries That Contain Changes Made to Components Not
in Target Stream

Set this policy to control whether streams accept deliveries that contain changes to
components that are not in the target streams’ configurations. If you set this policy to
Enabled, UCM allows the deliver operation, but the changes to any missing
components are not included. UCM contains two versions of this policy: one for
interproject deliver operations, and one for intraproject deliver operations.
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Allow Deliveries That Contain Changes to Nonmodifiable
Components

Set this policy to control whether streams accept interproject deliveries that contain
changes to components that are not modifiable in the target stream’s project. If you set
this policy to Enabled, UCM allows the deliver operation, but the changes to any
nonmodifiable components are not included.

UCM-ClearQuest Integration

This section describes the policies that are available only when you enable the project
to work with ClearQuest. Some of the policies are customizable. ClearQuest uses
scripts to implement the customizable policies. You can modify a policy’s behavior by
editing its script. See Customizing ClearQuest Project Policies on page 71.

Perform ClearQuest Action Before Work On

ClearCase invokes this policy when a developer attempts to set an activity. The default
policy script checks to see whether the developer’s user name matches the name in the
ClearQuest record’s Owner field. If the names match, the developer can work on the
activity. If the names do not match, the set activity action fails.

The intent of this policy is to ensure that all criteria are met before a developer can start
working on an activity. You may want to modify the policy to check for additional
criteria.

Perform ClearQuest Action Before Delivery

This default policy script is a placeholder: it does nothing. ClearCase invokes this
policy when a developer attempts to deliver an activity in a UCM-enabled project. We
recommend that you edit the script to implement an approval process to control
deliver operations. For example, you may want to add an Approved check box to the
activity’s record type and require that the project manager select it before allowing
developers to deliver activities.

See How the Integration Handles Interproject Deliveries on page 62 for details about
deliveries between two ClearQuest-enabled projects.

Perform ClearQuest Action Before Changing Activity

This default policy script is a placeholder: it does nothing. ClearCase invokes this
policy when a developer attempts to finish an activity. The finish activity operation
checks in all files that belong to the activity’s change set and performs ClearQuest
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actions, such as transitioning the activity to a Complete type state, based on the policies
that you set. When invoked in a single-stream project or on the integration stream of a
multiple-stream project, the finish activity operation is similar to a deliver operation in
a multiple-stream project. Both operations share changes with the rest of the team. We
recommend that you edit the script to implement an approval process to control finish
activity operations. For example, you may want to add an Approved check box to the
activity’s record type and require that the project manager select it before allowing
developers to finish activities.

Perform ClearQuest Action After Delivery

ClearCase calls this policy at the end of a deliver operation for each activity included
in the deliver operation. The default policy script is a placeholder: it does nothing. You
may want to edit this script to implement a post-delivery development practice. For
example, you might want the script to send an e-mail message to all developers on the
project telling them that a deliver operation has just finished.

See How the Integration Handles Interproject Deliveries on page 62 for details about
deliveries between two ClearQuest-enabled projects.

Perform ClearQuest Action After Changing Activity

ClearCase calls this policy when a developer attempts to finish an activity. If the
Perform ClearQuest Action Before Changing Activity policy is set, ClearCase calls that
policy first. The default policy script behaves as follows:

■ For developers working in a single-stream project or on the integration stream of a
multiple-stream project, allow the finish activity operation.

■ For developers working on a development stream, check in all files that belong to
the activity’s change set but do not perform any ClearQuest actions.

You may want to edit this script to implement a post-finish activity development
practice. For example, you might want the script to send an e-mail message to all
developers on the project telling them that a developer has just checked in files and
finished an activity.

Transition to Complete After Delivery

ClearCase calls this policy at the end of a deliver operation for each activity included
in the deliver operation. The policy uses the activity’s default action to transition the
activity to a Complete type state. If the default action requires entries in certain fields
of the activity’s record, and one of those fields is empty, the policy returns an error and
leaves the deliver operation in an uncompleted state. This state prevents the developer
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from performing another deliver operation, but it does not affect the current one. It
does not roll back changes made during the merging of versions.

To recover from an error, the developer needs to fill in the required fields in the
activity’s record and resume the deliver operation. If the developer invoked the deliver
operation from a GUI, the integration displays the ClearQuest record form so that the
developer can fill in the fields.

This policy is not customizable.

See How the Integration Handles Interproject Deliveries on page 62 for details about
deliveries between two ClearQuest-enabled projects.

Transition to Complete After Changing Activity

ClearCase calls this policy at the end of a finish activity operation. The policy uses the
activity’s default action to transition the activity to a Complete type state. If the default
action requires entries in certain fields of the activity’s record, and one of those fields
is empty, the policy returns an error. To recover from an error, the developer needs to
fill in the required fields in the activity’s record.

You may want to transition activities to a Complete type state depending on whether
the developer works in an integration stream.

■ To transition activities only for developers who work in a single-stream project or
on the integration stream of a multiple-stream project, set this policy and the
Perform ClearQuest Action After Changing Activity policy.

■ To transition activities regardless of which stream the developer works on, set this
policy and unset the Perform ClearQuest Action After Changing Activity policy.

This policy is not customizable.

Transfer ClearQuest Mastership Before Delivery

The Transition to Complete After Delivery project policy transitions activities to a
Complete type state when a deliver operation completes successfully. For that policy
to work correctly in a MultiSite environment, the activities being delivered must be
mastered by the same replica that masters the target stream. To ensure that this is the
case, you can set the Transfer Mastership Before Delivery policy.

The behavior of the Transfer Mastership Before Delivery policy depends on whether
the deliver operation is local or remote. If the deliver operation is local, meaning that
the target stream is mastered by the local PVOB replica, this policy causes the deliver
operation to fail unless all activities being delivered are mastered locally.
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A remote deliver operation is one for which the target stream is mastered by a remote
PVOB replica. The developer starts the deliver operation, but ClearCase leaves the
operation in a posted state. The integrator at the remote site completes the deliver
operation.

For a remote deliver operation, the Transfer Mastership Before Delivery policy causes
the following behavior:

■ If all activities in the deliver operation are mastered by the remote replica,
ClearCase allows the deliver operation to proceed.

■ If the deliver operation contains activities that are mastered by the local replica,
MultiSite transfers mastership of those activities to the remote replica. To have
MultiSite transfer mastership of those activities back to the local replica after the
integrator at the remote site performs any required merges and completes the
deliver operation, set the Transfer ClearQuest Mastership After Delivery policy
also.

■ If the deliver operation contains activities that are mastered by a third replica, the
deliver operation fails.

This policy is not customizable.

See How the Integration Handles Interproject Deliveries on page 62 for details about
deliveries between two ClearQuest-enabled projects.

Transfer ClearQuest Mastership After Delivery

Use this policy only in conjunction with the Transfer ClearQuest Mastership Before
Delivery policy. The Transfer ClearQuest Mastership Before Delivery policy transfers
mastership of activities involved in a remote deliver operation from the local replica to
a remote replica. Set this policy if you want ClearCase to transfer mastership of those
activities back to the original (local) replica after the integrator at the remote site
completes the deliver operation.

This policy is not customizable.

See How the Integration Handles Interproject Deliveries on page 62 for details about
deliveries between two ClearQuest-enabled projects.

How the Integration Handles Interproject Deliveries

With one exception, the integration does not invoke the following policies when you
deliver from one ClearQuest-enabled project to another:

■ Perform ClearQuest Action Before Delivery
■ Perform ClearQuest Action After Delivery
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■ Transition to Complete After Delivery
■ Transfer ClearQuest Mastership Before Delivery
■ Transfer ClearQuest Mastership After Delivery

The integration invokes the policies that are set for the source stream’s project only if
the source and target streams are integration streams and the target stream is the
default deliver target for the source stream.
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5Setting Up a
ClearQuest User
Database
This chapter describes how to set up a ClearQuest user database so that you can use
the UCM-ClearQuest integration for your project. The steps in this chapter are
typically completed by the ClearQuest database administrator. Rational ClearQuest
includes predefined schemas that are ready for use with UCM. You can also enable a
custom schema, or another predefined schema, to work with UCM. For information
about the decisions you need to make before setting up the integration, see Planning
How to Use the UCM-ClearQuest Integration on page 47.

Using the Predefined UCM-Enabled Schemas

The predefined UCM schemas, named UnifiedChangeManagement and Enterprise,
include the record type, field, form, state, and other definitions necessary to work with
a UCM project. To set up a ClearQuest user database to work with UCM:

1 Create a user database that is associated with one of the predefined UCM-enabled
schemas. In the ClearQuest Designer, click Database > New Database to start the
New Database Wizard.

2 Complete the steps in the wizard. Step 4 prompts you to select a schema to
associate with the new database. Scroll the list of schema names and select the new
schema, as shown in Figure 22.

3 Click Finish.

Figure 22 Associating a User Database with a UCM-Enabled Schema
65



Enabling a Schema to Work with UCM

The predefined UCM schemas let you use the UCM-ClearQuest integration right away,
but you may prefer to design a custom schema to track your project’s activities and
change requests, or you may prefer to use a different predefined schema. To enable a
schema to work with UCM:

1 Ensure that the schema does not contain a record type named UCM_Project,
which is a reserved name used by the UCM-ClearQuest integration.

2 In the ClearQuest Designer, click Package > Package Wizard to start the Package
Wizard.

3 Although it is not necessary, you may want to use the Package Wizard to apply the
BaseCMActivity package to your schema. The BaseCMActivity package adds the
BaseCMActivity record type to your schema. The BaseCMActivity record type is a
lightweight activity record type. You may want to use the BaseCMActivity record
type as a starting point and then modify it to include additional fields, states, and
so on. If you want to rename the BaseCMActivity record type, be sure to do so
before you create any records of that type.

4 Apply the UnifiedChangeManagement package to the schema. Select
UnifiedChangeManagement, and click Next.

5 In the second page of the wizard, select your schema. Click Next.

6 The third page of the wizard prompts you to specify the schema’s record types.
Select the check boxes of the record types that you want to enable. Click Next. All
selected record types must meet the requirements listed in Requirements for
Enabling Custom Record Types on page 68.

7 In the fourth page of the wizard, you must assign state types to the states for each
record type that you choose to enable. For each state, click in the adjacent state
type cell to display the list of available state types, as shown in Figure 23, and
select one. To enable another record type, click the arrow in the Record Type list to
see the available record types. See Setting State Types on page 68 for a description of
the four state types, and the rules for setting them.

When you are finished, click Finish to check out the schema.

Note: In some cases, the Setup State Types page of the wizard does not appear. If
that happens, assign state types to the states by clicking Package > Setup State
Types.
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Figure 23 Assigning State Types to a Record Type’s States

8 Before you can check in your schema, you must set default actions for the states of
each enabled record type. Default actions are state transition actions that
ClearQuest takes when a developer begins to work on an activity or delivers an
activity. In the ClearQuest Designer workspace, navigate to the record type’s state
transition matrix, as shown in Figure 24.

Figure 24 Navigating to Record Type’s State Transition Matrix

Double-click State Transition Matrix to display the matrix. Right-click the state
column heading, and select Properties from its shortcut menu. Click the Default
Action tab. Select the default action. See State Transition Default Action Requirements
for Record Types on page 69 for default action requirements. Before you can set
default actions, you may need to add some actions to the record type. To do so,
double-click Actions to display the Actions grid, and then click Edit > Add Action.

9 In the ClearQuest Designer workspace, navigate to the record type’s Behaviors.
Double-click Behaviors to display the Behaviors grid. Verify that the Headline field
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is set to Mandatory for all states. Verify that the Owner field is set to Mandatory for
all Active state types.

10 Validate the schema changes by clicking File > Validate. Fix any errors that
ClearQuest displays, and then check in the schema by clicking File > Check In.

11 Upgrade the user database so that it is associated with the UCM-enabled version
of the schema by clicking Database > Upgrade Database. Alternatively, create a new
user database that is based on the UCM-enabled version of the schema.

Requirements for Enabling Custom Record Types

Before you can apply the UnifiedChangeManagement package to a custom record
type, the record type must meet the following requirements:

■ It contains a field named Headline defined as a SHORT_STRING, and a field
named Owner defined as a REFERENCE to the ClearQuest-supplied users record
type. The Headline field must be at least 120 characters long.

■ It does not contain fields with these names:

❑ ucm_vob_object
❑ ucm_stream
❑ ucm_stream_object
❑ ucm_view
❑ ucm_project

■ It contains an action named Modify of type Modify.

■ It contains a state named Submitted. You can change the name of the state after
you apply the UnifiedChangeManagement package.

Setting State Types

The integration uses a state transition model to help you monitor the progress of
activities. To implement this model, the integration adds state types to UCM-enabled
schemas. Table 2 lists and describes the four state types. You must assign each state to
a state type. You must have at least one state definition of state type Waiting, one of
state type Ready, one of state type Active, and one of state type Complete.

Table 2 State Types in UCM-Enabled Schema

State type Description

Waiting The activity is not ready to be worked on,
either because it has not been assigned or
it has not satisfied a dependency.
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State Transition Default Action Requirements for Record Types

Record types can include numerous state definitions. However, UCM-enabled record
types must have at least one path of transitions among state types as follows: Waiting
to Ready to Active to Complete. The transition from one state to the next must be made
by a default action.

For example, Figure 25 shows the actions and default actions between the states
defined in the UCM-enabled BaseCMActivity record type included in the predefined
UCM schema. The default actions are identified with an asterisk (*). The states are
Submitted, Ready, Active, and Complete. The corresponding state types appear to the
right of the states.

Ready The activity is ready to be worked on. It
has been assigned, and all dependencies
have been satisfied.

Active The developer has started work on the
activity but has not completed it.

Complete The developer has either worked on and
completed the activity, or not worked on
and abandoned the activity.

Table 2 State Types in UCM-Enabled Schema

State type Description
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Figure 25 State Transitions of UCM-enabled BaseCMActivity Record Type

In addition to this single path requirement, states must adhere to the following rules:

■ All Waiting type states must have a default action that transitions to another
Waiting type state or to either a Ready or Active type state.

■ If a Ready type state has an action that transitions directly to a Waiting type state,
that Waiting type state must have a default action that transitions directly to that
Ready type state.

■ All Ready type states must have a default action that transitions to another Ready
type state or to an Active type state.

■ All Ready type states must have at least one action that transitions directly to a
Waiting type state.

■ For the BaseCMActivity record type, its initial state must be a Waiting type.
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Upgrading Your Schema to the Latest UCM Package

If you have a UCM-enabled ClearQuest schema from a previous release of ClearQuest,
you may want to upgrade that schema with the latest revision of the
UnifiedChangeManagement package so that you can use new functionality. To
upgrade the schema, perform the following steps:

1 In the ClearQuest Designer, click Package > Upgrade Installed Packages to start the
Upgrade Installed Packages Wizard.

2 The first page of the wizard lists all schemas that have at least one package that
needs to be upgraded. Select the schema that you want to upgrade, and click Next.

3 The second page of the wizard lists the packages that will be upgraded. Click
Upgrade to accept the changes.

4 If the UnifiedChangeManagement package that you are upgrading from is earlier
than revision 3.0, you need to assign states to state types for each UCM-enabled
record type.

5 Validate the schema changes by clicking File > Validate. Fix any errors that
ClearQuest displays, and then check in the schema by clicking File > Check In.

6 Upgrade the user database to associate it with the new version of the schema by
clicking Database > Upgrade Database.

Customizing ClearQuest Project Policies

To implement the project policies, the integration adds the following pairs of scripts to
a UCM-enabled schema:

■ UCM_ChkBeforeDeliver and UCM_ChkBeforeDeliver_Def
■ UCM_ChkBeforeWorkOn and UCM_ChkBeforeWorkOn_Def
■ UCM_CQActAfterDeliver and UCM_CQActAfterDeliver_Def
■ UCM_CQActBeforeChact and UCM_CQActBeforeChact_Def
■ UCM_CQActAfterChact and UCM_CQActAfterChact_Def

Each policy has two scripts: a base script and a default script. The default scripts have
_Def appended to their names and are installed by the UnifiedChangeManagement
package. The integration invokes the base scripts, which are installed by the
UCMPolicyScripts package. The base script calls the corresponding default script,
which contains the logic for the default behavior. To modify the behavior of a policy,
remove the call to the default script from the base script. Then add logic for the new
behavior to the base script. Adhere to the rules stated in the base script.
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Each script has a Visual Basic version and a Perl version. The Visual Basic scripts have
a UCM prefix. The Perl scripts have a UCU prefix. For ClearQuest clients on Windows
NT, the integration uses the Visual Basic scripts. For ClearQuest clients on UNIX, the
integration uses the Perl scripts. If you modify a policy’s behavior and your
environment includes ClearQuest clients on both platforms, be sure to make the same
changes in both the Visual Basic and Perl versions of the policy’s script. Otherwise, the
policy will behave differently for ClearQuest clients on UNIX and Windows NT.

For descriptions of these policies, see UCM-ClearQuest Integration on page 59.

Associating Child Activity Records with a Parent Activity
Record

As project manager, you may assign activities for large tasks to developers. When the
developers research their activities, they may determine that they need to perform
several separate activities to complete one large activity.

For example, an “Add customer verification functionality” activity may require
significant work in the product’s GUI, the command-line interface, and a library. To
more accurately track the progress of the activity, you can decompose it into three
separate activities.

By using the parent/child controls in ClearQuest, you can accomplish this
decomposition and tie the child activities back to the parent activity.

Using Parent/Child Controls

In ClearQuest, you use controls to display fields in record forms. A parent/child
control, when used with a reference or reference list field, lets you link related records.
By adding a parent/child control to the record form of a UCM-enabled record type,
you can provide the developers on your team with the ability to decompose a parent
activity into several child activities.

To have ClearQuest change the state of the parent activity to Complete when all child
activities have been completed, you need to write a hook. See Administrator’s Guide for
Rational ClearQuest for an example of such a hook.

Creating Users

Before you can assign activities to the developers on your project team, you must create
user account profiles for each developer in ClearQuest. To do so:
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1 In ClearQuest Designer, click Tools > User Administration.

2 Click User Action > Add User.

3 Complete the Add User dialog box.

See Administrator’s Guide for Rational ClearQuest and the ClearQuest Designer Help
for details on creating user profiles.

Setting the Environment (UNIX)

Before you can enable a UCM project to work with a ClearQuest user database, you
must define two environment variables as shown in Table 3. Developers who want to
use the integration must also define these variables on their machines.

The ClearQuest installation directory includes a C shell script, cq_setup.csh, which
you can run to set the environment variables for you. For example:

% source ClearQuest-install-directory/cq_setup.csh

In addition, if you have multiple ClearQuest schema repositories, you must set the
$SQUID_DBSET environment variable to the name of the schema repository you want
to use.

Table 3 Environment Variables Required for Integration

Variable Setting

$CQ_HOME ClearQuest-install-directory/releases/Clea
rquestClient

$LD_LIBRARY_PATH ($SHLIB_PATH on
HP-UX)

Must include:
ClearCase-install-directory/shlib and
ClearQuest-install-directory/releases/Clea
rquestClient/architecture/shlib
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6Setting Up the Project
This chapter describes how to set up a project so that a team of developers can work in
the Unified Change Management (UCM) environment. Before you set up a project, be
sure to plan the project. See Chapter 3, Planning the Project, for information on what to
include in a configuration management plan.

The chapter presents the following scenarios:

■ Creating a project from scratch
■ Creating a project based on an existing base ClearCase configuration
■ Creating a project based on an existing project
■ Enabling a project to use the UCM-ClearQuest integration
■ Working with Rational Suite
■ Creating a development stream reserved for testing new baselines
■ Creating a feature-specific development stream
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Creating a Project from Scratch

This section describes how to create and set up a new project that is not based on an
existing project or on an existing set of ClearCase VOBs.

Creating the Project VOB (Windows)

Product Note: This task does not apply to ClearCase LT users. The ClearCase
administrator creates the PVOB during the installation.

To create a PVOB:

1 Click Start > Programs > Rational Software > Rational ClearCase > Administration >
Create VOB. The VOB Creation Wizard appears.

2 In Step 1 of the VOB Creation Wizard, enter a name for the PVOB. Enter a
comment to describe the purpose of the PVOB. Leave the This VOB will contain
UCM components check box clear. Although you can use one VOB as the PVOB and
a component, we recommend against doing so unless your project is very small
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and you anticipate that it will remain small. Select the Create as a UCM project VOB
check box.

3 In Step 2, specify the PVOB’s storage directory. A PVOB storage directory is a
directory tree that serves as the repository for the PVOB’s contents. A PVOB’s
storage directory contains the same subdirectories as a VOB’s storage directory.
(For details about VOB storage directory structure, see the Administrator’s Guide for
Rational ClearCase.) You can choose one of the recommended locations or enter
the universal naming convention (UNC) path of a different location. Click Browse
to search the network for shared resource locations.

4 Step 3 prompts you to choose an administrative VOB to be associated with the
PVOB. Because you are creating a project from scratch and do not currently use an
administrative VOB, scroll to the top of the list and select none. When you create
components, ClearCase makes AdminVOB hyperlinks between the components
and the PVOB, and the PVOB assumes the role of administrative VOB.

If you are creating multiple PVOBs and anticipate that projects in those PVOBs
may need to modify some of the same components, choose one PVOB to act as the
administrative PVOB and create it first. When you create the other PVOBs, use this
step in the wizard to specify the PVOB that will serve as administrative VOB.
When you create components, ClearCase makes AdminVOB hyperlinks between
the components and the PVOB that serves as the administrative VOB. See Planning
PVOBs on page 42 for details about using multiple PVOBs.

Creating the Project VOB (UNIX)

Product Note: This task does not apply to ClearCase LT users. The ClearCase
administrator creates the PVOB during the installation.

To create a PVOB:

1 Issue the cleartool mkvob command. For example:

cleartool mkvob –tag /vobs/myproj2_pvob –nc –ucmproject \
/usr/vobstore/myproj2_pvob.vbs

The –ucmproject option indicates that you are creating a PVOB instead of a VOB.
The /usr/vobstore/myproj2_pvob.vbs path specifies the location of the PVOB’s
storage directory. A PVOB storage directory is a directory tree that serves as the
repository for the PVOB’s contents. A PVOB’s storage directory contains the same
subdirectories as a VOB’s storage directory. For details about VOB storage
directory structure, see the Administrator’s Guide for Rational ClearCase.

If you are in an MVFS environment and developers use dynamic views, perform
the following two steps.
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2 Create the PVOB mount point to match the PVOB-tag. For example:

mkdir /vobs/myproj2_pvob

3 Mount the PVOB. For example:

cleartool mount /vobs/myproj2_pvob

The PVOB assumes the role of administrative VOB. When you create components,
ClearCase automatically makes AdminVOB hyperlinks between the components and
the PVOB.

If you are creating multiple PVOBs and anticipate that projects in those PVOBs may
need to modify some of the same components, choose one PVOB to act as the
administrative PVOB and create it first. When you create the other PVOBs, use the
cleartool mkhlink command to create an AdminVOB hyperlink between each PVOB
and the PVOB that acts as the administrative VOB. When you create components,
ClearCase makes AdminVOB hyperlinks between the components and the PVOB that
serves as the administrative VOB. See Planning PVOBs on page 42 for details about
using multiple PVOBs.

Creating a Component for Storing the Project Baseline

This task is optional but we strongly recommend it. Using a composite baseline to
represent the project is easier than keeping track of a set of baselines, one for each
component. Although you can store a composite baseline and elements in the same
component, it is cleaner to dedicate one component for storing the project baseline. To
ensure that nobody creates elements in this component, create the component without
a VOB root directory. A component that has no VOB root directory cannot store its own
elements. To create a component without a VOB root directory:

1 On Windows, in the ClearCase Explorer, click UCM and click Project Explorer. On
UNIX, enter the command clearprojexp to start the Project Explorer. The Project
Explorer is the graphical user interface (GUI) through which you create, manage,
and view information about projects.

2 The left pane of the Project Explorer lists folders for all PVOBs in the local
ClearCase domain. Each PVOB has its own root folder. ClearCase creates the root
folder using the name of the PVOB. Navigate to the PVOB that you created.

3 ClearCase also creates a folder called Components, which contains entries for each
component in the PVOB. Right-click the Components folder and select New >
Component Without a VOB from its shortcut menu.

4 In the Create Component Without a VOB dialog box, enter a name and description
for the component. Click OK.
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You may decide to use multiple composite baselines in your project. If you do, we
recommend that you still use one top-level composite baseline that selects the baselines
of all components in the project, either directly or indirectly through other composite
baselines.

Creating Components for Storing Elements

This section describes how to create components for storing the files that your team
develops.

Product Note: The process for creating components that store elements is slightly
different for Rational ClearCase and Rational ClearCase LT.

When you create a component, you must specify the VOB that stores the component’s
directory tree. You can store multiple components in a VOB, or you can create a VOB
that stores one component. See Deciding How Many VOBs to Use on page 30 for details
about using one VOB to store multiple components.

Creating a VOB That Stores Multiple Components (Windows)

To create a VOB that can store multiple components in ClearCase:

1 Start the VOB Creation Wizard.

2 In Step 1, enter a name for the VOB. Enter a comment to describe the purpose of
the VOB. Select the This VOB will contain UCM components check box.

3 In Step 2, select the Allow this VOB to contain multiple components option button
and the Seed the VOB with these components check box. Select a view from the
View list, and click Add.

Enter the component’s name and root directory in the Add Component dialog box,
and click OK. The component appears in the list in the wizard. Click Add to create
additional components. The component’s name must be unique within its PVOB.

4 In Step 3, specify where to store the VOB. You can choose one of the recommended
locations or enter the UNC path of a different location. Click Browse to search the
network for shared resource locations.

5 Step 4 prompts you to identify the PVOB that will store the project information
about the components. Click the arrow to see the list of available PVOBs. Select the
PVOB that you previously created.

To create a VOB that can store multiple components in ClearCase LT:

1 Start the VOB Creation Wizard.
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2 In Step 1, enter a name for the VOB. Enter a comment to describe the purpose of
the VOB.

3 In Step 2, select the Allow this VOB to contain multiple components option button
and the Seed the VOB with these components check box. Select a view from the
View list, and click Add.

Enter the component’s name and root directory in the Add Component dialog box,
and click OK. The component appears in the list in the wizard. Click Add to create
additional components. The component’s name must be unique within its PVOB.

4 In Step 3, specify where to store the VOB. This page of the wizard lists the VOB
storage locations created by your ClearCase administrator. If only one VOB
storage location exists, the VOB Creation Wizard skips this step and uses that VOB
storage location.

Creating a VOB That Stores Multiple Components (UNIX)

To create a VOB that can store multiple components in ClearCase:

1 Use the cleartool mkvob command. For example:

cleartool mkvob –nc –tag /vobs/testvob13 /usr/vobstore/testvob13.vbs

If you are in an MVFS environment and developers use dynamic views, perform
the following two steps.

2 Create the VOB mount point to match the VOB-tag. For example:

mkdir /vobs/testvob13

3 Mount the VOB. For example:

cleartool mount /vobs/testvob13

To create a VOB that can store multiple components in ClearCase LT, use the cleartool
mkvob command. For example:

cleartool mkvob –nc -tag /testvob13 -stgloc vobstore

To create a component and store it in the VOB:

1 In ClearCase Project Explorer right-click the Components folder and select New >
Component in a VOB from the shortcut menu.

2 In the Create a Component in a VOB dialog box select the VOB that will contain
the component from the VOB list. Enter a name for the component and the
component’s root directory. Click OK.
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Creating One Component Per VOB (Windows)

To create a VOB and its one component in ClearCase:

1 Start the VOB Creation Wizard.

2 In Step 1, enter a name for the component. The component’s name must be unique
within its PVOB. Enter a comment to describe the purpose of the component.
Select the This VOB will contain UCM components check box.

3 In Step 2, select the Create VOB as a single VOB-level component check box. The
wizard needs a view in which to perform the operation. Select a view from the
View list.

4 In Step 3, specify where to store the component. You can choose one of the
recommended locations or enter the UNC path of a different location. Click
Browse to search the network for shared resource locations.

5 Step 4 prompts you to identify the PVOB that will store the project information
about the component. Click the arrow to see the list of available PVOBs. Select the
PVOB that you previously created.

ClearCase creates the component with an initial baseline that points to the \main\0

version of the component’s root directory.

To create a VOB and its one component in ClearCase LT:

1 Click Start > Programs > Rational Software > Rational ClearCase LT > ClearCase
Create VOB. The VOB Creation Wizard appears.

2 In Step 1, enter a name for the component. The component’s name must be unique
within its PVOB. Enter a comment to describe the purpose of the component.

3 In Step 2, select the Create VOB as a single VOB-level component check box. The
wizard needs a view in which to perform the operation. Select a view from the
View list.

4 In Step 3, select one of the available storage locations for the VOB’s storage
directory. This page of the wizard lists the VOB storage locations created by your
ClearCase administrator. If only one VOB storage location exists, the VOB Creation
Wizard skips this step and uses that VOB storage location.

Creating One Component Per VOB (UNIX)

To create a VOB and its one component in ClearCase:

1 Make a view by using the cleartool mkview command. For a dynamic view, also
issue the cleartool setview command. For example:
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cleartool mkview –tag myview /net/host2/view_store/myview.vws

cleartool setview myview

2 Create a VOB by using the cleartool mkvob command. For example:

cleartool mkvob –nc –tag /vobs/testvob1 /usr/vobstore/testvob1.vbs

If you are in an MVFS environment and developers use dynamic views, perform
the following two steps.

3 Create the VOB mount point to match the VOB-tag. For example:

mkdir /vobs/testvob1

4 Mount the VOB. For example:

cleartool mount /vobs/testvob1

5 Issue the cleartool mkcomp command. For example:

cleartool mkcomp –nc –root /vobs/testvob1 testcomp1@/vobs/myproj2_pvob

In this example, the mkcomp command creates a component named testcomp1
based on the VOB named testvob1. Although this example uses different names
for the VOB and component, you can use the same name for both. The
component’s name must be unique within its PVOB. The VOB and PVOB must be
mounted before you issue the command. All projects that use the myproj2_pvob
PVOB can access the testcomp1 component.

To create a component in ClearCase LT:

1 Make a view and change to it. For example:

cleartool mkview –stgloc dev_views ~/chris_snap_view

cd ~/chris_snap_view

2 Create a VOB by using the cleartool mkvob command. For example:

cleartool mkvob –nc –tag /testvob1 –stgloc vobstore

3 Issue the cleartool mkcomp command. For example:

cleartool mkcomp –nc –root testvob1 testcomp1@/myproj2_pvob

As an alternative to using the cleartool mkcomp command, you can convert an
existing VOB into a component by using the ClearCase Project Explorer. See Making a
VOB into a Component on page 91 for details.
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Creating the Project

This section shows how to create a project by using the Project Explorer and the New
Project Wizard. For information on creating a project from the command-line interface
(CLI), see the cleartool mkproject, mkstream, and mkfolder reference pages. To create
a project:

1 On Windows, in the left pane of ClearCase Explorer, click UCM and then click
Project Explorer. On UNIX, on the command line, type clearprojexp.

2 The left pane of the Project Explorer lists root folders for all PVOBs in the local
ClearCase domain. Each PVOB has its own root folder. ClearCase creates the root
folder using the name of the PVOB.

ClearCase also creates a folder called Components, which contains entries for each
component in the PVOB. Folders can contain projects and other folders. Select the
root folder for the PVOB that you want to use for storing project information.

3 Click File > New > Folder to create a project folder. You do not need to create a
project folder, but it is a good idea. As the number of projects grows, project
folders are helpful in organizing related projects.

4 In the left pane, select the project folder or root folder. Click File > New > Project.
The New Project Wizard appears.

5 In Step 1 of the New Project Wizard, enter a descriptive name for the project and
provide a comment to describe the purpose of this project. Enter a name for the
project’s integration stream or accept the default name (project name_Integration).
Select the type of project to create. A traditional parallel development project lets
users create multiple streams so that developers can have private and shared work
areas. A single-stream project contains only one stream, the integration stream.
Users cannot create development streams in a single-stream project. See Choosing a
Stream Strategy on page 34 for details about single-stream and multiple-stream
projects.

6 Step 2 asks whether you want to create the project based on an existing project.
Because you are creating a project from scratch, click No.

7 Step 3 asks you to choose the baselines that the project will use.

Click Add to open the Add Baseline dialog box. In the Component list, select one of
the components that you previously created. On Windows, click Change > All
Streams. On UNIX, click the arrow at the end of the From Stream box and select All
Streams. The component’s initial baseline appears in the Baselines list. Select the
baseline. Click OK. The baseline now appears in the list in Step 3. Continue to use
the Add Baseline dialog box until the project contains its full set of foundation
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baselines, including the baseline for the component that stores the project’s
composite baseline.

8 Step 4 prompts you to specify the development policies to enforce for this project.
Select the check boxes for the policies you want to enforce. See Chapter 4, Setting
Policies for information about each policy.

9 Step 5 asks whether to configure the project to work with the ClearQuest
integration. To enable the project to work with Rational ClearQuest, click Yes and
select a ClearQuest user database from the list. See Enabling a Project to Use the
UCM-ClearQuest Integration on page 94 for details about the integration.

Setting a Baseline Naming Template

UCM lets you define a template for implementing a baseline naming convention
within a project. The template can include any of the following tokens:

■ Project
■ Component
■ Stream
■ Date
■ Time
■ User
■ Host
■ Basename

Basename refers to a name that you specify. Use the –blname_template option with the
cleartool mkproject or chproject command to set a template. For example:

cleartool chproject -blname_template project,component,date mck_proj1

This example sets a template that uses the project name, component name, and date in
all baseline names created in the mck_proj1 project. Use commas to separate the tokens
in the command-line entry. When you create baselines, ClearCase replaces the commas
with underscores.

If you do not specify a baseline naming template, ClearCase uses basename to name
new baselines. When necessary, ClearCase appends a numeric identifier to the baseline
name to make it unique.

During deliver operations, ClearCase creates a baseline in the source stream. When
naming this baseline, ClearCase uses deliverbl.source-stream-name.date.unique-identifier
in place of the basename token.

See Command Reference for details about using chproject and mkproject.
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Defining Promotion Levels

ClearCase provides five baseline promotion levels. You can keep some or all of them,
and you can define your own promotion levels. To define the promotion levels that
your project uses:

1 In the Project Explorer, select the PVOB root folder that contains your project, and
then click Tools > Define Promotion Level. All projects that use that PVOB have
access to the same set of promotion levels.

2 The Define Promotion Levels dialog box opens. To remove an existing promotion
level, select it and click Remove. To change the order of promotion levels, select a
promotion level and use the Move Up or Move Down buttons.

3 To add a new promotion level, click Add. The Add Promotion Level dialog box
opens. Enter the name of the new promotion level and click OK. The new
promotion level appears in the list of promotion levels in the Define Promotion
Levels dialog box. Move it to the desired place in the order.

4 When you finalize the set and order of promotion levels, select one to be the initial
promotion level for new baselines. The initial promotion level is the level assigned
by default when you create a baseline.

For information on defining promotion levels from the CLI, see the cleartool setplevel
reference page.

Creating an Integration View

When you create a project, ClearCase creates the project’s integration stream for you.
To see and make changes to the project’s shared elements, you need an integration view.
To create an integration view:

1 In the Project Explorer, navigate to the integration stream by moving down the
object hierarchy:

a Root folder

b Project folder

c Project

d Stream

Figure 26 illustrates this hierarchy.
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Figure 26 Navigating to Integration Stream in Project Explorer

2 Select the integration stream and click File > New > View.

3 On Windows, the View Creation Wizard opens. On UNIX, the Create View dialog
box opens. Accept the default values to create an integration view attached to the
integration stream. By default, the View Creation Wizard and the Create View
dialog box use this convention for the integration view name:
username_project-name_int.

ClearCase supports two kinds of views:

❑ Dynamic views, which use the ClearCase multiversion file system (MVFS) to
provide immediate, transparent access to files and directories stored in VOBs.
On Windows, ClearCase maps a dynamic view to a drive letter in Windows
Explorer.

❑ Snapshot views, which copy files and directories from VOBs to a directory on
your computer.

Product Note: Rational ClearCase LT supports only snapshot views.

We recommend that you make the integration view a dynamic view to ensure that
you always see the correct version of files and directories that developers deliver
to the integration stream. With a snapshot view, you have to perform an update
operation to copy the latest delivered files and directories to your computer. For
more information about dynamic and snapshot views, see Developing Software.

Creating the Composite Baseline That Represents the Project

To create a composite baseline that represents the project by selecting the latest baseline
from each component that the project uses, perform the following steps:
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1 In the Project Explorer, right-click the project’s integration stream to display its
shortcut menu. Click Edit Baseline Dependencies.

2 The Edit Baseline Dependencies dialog box displays a list of all components that
the project uses. Identify the component that will contain the composite baseline.
Drag the other components onto the component that will contain the composite
baseline. For example, in Figure 27 the om2_proj_comp component contains the
composite baseline. The composite baseline selects baselines from the
admin2_comp and security2_comp components.

3 Click OK. The Create Baseline Dependencies dialog box opens.

4 Enter the name in the Base Name (Windows) or Baseline Title (UNIX) field that you
want to use for the baselines that UCM creates for these components. If you have a
baseline naming template set for the project, the Template Name field shows the
name that will be used. If the template does not include the Basename token, or if
no template is set, the Base Name or Baseline Title field does not appear in the
Create Baseline Dependencies dialog box.

5 Click OK.

Figure 27 Using the Edit Baseline Dependencies GUI
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Creating and Setting an Activity (UNIX Only)

Before you can add elements to the integration stream, you need to create and set an
activity.

1 Set your integration view if it is a dynamic view. For example:

cleartool setview kmt_Integration

If your integration view is a snapshot view, change to it.

2 Issue the cleartool mkactivity command. For example:

cleartool mkactivity –headline “Create Directories” create_directories

The ClearCase GUI tools use the name specified with –headline to identify the
activity. The last argument, create_directories, is the activity-selector. Use the
activity-selector when you issue cleartool commands.

3 By default, when you make an activity with the cleartool mkactivity command,
ClearCase sets your view to that activity. ClearCase does not set your view to an
activity if you create multiple activities in the same command line or if you specify
a stream with the –in option. If you need to set your integration view to the
activity, use the cleartool setactivity command. For example:

cleartool setactivity create_directories

Creating the Directory Structure

Because you are creating the project from scratch, you need to create the directory
elements within the project’s components to implement the directory structure that
you define during the planning phase. See Defining the Directory Structure on page 32.

On Windows

To add a directory element to a component:

1 In Windows Explorer, navigate to the integration view. Double-click the
component to display its contents. If the component is in a VOB that you created to
store multiple components, the component appears as a folder under the VOB.

2 Create a folder.

3 Right-click the folder to display the shortcut menu. Click ClearCase > Add to
Source Control.

4 When prompted, specify an activity to be associated with the addition of the new
directory element.
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On UNIX

To add a directory element to a component:

1 With your integration view set to an activity, navigate to the component. If the
component is in a VOB that you created to store multiple components, the
component appears as a directory under the VOB. For example:

cd /vobs/testvob13/libs

2 Check out the component’s root directory. For example:

cleartool co –nc .

3 Issue the cleartool mkelem command. For example:

cleartool mkelem –nc –eltype directory design

This example creates a directory element called design. By default, the mkelem
command leaves the element checked out. To add elements, such as subdirectories,
to the directory element, you must leave the directory element checked out.

4 When you finish adding elements to the new directory, check it in. For example:

cleartool ci –nc design 

5 When you finish creating directory elements, check in the component’s root
directory. For example:

cleartool ci –nc .

For more information about creating directory and file elements, see Developing
Software and the mkelem reference page.

Importing Directories and Files from Outside ClearCase

If you have a large number of files and directories that you want to place under
ClearCase version control, you can speed the process by using the clearexport and
clearimport command-line utilities. These two utilities allow you to migrate an
existing set of directories and files from another version control software system, such
as SourceSafe, RCS or PVCS, to ClearCase.

To migrate source files into a component:

1 Run clearexport to generate a data file from your source files.

2 Create and set a non-UCM view. On Windows use the View Creation Wizard. To
start the View Creation Wizard, from ClearCase Explorer click Base ClearCase >
Create View. On UNIX use the cleartool mkview and setview commands.

3 From within the view, run clearimport to populate the component with the files
and directories from the data file.
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4 In the component, create a baseline from a labeled set of versions. If the versions
that you want to include in the baseline are not labeled, create a label type and
apply it to the versions. See Making a Baseline from a Label on page 91 for details.

As an alternative, you can use clearexport and clearimport on VOBs, and then convert
the VOBs to components. See Creating a Project Based on an Existing ClearCase
Configuration on page 90 for details on converting VOBs into components.

To migrate directories and flat files that are not currently under any version control, use
the clearfsimport command-line utility. Run clearfsimport from within a UCM view
to import directories and files directly onto a stream. You can then create a baseline in
the stream without having to label the versions. See the clearfsimport reference page
for details.

For details on using clearexport and clearimport, see the Administrator’s Guide for
Rational ClearCase and the clearexport and clearimport reference pages.

ClearCase on Windows provides the Import Wizard, a GUI that you can use as an
alternative to the clearexport and clearimport commands. You can start the Import
Wizard from the Getting Started Wizard.

Making and Recommending a Baseline

After you create the directory structure and import files, create and recommend a new
baseline that selects those directory and file elements. Developers who join the project
populate their development streams with the versions identified by the recommended
baseline. For details on making baselines, see Creating a New Baseline on page 110. For
details on recommending baselines, see Recommending the Baseline on page 114.

Creating a Project Based on an Existing ClearCase
Configuration

If you have existing VOBs, you may want to convert them or their directories into
components so that you can include them in projects. This section describes how to set
up a project based on existing VOBs.

Creating the PVOB

On Windows, use the VOB Creation Wizard, as described in Creating the Project VOB
(Windows) on page 76, to create the PVOB. In Step 3, if you currently use an
administrative VOB, select it in the list. ClearCase creates an AdminVOB hyperlink
between the PVOB and the administrative VOB. When you create components, they
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use the existing administrative VOB. If you do not currently use an administrative
VOB, select none.

On UNIX, use the cleartool mkvob command as described in Creating the Project VOB
(UNIX) on page 77. If you currently use an administrative VOB, use the cleartool
mkhlink command to create an AdminVOB hyperlink between the PVOB and the
administrative VOB. When you create components, they then use the existing
administrative VOB.

Making a VOB into a Component

To make a VOB into a component:

1 In the Project Explorer, select the PVOB. On Windows, click Tools > Import > VOB
as Component. On UNIX, click Tools > Import > Import VOB. The Import VOB
dialog box opens.

2 In the Available VOBs list, select the VOB that you want to make into a component.
Click Add to move the VOB to the VOBs to Import list. You can add more VOBs to
the VOBs to Import list. If you change your mind, you can select a VOB in the VOBs
to Import list and click Remove to move it back to the Available VOBs list. When you
are finished, click Import.

You may want to organize the contents of a VOB into multiple components. To make a
directory tree within a VOB into a component:

1 In the Project Explorer, right-click the PVOB folder and select Import > VOB
Directory as Component.

2 In the Import VOB Directory as Component dialog box, select a view from the View
list; select the VOB that contains the directory from the VOB list; select the
directory from the Root Directory list; and specify a name for the component.

The new component contains the directory and all its subdirectories and files. The
component’s root directory must be at or directly below the VOB root directory. If
the component’s root directory is at the VOB root directory, that VOB cannot store
multiple components.

Making a Baseline from a Label

After you convert an existing VOB or one of its directory trees into a component, to
access the directories and files in that component, you must create a baseline from the
set of versions identified by a label type. To create the baseline:

1 On Windows, if the set of versions that you want to use are not already labeled,
use the Apply Label Wizard to make and apply a label type. To start the Apply
Label Wizard, click Start > Programs > Rational Software > Rational ClearCase >
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Apply Label Wizard. Alternatively, you can enter clearapplywizard at the command
prompt.

On UNIX, if the set of versions that you want to use are not already labeled, use
the cleartool mklbtype and mklabel commands to create and apply a label type.
For example:

% cleartool mklbtype –c “label for release 2” REL2
Created label type “REL2”.

% cleartool mklabel -recurse REL2 .
Created label “REL2” on “.” version “/main/5”.

Created label “REL2” on “./src” version “/main/6”.

Created lable “REL2” on “./src/Makefile” version “/main/2”.

The –recurse option directs ClearCase to apply the label to all versions at or below
the current working directory.

2 In the Project Explorer, select the PVOB. On Windows, click Tools > Import > Label
as Baseline. On UNIX, click Tools > Import > Import Label. Step 1 of the Import
Label Wizard appears.

3 In the Available Components list, select the component that contains the label from
which you want to create a baseline. Click Add to move that component to the
Selected Components list. If you change your mind, select a component in the
Selected Components list and click Remove to move the component back to the
Available Components list.

4 In Step 2, select the label type that you want to import, and enter the name of the
baseline that you want to create for the versions identified by that label type. Then
select the baseline’s promotion level. Note: You cannot import a label type from a
global label type definition.

Creating the Project

Use the New Project Wizard to create the project as described in Creating the Project on
page 83.

Creating an Integration View

Create an integration view as described in Creating an Integration View on page 85.

Creating a Project Based on an Existing Project

As you create new projects, you may need to create new versions of existing projects.
For example, suppose you have released version 3.0 of the Webotrans project and are
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planning for version 3.1. You anticipate that version 3.1 will use the same components
as version 3.0. Therefore, you want to use the latest baselines in the version 3.0
components as the foundation baselines for version 3.1 development.

Using a Composite Baseline to Capture Final Baselines

If the existing project contains numerous components, you may want to create a
composite baseline that selects the final baselines of those components before you
create the new project. This composite baseline serves as a single starting point for
teams that want to start their work from the final approved baselines of the existing
project. To create such a composite baseline, perform the following steps:

1 Create a component that does not have a root directory in a VOB. See Creating a
Component for Storing the Project Baseline on page 78.

2 Add the initial baseline of the component to the integration stream. See Adding
Components on page 105.

3 In the component, create a composite baseline that selects baselines of all other
components in the project. See Creating the Composite Baseline That Represents the
Project on page 86.

4 Recommend the composite baseline. See Recommending the Baseline on page 114.

Reusing Existing PVOB and Components

Because your project is a new version of an existing project and uses the same
components as the existing project, do not create a new PVOB for this project. Continue
to use the existing PVOB.

Creating the Project

Start the New Project Wizard, as described in Creating the Project on page 83, to create
the project.

In Step 2 of the wizard, select Yes to indicate that the project begins from the baselines
in an existing project. Then navigate to the project that contains those baselines.
Figure 28 shows that the new project is based on the baselines in the
OM_proj1.0_Integration stream.
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Figure 28 Step 2 of New Project Wizard

Step 3 lists the latest baselines in the project that you select in Step 2. If you created a
composite baseline to capture the final approved baselines in the existing project, select
it. You can add baselines from components that are not part of the existing project by
clicking Add to open the Add Baseline dialog box. Similarly, you can remove a baseline
by selecting it and clicking Remove.

Finish the remaining steps in the wizard as described in Creating the Project on page 83.

Creating an Integration View

When you create a new project, ClearCase creates a new integration stream for you.
Therefore, you need to create a new integration view to access elements in the
integration stream. Create an integration view as described in Creating an Integration
View on page 85.

Enabling a Project to Use the UCM-ClearQuest
Integration

Before you can connect a project to a ClearQuest user database, you must set up the
database to use a UCM-enabled schema. See Chapter 5, Setting Up a ClearQuest User
Database.

To enable a project to work with a ClearQuest user database:

1 In the left pane of the Project Explorer, right-click the project to display its shortcut
menu. Click Properties to display its property sheet.
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2 Click the ClearQuest tab and then select the Project is ClearQuest-enabled check
box. Select the user database that you want to link to the project. The first time that
you enable a project, ClearQuest opens its Login dialog box. Enter your user name,
password, and the name of the database to which you are linking the project.

3 Select the development policies that you want to enforce. See UCM-ClearQuest
Integration on page 59 for a description of these policies. Click OK when you are
finished.

If you are creating a new project, you can enable the project to work with ClearQuest
by selecting Yes, use the ClearQuest database selected below and selecting the user
database in Step 5 of the New Project Wizard, as shown in Figure 29.

After you enable a UCM project to work with a ClearQuest user database, you may
decide to link the project to a different user database. You can switch databases by
selecting a different one on the ClearQuest tab of the project’s property sheet if no
activities have been created.

Migrating Activities

If your project contains activities when you enable it to work with a ClearQuest
database, the integration creates records for each of those activities by using the
UCMUtilityActivity record type. If you want to store all of your project’s activities in
records of some other record type, enable the project when you create it, before team
members create any activities. After the migration is complete, any new activities that
you create can link to records of any UCM-enabled record type.
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Figure 29 Enabling a Project to Work with a ClearQuest User Database

Setting Project Policies

A UCM-enabled schema includes four policies that you can set from either ClearCase
or ClearQuest.

In ClearCase, set the policies by selecting check boxes on the ClearQuest tab of the
project’s property sheet, as shown in Figure 29.

To set policies from ClearQuest:

1 On Windows, start the ClearQuest client by clicking Start > Programs > Rational
Software > Rational ClearQuest > Rational ClearQuest. On UNIX, start the
ClearQuest client by entering clearquest at the shell prompt. In the ClearQuest
client workspace, navigate to the UCMProjects query, as shown in Figure 30.

2 Double-click the query to display all UCM-enabled projects.

3 Select a project from the Results set. The project’s form appears.

4 On the form, click Actions and select Modify. Select the check boxes for the policies
you want to set.
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For descriptions of the policies, see UCM-ClearQuest Integration on page 59.

Figure 30 Navigating to the UCMProjects Query

Assigning Activities

To create and assign activities in ClearQuest:

1 Start the ClearQuest client, and log on to the user database connected to the
project.

Project 
Manager

Assign and 
schedule work

Monitor 
project status

Establish 
policies

Create 
project
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2 Click Actions > New. The Choose a record type dialog box opens. Select a
UCM-enabled record type, and click OK.

3 The Submit form appears. Fill in the boxes on each tab. When you finish filling in
the boxes, click OK. ClearQuest creates the record and leaves it in a Submitted
type state.

4 Run a query and select the record. For example, if the record type is Defect, you
can run the All Defects query.

5 Click Actions > Assign, and select the owner from the Owner list. Click Apply.

User account profiles must exist in ClearQuest for the developers to whom you assign
activities. See Creating Users on page 72 for details on creating user account profiles.

Disabling the Link Between a Project and a ClearQuest User Database

There may be times when you want to disable the link between a project and a
ClearQuest user database. To disable the links:

1 On the ClearQuest tab of the project’s property sheet, clear the Project is
ClearQuest-enabled check box.

2 Click OK on the ClearQuest tab. The integration disables the link between the
project and the ClearQuest database. The integration also removes any existing
links between activities and their corresponding ClearQuest records.

3 Display the project’s property sheet again, select the Project is ClearQuest-enabled
check box, and select another user database if you want to link the project to a
different user database.

Note: If you select the same user database that you just unlinked, the integration
creates new ClearQuest records for the project’s activities; it does not link the
activities to the ClearQuest records with which they were previously linked.

Fixing Projects That Contain Linked and Unlinked Activities

It is possible that after you enable a project to work with ClearQuest, some of the
project’s activities remain unlinked to ClearQuest records. Similarly, when you disable
the link between a project and ClearQuest, some activities may remain linked. The
following scenarios can cause your project to be in this inconsistent state:

■ A network failure or a general system crash occurs during the enabling or
disabling operation and interrupts the activity migration.

■ The ClearQuest user database can become corrupted, forcing you to restore a
backed-up version of the user database. That version of the user database is out of
sync with the PVOB that contains the project that is linked to the user database.
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■ You use the cleartool command-line interface to rename an activity or a project.
When you rename an activity or project from the command-line interface, the
UCM-ClearQuest integration does not update the corresponding ClearQuest
record with the name change. As a result, the ClearCase and ClearQuest objects
are out of synch.

■ The project’s PVOB is in a ClearCase MultiSite configuration, and unlinked
activities were added by a MultiSite synchronization operation to the local PVOB’s
project, which is enabled to work with ClearQuest.

Detecting the Problem

If a developer attempts to take an action, such as modifying an unlinked activity in an
enabled project, the integration displays an error and disallows the action.

Correcting the Problem

If the problem is the result of one of the first three scenarios previously mentioned, use
the cleartool checkvob command with the –ucm option to restore the project to a
consistent state. See Administrator’s Guide for Rational ClearCase and Command
Reference for details about using this command.

If the problem is caused by MultiSite, perform the following actions at the remote site:

1 In the Project Explorer, display the project’s property sheet, and click the
ClearQuest tab.

2 Click Link all unlinked activities mastered at this replica. The integration checks all
of the project’s activities and links any that are unlinked. The integration then
displays the following summary information:

❑ Number of activities that had to be linked.

❑ Number of activities that were previously linked.

❑ Number of activities that could not be linked because they are not mastered in
the current PVOB replica. In this case, the integration also displays a list of
replicas on which you must run the Link all unlinked activities mastered at this
replica operation again to correct the problem.

3 At each replica on the list described in Step 2, repeat Step 1 and Step 2.

How MultiSite Affects the UCM-ClearQuest Integration

If you use ClearCase MultiSite to replicate the PVOB and ClearQuest MultiSite to
replicate the ClearQuest user database and schema repository involved in the
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UCM-ClearQuest integration, you need to be aware of several requirements. This
section describes those requirements.

Replica and Naming Requirements

When you set up the UCM-ClearQuest integration, you establish a link between a
project and a ClearQuest user database. If you use MultiSite, the following
requirements apply:

■ Each site that has a PVOB replica that contains a linked project must have a replica
of the ClearQuest user database to which the project is linked and the user
database’s schema repository. Similarly, each site that contains a linked ClearQuest
user database replica must contain a replica of the PVOB that contains the project
to which the user database is linked.

■ The name of the ClearQuest replica must match the name of the PVOB replica at
the same site.

Transferring Mastership of the Project

Before you enable a project to work with ClearQuest, your current PVOB replica must
master the project. If your replica does not master the project, transfer mastership of
the project by using the multitool chmaster command at the replica that masters the
project.

When you enable the project to work with ClearQuest, the integration creates a
corresponding project record in the ClearQuest user database and assigns mastership
of that record to the current replica of the ClearQuest user database. If a project record
with the same name as the project exists in the ClearQuest user database when you
enable the project, and that project record is not mastered by your current replica, you
must transfer mastership of the project record to your current replica.

Linking Activities to ClearQuest Records

If a project contains activities, when you enable that project to work with ClearQuest,
the integration creates corresponding ClearQuest records for the activities and links
the records to the activities. The integration cannot link activities that are mastered by
remote replicas. See Correcting the Problem on page 99 for details about linking activities
that are mastered by a remote replica.

Changing Project Policy Settings

Before you can change a project’s policy settings from within ClearQuest, the
ClearQuest project record must be mastered. Similarly, before you can change a
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project’s policy settings from within ClearCase, the project object must be mastered.
After you change a project’s policy settings in the current replica, the new settings do
not take effect in streams in sibling replicas until you synchronize the current replica
with those replicas. See the Administrator’s Guide for Rational ClearCase MultiSite for
details on synchronizing replicas.

Changing the Project Name

The integration links a project name to the name field in the corresponding ClearQuest
project record. If you change the project name in the ClearCase GUI, the integration
makes the same change to the name field in the corresponding ClearQuest project
record. Similarly, if you change the name in ClearQuest, the integration makes the
same change to the project name in ClearCase. Before you can change the project name
in a MultiSite environment, the project record and the project object must both be
mastered.

Note: Change the project name only by using a GUI, such as ClearCase Project Explorer.
If you change the project name by using the command-line interface, the integration
does not make the same change to the corresponding project record.

Working with Rational Suite (Windows)

If you are using UCM with Rational Suite, you can store Rational RequisitePro projects,
Rational Rose and XDE models, and Rational Test datastores in UCM components and
include them in baselines. To enable this integration, use the Rational Administrator
GUI to create and configure a Rational project. A Rational project associates your UCM
project with a RequisitePro project, Rose models, and Rational Test datastores. For
details on setting up this integration, see Using UCM and Rational Suite.

Creating a Development Stream for Testing Baselines

Integrator

Make 
baselines

Recommend 
baselines

Build 
components

Create a 
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When you make a new baseline, we recommend that you lock the integration stream
so that you can build and test a static set of files. Otherwise, developers can
inadvertently cause confusion by delivering changes while you are building and
testing. Locking the integration stream for a short period of time is acceptable; locking
the integration stream for several days can result in a backlog of completed but
undelivered activities. To avoid locking out developers for a long period of time, you
may want to create a development stream and use it for extensive testing of baselines.
If your project uses feature-specific development streams, you may want to create a
testing stream for each feature-specific development stream so that you can test the
baselines created in those streams.

To create a development stream:

1 In ClearCase Project Explorer, right-click the integration stream, and select Create
Child Stream from the shortcut menu.

The Create a Development Stream dialog box appears.

2 If you do not want to allow changes to be made in the testing stream, select the
Make Stream read only check box. If you select this option, you cannot fix defects
discovered in the baseline in this stream. Instead, the developers responsible for
the defects would need to make the fixes in their development streams and deliver
them to the integration stream.

3 By default, ClearCase uses the set of recommended baselines when creating a
development stream. Because the new baseline has not been tested extensively,
you probably have not yet promoted it to the level associated with recommended
baselines. To create the development stream with baselines other than the
recommended baselines, click Advanced Options.

The Change Baseline dialog box appears.

4 In the Change Baseline dialog box, select the component that contains the baseline
you want to test. Click Change.

A second Change Baseline dialog box appears, listing all baselines for the
component.

5 Select the baseline that you want to test, and click OK. If you need to test the
baseline of another component, select it in the first Change Baseline dialog box and
repeat the process. When you are finished, click OK in the first Change Baseline
dialog box.

6 In the Create a Development Stream dialog box, be sure that the Prompt me to
create a View for this stream check box is selected. Click OK.

The View Creation Wizard (Windows) or Create View dialog box (UNIX) appears.
102 Managing Software Projects



7 Complete the steps of the View Creation Wizard or the fields of the Create View
dialog box to create a view for the development stream.

Now the development stream is configured so that you can build and test the new
baselines, and developers can deliver changes to the integration stream without being
concerned about interfering with the building and testing process. For information on
testing baselines, see Testing the Baseline on page 113.

Creating a Feature-Specific Development Stream

The basic UCM process uses the integration stream as the project’s sole shared work
area. You may choose to organize your project into small teams of developers where
each team develops a specific feature. To support this type of organization, create a
development stream to serve as the shared work area for each team of developers. The
developers who work on that feature create their own development streams based on
the recommended baselines in the feature-specific development stream. See Choosing a
Stream Strategy on page 34 for additional information about feature-specific
development streams.

To create a feature-specific development stream:

1 In ClearCase Project Explorer, right-click the integration stream, and select Create
Child Stream from the shortcut menu.

The Create a Development Stream dialog box appears.

2 By default, ClearCase uses the set of recommended baselines when creating a
development stream. To create the development stream with baselines other than
the recommended baselines, click Advanced Options and select the baselines from
the Change Baseline dialog box.

3 In the Create a Development Stream dialog box enter a name and description for
the new stream. Be sure that the Prompt me to create a View for this stream check
box is selected. Click OK.

On Windows, the View Creation Wizard appears.

On UNIX, the Create View dialog box appears.

4 Complete the steps of the View Creation Wizard or the Create View dialog box to
create a view for the development stream.

5 In ClearCase Project Explorer, right-click the feature-specific development stream,
and select Recommend Baselines.

6 In the Recommended Baselines dialog, click Add to display the Add Baseline
dialog box. Select the baselines that you want to recommend to developers who
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will work on this feature. When developers create their own development streams,
those streams will be based on the recommended baselines. When you finish
selecting the baselines, click OK in the Recommended Baselines dialog.
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7Managing the Project
After you create and set up a project, developers join the project, work on activities,
and deliver completed activities to the integration stream or feature-specific
development stream. In your role as integrator, you need to maintain the project so that
developers do not get out of sync with each other’s work. This chapter describes the
following maintenance tasks:

■ Adding components
■ Building components
■ Making new baselines
■ Testing baselines
■ Recommending baselines
■ Monitoring project status
■ Cleaning up the project

Adding Components

Over time, the scope of your project typically broadens, and you may need to add
components. To add a component to a stream:

1 Windows: In the left pane of ClearCase Explorer, click UCM and then click Project
Explorer.

UNIX: Enter clearprojexp to start ClearCase Project Explorer.

2 In the right pane of the Project Explorer, right-click the stream to display its
shortcut menu. Click Properties to open the stream’s Properties dialog box.

3 Click the Configuration tab, and then click Add. The Add Baseline dialog box
opens, as shown in Figure 31.

4 Windows: Click Change > All Streams or Change > Browse to select the stream that
contains the component baseline you want to add.

UNIX: Click the arrow at the end of the From Stream box and either select a stream
from the tree hierarchy or by clicking All Streams.

5 In the Component list, select the component that you want to add. The
component’s baselines appear in the Baselines list.
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Figure 31 Add Baseline Dialog Box

6 In the Baselines list, select the baseline that you want to add to the project.

7 Click OK. The Add Baseline dialog box closes, and the baseline that you chose
appears on the Configuration tab.

8 Click OK to close the stream’s Properties dialog box.

The Rebase Stream Preview dialog box opens. To modify the stream’s
configuration to include the new foundation baseline, UCM needs to rebase the
stream.

9 Click OK in the Rebase Stream Preview dialog box.

10 Click Complete to finish the rebase operation.

Making the Component Modifiable

By default, Rational ClearCase adds the component to the project as read-only. To make
the component modifiable within the project, perform the following steps:

1 In the Project Explorer, select the project, and click File > Policies.

2 In the Components tab, click the check box next to the component.

3 Click OK.

Synchronizing the View

Before you can access the component that you added, you must synchronize your view
with the stream’s new configuration by performing the following steps:
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1 In the Project Explorer, select the stream that contains the component you added,
and click File > Properties.

2 Click the Views tab. Select the view and click Properties.

3 On the General tab, click Synchronize with stream.

Synchronizing Child Streams

To enable a child stream to access the component, you must synchronize the child
stream with the project’s new set of modifiable components, and you must synchronize
the child stream’s view with the stream’s new configuration.

To synchronize a child stream with the project’s set of modifiable components, perform
the following steps:

1 In the Project Explorer, select the stream and click File > Properties.

2 On the General tab, click Synchronize with project.

To synchronize a child stream’s view with the stream’s new configuration, perform the
following steps:

1 In the Project Explorer, select the stream and click File > Properties.

2 Click the Views tab. Select the view and click Properties.

3 On the General tab, click Synchronize with stream.

Updating Snapshot View Load Rules

If your view is a snapshot view, you need to edit the view’s load rules to include the
components that you add to the stream. A snapshot view’s load rules specify which
components ClearCase loads into the view. To edit the view’s load rules:

1 In the Project Explorer, select the stream, and click File > Properties to display the
stream’s property sheet.

2 In the property sheet, click the Load Rules tab.

3 Select the component or components that you added to the stream.

4 Click Add. Click OK to close the property sheet.

In addition, you need to know whether any developers working on the project use
snapshot views for their development views. When a developer who uses a snapshot
view rebases to a baseline that contains a new component, ClearCase updates the
snapshot view’s config spec, but it does not update the view’s load rules. When you
add a component, notify developers who use snapshot views that they need to update
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the load rules for their development views after they rebase their development streams
to the new baseline.

Building Components

Before you make new baselines in a stream, build the components by using the current
baselines plus any work that developers have delivered to the stream since you created
the current baselines. If the build succeeds, you can make baselines that select the latest
delivered work. Building components involves the following tasks:

■ Locking the stream
■ Finding remote deliver operations
■ Completing remote deliver operations
■ Undoing bad deliver operations
■ Building and testing the components

Locking the Integration Stream

Before you build components in the integration stream or feature-specific development
stream, lock the stream to prevent developers from delivering work. This ensures that
you are dealing with a static set of files.

1 In the Project Explorer, select the stream.

2 Click File > Properties to display the stream’s property sheet.

3 Click the Lock tab.

4 Click Locked and then click OK.

Note: It is possible that a developer could be in the process of completing a deliver
operation when you lock the stream. This scenario could result in some files associated
with an activity not being checked in, which, in turn, could break your build operations
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and produce bad baselines. You may want to create a script that checks for deliveries
in progress, and run the script before you lock the stream.

Finding Work That Is Ready to Be Delivered

Before you build components, you may need to complete some deliver operations. In
most cases, developers complete their deliver operations. However, in a MultiSite
configuration in which the target stream is mastered at a different replica than the
developer’s source stream, the developer cannot complete deliver operations. When
ClearCase detects such a stream mastership situation, it makes the deliver operation a
remote deliver operation.

In a remote deliver operation, ClearCase starts the deliver operation but leaves it in the
posted state. It is up to you, as integrator, to find and complete deliver operations in
the posted state. Developers who have deliver operations in the posted state cannot
deliver from or rebase their source development streams until you complete or cancel
their deliver operations.

Product Note: Rational ClearCase LT does not support ClearCase MultiSite.

To find all deliver operations that are in the posted state:

1 In the Project Explorer, select the project.

2 Click Tools > Find Posted Deliveries. If the project contains posted deliveries, the
Find Posted Deliveries dialog box appears and lists all streams within the project
that contain deliver operations in the posted state. For each posted deliver
operation, the dialog box shows the source stream and the target stream.

To find posted deliver operations for a specific target stream, select the stream and click
Tools > Find Posted Deliveries. The Find Posted Deliveries dialog box lists the source
streams that have posted deliver operations for the target stream. The Find Posted
Deliveries dialog box lists posted deliver operations only for source streams that are
direct children of the target stream.

Completing Remote Deliver Operations

To complete remote deliver operations for a development stream:

1 Select the development stream from the list in the Find Posted Deliveries dialog
box.

2 Click Deliver. The Deliver dialog box opens. Click Resume to resume the deliver
operation. Click Cancel to cancel the deliver operation. See Developing Software for
details on completing the deliver operation.
Chapter 7 - Managing the Project 109



Undoing a Deliver Operation

At any time before developers complete the deliver operation, they can back out of it
and undo any changes made; but if they check in their versions to the integration view,
they cannot undo the changes easily. When this happens, you may need to remove the
checked-in versions by using the cleartool rmver –xhlink command.

Note: The rmver command erases part of your organization’s development history, and
it may have unintended consequences. Therefore, be very conservative in using this
command, especially with the –xhlink option. See the rmver reference page in the
Command Reference for details.

Note that removing a version does not guarantee that the change is really gone. If a
successor version was created or if the version was merged before you removed the
version, the change still exists. You may need to check out the file, edit it to remove the
change, and check the file back in.

Building and Testing the Components

After you lock the stream and complete any outstanding deliver operations, you are
ready to build and test the project’s executable files to make sure that the changes
delivered by developers since the last baseline do not contain any bugs. For
information on performing builds, see Building Software. Because you lock the stream
when you build and test in it, we recommend that you use a separate development
stream for extensive testing of new baselines. Perform only quick validation tests in the
current stream so that it is not locked for an extended period of time. See Testing the
Baseline on page 113 for information about using a development stream for testing new
baselines.

Creating a New Baseline
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As developers deliver work to the integration stream or feature-specific development
stream, it is important that you make new baselines frequently to record the changes.
Developers can then rebase to the new baselines and stay current with each other’s
changes. Before you make the baseline, make sure that the stream is still locked so that
developers cannot deliver work to the stream.

Making the New Baseline

To make new baselines for all components in the stream:

1 In the Project Explorer, select the integration stream or feature-specific
development stream where you want to make the baseline.

2 Click Tools > Make Baseline. The Make Baseline dialog box opens (Figure 32).

Figure 32 Make Baseline Dialog Box

3 If you have a baseline naming template set for the project, the Template Name field
shows the name that will be used for the new baseline. In Figure 32, the project
uses a baseline naming template that includes the project, component, and date
tokens. Enter a name in the Base Name (Windows) or Baseline Title (UNIX) field
only if the project does not have a baseline naming template set or the template
includes the basename token. Otherwise, the Base Name or Baseline Title field does
not appear in the Make Baseline dialog box.

4 Choose the type of baseline to create.
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An incremental baseline is a baseline that ClearCase creates by recording the last full
baseline and those versions that have changed since the last full baseline was
created.

A full baseline is a baseline that ClearCase creates by recording all versions below
the component’s root directory.

Generally, incremental baselines are faster to create than full baselines; however,
ClearCase can look up the contents of a full baseline faster than it can look up the
contents of an incremental baseline.

5 Specify a view in which to perform the operation. Choose a view that is attached to
the stream where you want to make the baseline.

Making a Baseline for a Set of Activities

By default, all activities modified since the last baseline was made are included in the
new baseline. There might be times when you want to create a baseline that includes
only certain activities. To do so, click the Activities tab in the Make Baseline dialog box,
and select the activities that you want to go into the baseline.

Making a Baseline of One Component

To make a baseline for one specific component rather than all components in the
stream, perform the following steps:

1 In the Project Explorer, select the stream in which you want to create a new
baseline. Click File > Properties to display the stream’s property sheet.

2 Click the Baselines tab. Select a component, and click Make Baseline.

3 Fill in the fields of the Make Baseline dialog box, then click OK.

Unlocking the Stream

After you create a new baseline, unlock the integration or feature-specific development
stream so that developers can resume delivering work to the stream. To unlock the
stream:

1 In the Project Explorer, select the stream.

2 Click File > Properties to display the stream’s property sheet.

3 Click the Lock tab.

4 Click Unlocked and then click OK.
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Testing the Baseline

To avoid locking the integration stream or feature-specific development stream for an
extended period of time, we recommend that you use a separate development stream
for performing extensive testing, such as system, regression, and acceptance tests, on
new baselines. See Creating a Development Stream for Testing Baselines on page 101 for
information on creating a development stream.

After you create a new baseline and verify that it builds and passes an initial validation
test in the integration stream, rebase the development stream:

1 In the Project Explorer, select the development stream and click Tools > Rebase
Stream.

The Rebase Stream Preview dialog box opens.

2 By default, ClearCase rebases your development stream to the recommended
baselines. Because the new baseline has not been tested extensively, you probably
have not yet promoted it to the level associated with recommended baselines. To
rebase to the baseline, or baselines, you want to test, click Advanced.

The Change Rebase Configuration dialog box opens.

3 Select a component that contains a baseline you want to test. Click Advanced.

The Change Rebase Configuration dialog box opens, listing all baselines for the
component.

4 Select the baseline that you want to test, and click OK.

5 Select another component in the Change Rebase Configuration dialog box and
repeat the process. When you finish selecting baselines, click OK to close the
Change Rebase Configuration dialog box.

6 Click OK in the Rebase Stream Preview dialog box to continue the rebase
operation. See the Help or Developing Software for details on rebasing a
development stream. When you finish rebasing the development stream, you are
ready to begin testing the new baselines.

Fixing Problems

If you discover a problem with a baseline while testing it, fix the affected files and
deliver the changes to the integration stream as follows:

1 From the development view attached to the development stream, check out the
files you need to fix. When you check out a file, you need to specify an activity.

2 Make the necessary changes to the files and check them in.
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3 Build and test the changes in the development view.

4 When you are confident that the changes work, make a new baseline that
incorporates the changes in the development stream.

5 Deliver the new baseline to the integration or feature-specific development stream.
When you deliver the new baseline to the integration or feature-specific
development stream, you merge changes with work that developers have
delivered since the last baseline was created. For information about delivering
baselines, see Chapter 9, Managing Parallel Releases of Multiple Projects.

6 Change the set of recommended baselines for the integration stream or
feature-specific development stream to include the new baseline that you made in
the testing stream. For details about recommending a baseline in another stream,
see Recommending the Baseline on page 114.

Recommending the Baseline

As work on your project progresses and the quality and stability of the components
improve, change the baseline’s promotion level attribute to reflect a level of testing that
the baseline has passed, and recommend baselines that have passed extensive testing.

To change a baseline’s promotion level:

1 Windows: In the Project Explorer, right-click the stream to display its shortcut
menu. Click Properties to open the stream’s Properties dialog box.

UNIX: In the Project Explorer, select the stream. Click File > Properties to open the
stream’s Properties dialog box.

2 Click the Baselines tab.
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3 In the Components list, select the component that contains the baseline you want to
promote. In the Baselines list, select the baseline. Click Properties. The baseline’s
Properties dialog box opens.

4 Click the arrow in the Promotion Level list to display all available promotion levels.
Select the new promotion level.

To recommend a baseline or set of baselines:

1 In the Project Explorer, select the stream. Click Tools > Recommend Baselines.

2 In the Recommended Baselines dialog box, you can filter the list of baselines
displayed by selecting a promotion level and clicking Seed List. The dialog box
then displays only baselines at or above the selected promotion level.

3 To remove a baseline from the list, select it and click Remove. To add a baseline,
click Add and select the baseline in the Add Baseline dialog box.

4 To recommend a different baseline of a component, select the baseline and click
Change. In the Change Baseline dialog box, select the baseline that you want to
recommend. To select a baseline in another stream, such as a testing stream, click
Change and navigate to the stream in the Choose Stream (Windows) or Change
Baseline (UNIX) dialog box.

You can recommend a baseline that is not in the current stream or its foundation if
the following conditions apply:

❑ The baseline is in the same project as the stream.

❑ The baseline has been delivered to the stream, or the stream has rebased to the
baseline or one of its descendents.

❑ The baseline contains the current recommended baseline, which means it must
be a descendent of the current recommended baseline.

5 When you finalize your list of recommended baselines, click OK in the
Recommended Baselines dialog box.

Resolving Baseline Conflicts

If your project uses composite baselines, you may encounter a situation where you
must resolve a conflict in a stream’s configuration between two different baselines of
the same component. Conflicts can occur during operations that involve baselines,
such as the following:

■ Making a baseline
■ Adding a baseline to a stream’s configuration
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■ Recommending a baseline
■ Rebasing a stream

Conflicts Between a Composite Baseline and a Noncomposite Baseline

The simpler of the two conflict cases is when a composite baseline conflicts with a
noncomposite baseline. For example, assume that a stream’s configuration includes a
composite baseline that selects baseline BL4 of component A, and that the composite
baseline is the recommended baseline. After testing a new baseline, BL5, of component
A, you decide to recommend it. By doing so, you override the member baseline, BL4,
selected by the composite baseline. The Recommended Baselines dialog box identifies
BL5 as an override and BL4 as overridden. UCM uses the same override and
overridden identifiers in other GUIs.

Conflicts Between Two Composite Baselines

The more complex conflict case can occur when a stream’s configuration includes
multiple composite baselines where each composite baseline selects a baseline of the
same component. A stream cannot select two different baselines of the same
component. If you attempt to perform an operation that would cause this situation,
UCM recognizes the conflict and forces you to resolve it before completing the
operation.

Monitoring Project Status

ClearCase provides several tools to help you track the progress of your project. This
section describes how to use those tools.
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Viewing Baseline Histories (Windows Only)

The ClearCase Component Tree Browser is a GUI that displays the baseline history of
a component. To start the Component Tree Browser:

1 Start the Project Explorer, and navigate to the component whose baseline history
you want to see.

2 Right-click the component to display its shortcut menu. Select Browse Baselines.

The Component Tree Browser opens, as shown in Figure 33.

Figure 33 ClearCase Component Tree Browser

The Component Tree Browser shows the lines of development for the component and
each stream that uses the component. In Figure 33, security_INITIAL is the initial
baseline that was created when the project manager created the security component.

OM_proj2.0_09_06_01.1006 is the first baseline that the integrator created after
creating the component. It is the foundation baseline for the integration stream and the
development stream named kmt_OM_proj2.0.

The baseline with the deliverbl prefix is the baseline that ClearCase creates in the
development stream during deliver operations. The integration arrow from the
development stream to the integration stream represents a deliver operation. The
OM_proj2.0_09_06_01.5976 baseline includes the work from the deliver operation.
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To compare two baselines, select a baseline by clicking its icon. Then click Tools >
Compare > with Another Baseline. Click the second baseline’s icon. The Compare
Baselines GUI opens. Alternatively, you can click Tools > Compare > with Previous
Baseline to compare a baseline with its immediate predecessor.

Comparing Baselines

ClearCase allows you to display the differences between two baselines graphically. To
compare two baselines, use the cleardiffbl command. For example:

% cleardiffbl OM_proj2.0_Integration_08_12_01 OM_proj2.0_09_06_01

This command opens the Compare Baselines dialog box, as shown in Figure 34. You
can also open the Compare Baselines dialog box from within the baseline’s property
sheet:

1 In ClearCase Project Explorer, select the integration stream, and click File >
Properties to display the integration stream’s property sheet.

2 Click the Baselines tab and then select the component that contains the baseline
you want to compare.

3 Select the baseline; then right-click it and select Compare with Previous Baseline or
Compare with Another Baseline.
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Figure 34 Comparing Baselines

The Compare Baselines window in Figure 34 shows the results of a comparison of two
composite baselines named OM_proj2.0_Integration_08_12_01 and
OM_proj2.0_09_06_01. The Members tab shows the baselines that contribute to each
composite baseline.

To see the activities included in each baseline, click Activities. In Figure 35, the first
baseline contains no activities because its member baselines are the initial baselines of
the license and security components.

To see the change sets associated with the activities, click Versions.
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Figure 35 Comparing Baselines by Activity

Querying ClearQuest User Databases

If you use the UCM-ClearQuest integration, you can use ClearQuest queries to retrieve
information about the state of your project. When you create or upgrade a ClearQuest
user database to use a UCM-enabled schema, the integration installs six queries in two
subfolders of the Public Queries folder in the user database’s workspace. These queries
make it easy for developers to see which activities are assigned to them and for project
managers to see which activities are active in a particular project. Table 4 lists and
describes the queries.

Table 4 Queries in UCM-Enabled Schema

Query Description

ActiveForProject For one or more specified projects, selects
all activities in an active state type.
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You can also create your own queries by clicking Query > New Query within the
ClearQuest client. In the Choose a record type dialog box that opens, select
All_UCM_Activities if you want the query to search all UCM-enabled record types.

Using ClearCase Reports (Windows Only)

The ClearCase Reports applications (Report Builder and Report Viewer) allow you to
generate and view reports specific to your project environment. Use the Report Builder
to select and define a report’s parameters. Use the Report Viewer to see the report
output.

ActiveForStream For one or more specified streams, selects
all activities in an active state type.

ActiveForUser For one or more specified developers,
selects all assigned activities in an active
state type.

AllActivitiesInStream For one or more specified streams, selects
all activities.

MyCompletedWork Selects all activities in a completed type
state for the developer running the query.

MyToDoList Selects all activities in an active or ready
state type assigned to the developer
running the query.

UCMProjects Selects all projects linked to the
ClearQuest user database.

UCMCustomQuery1 This query is not intended to be used
directly by users; the integration uses it.
When a developer checks out or checks in
a file, or adds a file to source control and
is prompted to select an activity, the
integration calls this query to display the
list of activities available in the stream
associated with the developer’s view.

You can customize this query on a
per-developer basis by copying the query
from the Public Queries folder to the
developer’s Personal Queries folder and
using the Query editor.

Table 4 Queries in UCM-Enabled Schema

Query Description
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Product Note: To start the ClearCase Report Builder:

■ In ClearCase, click Start > Programs > Rational Software > Rational ClearCase >
Administration > Report Builder.

■ In ClearCase LT, click Start > Programs > Rational Software > Rational ClearCase
LT > Report Builder.

The ClearCase Report Builder categorizes its reports based on object types, such as
UCM projects and streams. When you select a category in the left pane, the Report
Builder lists the reports available for that category in the upper right pane. When you
select a report, the Report Builder prompts you for parameters in the lower right pane.
For example, in Figure 36, with the Activities Delivered Since Date report selected,
the Report Builder prompts for the name of an integration stream and a date.

For details on using the Report Builder and the Report Viewer, see their Help.

ClearCase Reports includes a set of hooks into the Report Builder and Report Viewer
applications. These hooks, known as report procedures, implement all the operations
necessary to generate and view a specific report. The ClearCase Reports Programming
Interface allows you to customize report procedures. For details on doing so, see
Appendix C, Customizing ClearCase Reports.

Figure 36 ClearCase Report Builder
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Cleaning Up the Project

When your team finishes work on a project and releases or deploys the new software,
you should clean up the project environment before creating the next version of the
project. Cleaning up involves removing any unused objects, and locking and hiding
the project and its streams. This process reduces clutter and makes it easier to navigate
in the Project Explorer.

Removing Unused Objects

During the life of the project, you or a developer might create an object and then decide
not to use it. Perhaps you decide to use a different naming convention, and you create
a new object instead of renaming the existing one. To avoid confusion and reduce
clutter, remove these unused objects.

To delete a project, stream, component, or activity, select the object in the Project
Explorer, and click File > Delete. To delete a baseline, use the cleartool rmbl command.

Projects

You can delete a project only if it does not contain any streams. When you create a
project with the Project Creation Wizard, the wizard also creates an integration stream.
Therefore, you can delete a project only if you created it with the cleartool mkproject
command, or if you first delete the integration stream. For more information on
removing projects, see the rmproject reference page in the Command Reference.

Streams

You can delete a development stream or an integration stream only if all of the
following conditions are true:

■ The stream contains no activities.
■ No baselines have been created in the stream.
■ No views are attached to the stream.

In addition, you cannot delete an integration stream if the project contains any
development streams. For more information on removing streams, see the rmstream
reference page in the Command Reference.

Components

You can delete a component only if all of the following conditions are true:

■ No baselines of the component other than its initial baseline exist.
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■ The component’s initial baseline does not serve as a foundation baseline for another
stream.

For more information about removing components, see the rmcomp reference page in
the Command Reference.

Baselines

You can delete a baseline only if all of the following conditions are true:

■ The baseline does not serve as a foundation baseline.
■ The baseline is not a component’s initial baseline.
■ A stream has not made changes to the baseline.
■ The baseline is not used as the basis for an incremental baseline.

For more information about removing baselines, see the rmbl reference page in the
Command Reference.

Activities

You can delete an activity only if both of the following conditions are true:

■ The activity has no versions in its change set.
■ No view is currently set to the activity.

For more information about removing activities, see the rmactivity reference page in
the Command Reference.

Locking and Making Obsolete the Project and Streams

To prevent a project or a stream from appearing in the Project Explorer, lock the object
and use the obsolete option. The obsolete option hides the object.

1 In the Project Explorer, select the stream or project that you want to hide, and click
File > Properties to display its property sheet.

2 Click the Lock tab, and select Obsolete. Click OK.

To see objects that you have made obsolete, click View > Show Obsolete Items in the
Project Explorer.
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8Using Triggers to
Enforce Development
Policies
UCM provides a group of development policies that you can easily set in a project by
using the GUI or CLI. In addition, you can use triggers on certain UCM operations to
enforce customized development policies for your project team. This chapter describes
how to create triggers and shows how to use triggers to implement various
development policies in UCM projects. For additional information, see the cleartool
mktrigger and mktrtype reference pages.

Overview of Triggers

A trigger is a monitor that causes one or more procedures or actions to be run whenever
a certain ClearCase operation is performed. Typically, the trigger runs a Perl, batch, or
shell script. You can use triggers to restrict operations to specific users and to specify
the conditions under which they can perform those operations. You can use triggers
with the following UCM operations:

■ chbl
■ chfolder
■ chproject
■ chstream
■ deliver
■ mkactivity
■ mkbl
■ mkcomp
■ mkfolder
■ mkproject
■ mkstream
■ rebase
■ rmbl
■ rmcomp
■ rmfolder
■ rmproject
■ rmstream
■ setactivity
■ setplevel
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Preoperation and Postoperation Triggers

Triggers fall into one of two categories. Preoperation triggers fire, or run their
corresponding procedures, before an operation takes place. Postoperation triggers fire
after an operation occurs. When a user enters a ClearCase command, ClearCase checks
for preoperation triggers on that command. If a trigger is associated with the
command, ClearCase fires the trigger procedure. If the trigger procedure finishes with
a failure status, ClearCase disallows the operation requested by the user. If the trigger
procedure finishes with a success status, ClearCase performs the operation.

Use preoperation triggers to prevent users from performing operations unless certain
conditions apply. Use postoperation triggers to perform actions after an operation
completes. For example, you may want to place a postoperation trigger on the deliver
operation to notify team members whenever a developer delivers work to the project’s
integration stream.

Scope of Triggers

A trigger type defines a trigger for use within a VOB or PVOB. When you create a
trigger type, with the cleartool mktrtype command, you specify the scope to be one of
the following:

■ An element trigger type applies to one or more elements. You attach an instance of
the trigger type to one or more elements by using the cleartool mktrigger
command.

■ An all-element trigger type applies to all elements in a VOB.

■ A type trigger type applies to type objects, such as attributes types, in a VOB.

■ A UCM trigger type applies to a UCM object, such as a stream or a project, in a
PVOB.

■ An all-UCM-object trigger type applies to all UCM objects in a PVOB.

Using Attributes with Triggers

As you design triggers to enforce development policies, you may find it useful to use
attributes. An attribute is a name/value pair. An attribute type defines an attribute. You
can apply an attribute to an object, such as a stream or an activity, or to a version of an
element. In your trigger scripts, you can test the value of an attribute to determine
whether to fire the trigger. For example, you could define an attribute type called
TESTED and attach a TESTED attribute to elements to indicate whether they had been
tested. Acceptable values would be Yes and No.
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When to Use ClearQuest Scripts Instead of UCM Triggers

This chapter presents several use cases for UCM triggers. If your UCM project is
enabled to work with Rational ClearQuest, you can set the following policies, which
are described in UCM-ClearQuest Integration on page 59:

■ Perform ClearQuest Action Before Work On
■ Perform ClearQuest Action Before Delivery
■ Perform ClearQuest Action Before Changing Activity
■ Perform ClearQuest Action After Delivery
■ Perform ClearQuest Action After Changing Activity
■ Transition to Complete After Delivery
■ Transition to Complete After Changing Activity
■ Transfer ClearQuest Mastership Before Delivery
■ Transfer ClearQuest Mastership After Delivery

Some of these policies have ClearQuest global hook scripts associated with them,
which you can edit or replace in ClearQuest Designer to customize the policy for your
environment. You can also write your own ClearQuest hooks to enforce development
policies. In general, if the policy you want to enforce involves a ClearQuest action, use
one of the ClearQuest policies previously mentioned or use ClearQuest hooks. If the
policy you want to enforce involves a ClearCase action, use UCM triggers.

Some operations might have ClearCase triggers and ClearQuest hooks associated with
them. For example, you might define a trigger that sends e-mail to team members
when a developer completes a deliver operation, and you might have the Perform
ClearQuest Activity After Delivery policy enabled. ClearCase and ClearQuest run
triggers, hooks, and UCM operations in the following order:

1 ClearCase preoperation trigger

2 ClearQuest preoperation hook

3 UCM action

4 ClearQuest postoperation hook

5 ClearQuest transition activity hook

6 ClearCase postoperation trigger

Sharing Triggers Between UNIX and Windows

You can define triggers that fire correctly on both UNIX and Windows computers. The
following sections describe two techniques. With one, you use different pathnames or
different scripts; with the other, you use the same script for both platforms.
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Using Different Pathnames or Different Scripts

To define a trigger that fires on UNIX, Windows, or both, and that uses different
pathnames to point to the trigger scripts, use the –execunix and –execwin options with
the mktrtype command. These options behave the same as –exec when fired on the
appropriate platform (UNIX or Windows, respectively). On the other platform, they do
nothing. This technique allows a single trigger type to use different paths for the same
script or to use completely different scripts on UNIX and Windows computers. For
example:

cleartool mktrtype –element –all –nc –preop checkin
–execunix /public/scripts/precheckin.sh –execwin 
\\neon\scripts\precheckin.bat  
pre_ci_trig 

Note: The command line example is broken across lines to make it easier to read. You
must enter it all on one line.

On UNIX, only the script precheckin.sh runs. On Windows, only precheckin.bat runs.

To prevent users on a new platform from bypassing the trigger process, triggers that
specify only –execunix always fail on Windows. Likewise, triggers that specify only
–execwin fail on UNIX.

Using the Same Script

To use the same trigger script on Windows and UNIX platforms, you must use a batch
command interpreter that runs on both operating systems. For this purpose, Rational
ClearCase includes the ccperl program, a version of Perl that you can use on Windows
and UNIX.

The following mktrtype command creates sample trigger type pre_ci_trig and names
precheckin.pl as the executable trigger script.

cleartool mktrtype –element –all –nc –preop checkin \ 
–execunix 'Perl /public/scripts/precheckin.pl' \ 
–execwin 'ccperl \\neon\scripts\precheckin.pl' \ 
pre_ci_trig 

Tips
■ To tailor script execution for each operating system, use environment variables in

Perl scripts.

■ To collect or display information interactively, you can use the clearprompt
command.
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Enforce Serial Deliver Operations

Because UCM allows multiple developers to deliver work to the same integration
stream concurrently, conflicts can occur if two or more developers attempt to deliver
changes to the same element. If one developer’s deliver operation has an element
checked out, the second developer cannot deliver changes to that element until the first
deliver operation is completed or canceled. The second deliver operation attempts to
check out all elements other than the checked-out one, but it does not proceed to the
merge phase of the operation. The second developer must either wait for the first
deliver operation to finish or undo the second deliver operation.

You may want to implement a development policy that eliminates the confusion that
concurrent deliveries can cause developers. This section shows three Perl scripts that
prevent multiple developers from delivering work to the same integration stream
concurrently:

■ Script 1 creates the trigger types and an attribute type.
■ Script 2 is the preoperation trigger action that fires at the start of a deliver operation.
■ Script 3 is the postoperation trigger action that fires at the end of a deliver operation.

Setup Script

This setup script creates a preoperation trigger type, a postoperation trigger type, and
an attribute type. The preoperation trigger action fires when a deliver operation starts,
as represented by the deliver_start operation kind (opkind). The postoperation trigger
action fires when a deliver operation is canceled or completed, as represented by the
deliver_cancel and deliver_complete opkinds, respectively.

The script runs on both UNIX and Windows platforms. Because the command-line
syntax to run the preoperation and postoperation scripts on Windows differs slightly
depending on whether the PVOB resides on Windows or UNIX, the setup script uses
an IF ELSE Boolean expression to set the appropriate PVOB tag.

The mktrtype command uses the –ucmobject and –all options to specify that the
trigger type applies to all UCM objects in the PVOB, but the –stream option restricts
the scope to one integration stream.

The mkattype command creates an attribute type called deliver_in_progress, which
the preoperation and postoperation scripts use to indicate whether a developer is
delivering work to the integration stream._

use Config;

my $PVOBTAG;
my $PREOPCMDW;
my $POSTOPCMDW;
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$PREOPCMDW = '-execwin "ccperl 
\\\\pluto\\c$\\ucmscripts\\ex1_preop.pl"';

$POSTOPCMDW = '-execwin "ccperl 
\\\\pluto\\c$\\ucmscripts\\ex1_postop.pl"';

if ($Config{'osname'} eq 'MSWin32') {
$PVOBTAG = '\cyclone-pvob';

}
else {

$PVOBTAG = '/pvobs/cyclone-pvob';
}

my $PREOPCMDU = '';
my $POSTOPCMDU = '';
my $STREAM = "cc5testproj_Integration\@$PVOBTAG";
my $PREOPTRTYPE = "trtype:ex1_preop\@$PVOBTAG";
my $POSTOPTRTYPE = "trtype:ex1_postop\@$PVOBTAG";
my $CANXTRTYPE = "trtype:ex1_cancel\@$PVOBTAG";
my $ATTYPE = "attype:deliver_in_progress\@$PVOBTAG";

print $PVOBTAG . "\n";
print $STREAM . "\n";
print $PREOPTRTYPE . "\n";
print $POSTOPTRTYPE . "\n";
print $CANXTRTYPE . "\n";
print $ATTYPE . "\n";

print `cleartool mktrtype -replace -ucmobject -all -preop 
deliver_start $PREOPCMDU $PREOPCMDW -stream $STREAM -nc $PREOPTRTYPE`;
print `cleartool mktrtype -replace -ucmobject -all -postop 
deliver_complete $POSTOPCMDU $POSTOPCMDW -stream $STREAM -nc 
$POSTOPTRTYPE`;
print `cleartool mktrtype -replace -ucmobject -all -postop 
deliver_cancel $POSTOPCMDU $POSTOPCMDW -stream $STREAM -nc 
$CANXTRTYPE`;
print `cleartool mkattype -replace -vtype integer -default 1 -nc 
$ATTYPE`;

Preoperation Trigger Script

This preoperation trigger action fires when a developer begins to deliver work to the
specified integration stream. The script attempts to attach an attribute of type
deliver_in_progress to the integration stream. If another developer is in the process of
delivering work to the same stream, the mkattr command fails and the script displays
a message suggesting that the developer try again later. Otherwise, the mkattr
command succeeds and prevents other developers from delivering to the integration
stream until the current deliver operation finishes.

use Config;

my $PVOBTAG;
my $tempfile;
my $exit_value;
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if ($Config{'osname'} eq 'MSWin32') {
$PVOBTAG = '\cyclone-pvob';
$tempfile = 

$ENV{TMP}."\\expreop.".$ENV{"CLEARCASE_PPID"}.".txt";
}
else {

$PVOBTAG = '';
}

my $STREAM = "stream:".$ENV{"CLEARCASE_STREAM"};
my $ATTYPE = "attype:deliver_in_progress\@$PVOBTAG";

print $STREAM."\n";
print $ATTYPE."\n";

my $cmdline;
my $cmdoutput;

# Test to see if the deliver in progress attribute is 
# applied to the target stream. 

$msg = ‘cleartool describe -fmt "%a" $STREAM‘;

print $msg."\n";

if ($ENV{"CLEARCASE_CMDLINE"} eq "") {
open(TEMPFH, "> $tempfile");
print TEMPFH $msg."\n";
close(TEMPFH);
$cmdline = "clearprompt text -outfile $tempfile -multi_line 

-dfile \"$tempfile\" -prompt \"Describe Results\"";
$cmdoutput = ‘$cmdline‘;

}

if (index($msg, "deliver_in_progress") >=0) {
print "***\n";
print "*** A deliver operation is already in progress. Please 

try again later.\n";
print "***\n";
exit 1;

}

$cmdline = "cleartool mkattr -default $ATTYPE $STREAM";

print $cmdline."\n";

$msg = ‘$cmdline‘;

$exit_value = $? >> 8;

if (!($exit_value eq 0)) {
print "***\n";
print "*** A deliver operation was started just before 

yours.\n";
print "*** That deliver operation is already in progress. Please 

try again later.\n";
print "***\n";
exit 1;

}
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exit 0;

Postoperation Trigger Script

This postoperation trigger action fires when a developer cancels or completes a deliver
operation to the specified integration stream. This script removes the
deliver_in_progress attribute that the preoperation script attaches to the integration
stream at the start of the deliver operation. After the attribute is removed, another
developer can deliver work to the integration stream.

# perl script that fires on deliver_complete or deliver_cancel postop 
trigger.
use Config;

# define platform-dependent arguments.
my $PVOBTAG;
if ($Config{'osname'} eq 'MSWin32') {

$PVOBTAG = '\cyclone-pvob';
}
else{

$PVOBTAG = '';
}
my $STREAM = "stream:".$ENV{"CLEARCASE_STREAM"};
my $ATTYPE = "attype:deliver_in_progress\@$PVOBTAG";

# remove the attribute to allow deliveries.
print `cleartool rmattr -nc $ATTYPE $STREAM`;

Send Mail to Developers on Deliver Operations

To improve communication among developers on your project team, you may want to
create a trigger type that sends an e-mail message to team members whenever a
developer completes a deliver operation. This section includes two scripts:

■ Script 1 creates a trigger type that fires at the end of a successful deliver operation.
■ Script 2 is the postoperation trigger action that sends e-mail messages to

developers.

Setup Script

This script creates a postoperation trigger type that fires when a developer finishes a
deliver operation, as represented by the deliver_complete opkind. The mktrtype
command uses the –stream option to indicate that the trigger type applies only to
deliver operations that target the specified integration stream.

# This is a Perl script to set up the triggertype
# for e-mail notification on deliver.
use Config;
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# define platform-dependent arguments.
my $PVOBTAG;
if ($Config{'osname'} eq 'MSWin32') {

$PVOBTAG  = '\cyclone_pvob';
$WCMD     = '-execwin "ccperl 

\\\\pluto\disk1\ucmtrig_examples\ex2\ex2_postop.pl"';
}
else {

$PVOBTAG  = '/pvobs/cyclone_pvob';
$WCMD     = '-execwin "ccperl 

\\\\\\pluto\disk1\ucmtrig_examples\ex2\ex2_postop.pl"';
}
my $STREAM = "stream:P1_int\@$PVOBTAG";
my $TRTYPE = "trtype:ex2_postop\@$PVOBTAG";
my $UCMD   = '-execunix "Perl 
/net/pluto/disk1/ucmtrig_examples/ex2/ex2_postop.pl"';

print 'cleartool mktrtype -ucmobject -all -postop deliver_complete 
$WCMD $UCMD -stream $STREAM -nc $TRTYPE`;

Postoperation Trigger Script

This postoperation trigger action fires when a developer finishes delivering work to
the integration stream. The script composes and sends an e-mail message to other
developers on the project team telling them that a deliver operation has just finished.
The script uses ClearCase environment variables to provide the following details about
the deliver operation in the body of the message:

■ Project name
■ Development stream that delivered work
■ Integration stream that received delivered work
■ Integration activity created by the deliver operation
■ Activities delivered
■ Integration view used by deliver operation

# Perl script to send mail on deliver complete.

##################################################################
# Simple package to override the "open" method of Mail::Send so we
# can control the mailing mechanism.

package SendMail;

use Config;
use Mail::Send;

@ISA = qw(Mail::Send);

sub open {
my $me = shift;
my $how;  # How to send mail
my $notused;
my $mailhost;
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# On Windows use SMTP

if ($Config{'osname'} eq 'MSWin32') {
$how = 'smtp';
$mailhost = "localmail0.company.com";
}

# else use defaults supplied by Mail::Mailer

Mail::Mailer->new($how, $notused, $mailhost)->open($me);
}

#
##################################################################
# Main program

my @to = "developers\@company.com";
my $subject = "Delivery complete";

my $body = join '', ("\n",
"UCM Project: ", $ENV{CLEARCASE_PROJECT}, "\n",
"UCM source stream: ", $ENV{CLEARCASE_SRC_STREAM}, "\n",
"UCM destination stream: ", $ENV{CLEARCASE_STREAM}, "\n",
"UCM integration activity: ", $ENV{CLEARCASE_ACTIVITY}, 

"\n",
"UCM activities delivered: ", $ENV{CLEARCASE_DLVR_ACTS}, 

"\n",
"UCM view: ", $ENV{CLEARCASE_VIEW_TAG}, "\n"

);

my $msg = new SendMail(Subject=>$subject);

$msg->to(@to);
my $fh  = $msg->open($me);
$fh->print($body);
$fh->close();
1; # return success

#
##################################################################

Do Not Allow Activities to Be Created on the Integration
Stream

Anyone who has an integration view attached to the integration stream can create
activities on that stream, but the UCM process calls for developers to create activities
in their development streams. You may want to implement a policy that prevents
developers from creating activities on the integration stream inadvertently. This
section shows a Perl script that enforces that policy.

The following mktrtype command creates a preoperation trigger type called
block_integration_mkact. The trigger type fires when a developer attempts to make
an activity.
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cleartool mktrtype -ucmobject -all -preop mkactivity -execwin "ccperl ^
\\pluto\disk1\triggers\block_integ_mkact.pl" -execunix "Perl ^
/net/jupiter/triggers/block_integ_mkact.pl" block_integration_mkact@\my_pvob 

The following preoperation trigger script runs when the block_integration_mkact
trigger fires. The script uses the cleartool lsproject command and the
CLEARCASE_PROJECT environment variable to determine the name of the project’s
integration stream. ClearCase creates an integration activity to keep track of changes
that occur during a deliver operation. The script uses the CLEARCASE_POP_KIND

environment variable to determine whether the activity being created is an integration
activity. If the mkactivity operation is the result of a deliver operation, the value of
CLEARCASE_POP_KIND, which identifies the parent operation, is deliver_start.

If the value of CLEARCASE_POP_KIND is not deliver_start, the activity is not an
integration activity, and the script disallows the mkactivity operation.

# Get the integration stream name for this project
my $istream = ‘cleartool lsproject -fmt "%[istream]p" 
$ENV{"CLEARCASE_PROJECT"}‘;

# Get the current stream and strip off VOB tag
$_ = $ENV{"CLEARCASE_STREAM"};
s/\@.*//;
my $curstream = $_;

# If it’s the same as our stream, then it is the integration stream
if ($istream eq $curstream) {

# Only allow this mkact if it is a result of a deliver
# Determine this by checking the parent op kind
if ($ENV{"CLEARCASE_POP_KIND"} ne "deliver_start") {

print "Activity creation is only permitted in integration 
streams for

delivery.\n";
exit 1

}
}

exit 0 

Implementing a Role-Based Access Control System

In a ClearCase environment, where users perform different roles, you may want to
restrict access to certain ClearCase operations based on role. This section shows a
trigger definition and script that implement a role-based access control system.

The following mktrtype command creates a preoperation trigger type called
role_restrictions. The trigger type fires when a user attempts to make a baseline,
stream, or activity.
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cleartool mktrtype -nc -ucmobject -all -preop mkstream,mkbl,mkactivity \
-execunix "perl /net/jupiter/triggers/role_restrictions.pl" \
-execwin "ccperl \\pluto\disk1\triggers\role_restrictions.pl" \
role_restrictions@\my_pvob

Preoperation Trigger Script

The following preoperation trigger script maps users to the following roles:

■ Project manager
■ Integrator
■ Developer

The script maps the mkactivity, mkbl, and mkstream operations to the roles that are
permitted to perform them. For example, only users designated as project managers or
integrators can make a baseline.

The script uses the CLEARCASE_USER environment variable to retrieve the user’s
name, the CLEARCASE_OP_KIND environment variable to identify the operation the
user attempts to perform, and the CLEARCASE_POP_KIND environment variable to
identify the parent operation. If the parent operation is deliver or rebase, the script
does not check permissions.

use strict;

sub has_permission
{

my ($user,$op,$pop,$proj) = @_;

#When performing a composite operation like 'deliver' or 
'rebase',

#we don’t need to check permissions on the individual 
sub-operations

#that make up the composite.

return 1 if($pop eq 'deliver_start' || $pop eq 'rebase_start' ||
 ($pop eq 'deliver_complete' || $pop eq 

'rebase_complete' ||
 ($pop eq 'deliver_cancel' || $pop eq 

'rebase_cancel');

# Which roles can perform what operations?
# Note that these maps could be stored in a ClearCase attribute
# on each project instead of hard-coded here in the trigger 

script
# to give true per-project control.

my %map_op_to_roles = (
mkactivity => [ "projectmgr", "integrator", "developer" ],
mkbl       => [ "projectmgr", "integrator" ],
mkstream   => [ "projectmgr", "integrator", "developer" ],

);
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# Which users belong to what roles?

my %map_role_to_users = (
projectmgr => [ "kate" ],
integrator => [ "kate", "mike" ],
developer  => [ "kate", "mike", "jones" ],

);

# Does user belong to any of the roles that can perform this 
operation?

my ($role,$tmp_user);

for $role (@{ $map_op_to_roles{$op} }) {
for $tmp_user (@{ $map_role_to_users{$role} }) {

if ($tmp_user eq $user) {
return 1;

}
}

}

return 0;
}

sub Main
{

my $user = $ENV{CLEARCASE_USER};
my $proj = $ENV{CLEARCASE_PROJECT};
my $op   = $ENV{CLEARCASE_OP_KIND};
my $pop  = $ENV{CLEARCASE_POP_KIND};

my $perm = has_permission($user, $op, $proj);

printf("$user %s permission to perform '$op' in project 
$proj\n",

$perm ? "has" : "does NOT have");

exit($perm ? 0 : 1);
}

Main();

Additional Uses for UCM Triggers

The examples shown in the previous sections represent just a few ways that you may
use UCM triggers to enforce development policies. Other uses for UCM triggers
include the following:

■ Creating an integration between UCM and a change request management (CRM)
system. Although we expect that most customers will use the out-of-the-box
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integration with ClearQuest, you may want to integrate with another CRM
system. To accomplish this, you could do the following:

❑ Create a trigger type on mkactivity that creates a corresponding record in the
CRM database when a developer makes a new activity.

❑ Create a trigger type on setactivity that transitions the record in the CRM
database to a scheduled state when a developer starts working on an activity.

❑ Create a trigger type on deliver that transitions the record in the CRM database
to a completed state when a developer finishes delivering the activity to the
integration stream.

■ Creating a trigger type on rebase that prevents developers from rebasing certain
development streams. You may want to enforce this policy on a development
stream that is being used to fix one particular bug.

■ Creating a trigger type on setactivity that allows specific developers to work on
specific activities.
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9Managing Parallel
Releases of Multiple
Projects
The previous chapters describe how to manage a single project. However, you may
need to manage multiple releases of a project simultaneously. To do so, you need to
merge changes from one project to another. This chapter describes how to accomplish
that merging in two common scenarios:

■ Managing a current project and a follow-on project simultaneously
■ Incorporating a patch release into a new release of the project

This chapter also describes how to use base ClearCase tools to merge work from a
UCM project to a base ClearCase project.

Managing a Current Project and a Follow-On Project
Simultaneously

Given the tight software development schedules that most organizations operate
within, it is common practice to begin development of the next release of a project
before work on the current release is completed. The next release may add new
features, or it may involve porting the current release to a different platform.

Example

Figure 37 illustrates the flow of a current project, Webotrans 4.0, and a follow-on
project, Webotrans 4.1.
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Figure 37 Managing a Follow-On Release

In this example:

■ The project manager for the follow-on project created the Webotrans 4.1 project
based on the Beta baselines of the components used in the Webotrans 4.0 project.
Developers on both project teams then continued to make changes, and the 4.0 and
4.1 integrators continued to create new baselines that incorporate those changes.
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■ When the 4.0 team completed its work, the integrator created the final baselines,
named FCS. The 4.1 project manager then rebased the 4.1 integration stream to the
FCS baselines.

Performing Interproject Rebase Operations

To rebase an integration stream to a set of baselines in another project’s integration
stream, perform the following steps:

1 In ClearCase Project Explorer, select the integration stream that you want to
rebase.

2 Click Tools > Rebase Stream.

3 In the Rebase Stream Preview dialog box, click Advanced.

4 In the Change Rebase Configuration dialog box, select a component that contains
the baseline you want to use to rebase your stream. Click Change.

5 In the Change Baseline dialog box:

On Windows, click Change.

On UNIX, click the arrow at the end of the From Stream field.

6 On Windows, in the Choose Stream dialog box, navigate to the integration stream
of the other project. Select the integration stream and click OK

On UNIX, select the integration stream of the other project.

This updates the Change Baseline dialog box with the set of baselines available in
the other project’s integration stream.

7 In the Change Baseline dialog box, select the component. The Baselines list
displays all baselines available for the selected component in the other project’s
integration stream. Select the baseline to which you want to rebase your
integration stream. Click OK. The baseline that you selected now appears in the
Change Rebase Configuration dialog box.

8 Repeat steps Step 4 through Step 7 until you finish selecting the set of baselines to
which you want to rebase your integration stream.

9 Click OK to close the Change Rebase Configuration dialog box. Click OK in the
Rebase Stream Preview dialog box.

10 ClearCase merges all nonconflicting changes automatically. If ClearCase
encounters conflicting changes, it prompts you to start Diff Merge, a tool with
which you resolve conflicting changes. For details on using Diff Merge, see the Diff
Merge Help and Developing Software.
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Note that you can rebase your project’s integration stream only if the baseline to which
you are rebasing is a successor of your integration stream’s current foundation baseline.
In the previous example, the FCS baseline is a successor to the Beta baseline, which is
the current foundation baseline for the Webotrans 4.1 integration stream.

Incorporating a Patch Release into a New Version of the
Project

Another common parallel development scenario involves working on a patch release
and a new release of a project at the same time. This section describes this scenario.

Example

Figure 38 illustrates the flow of a patch release and a new release. In this example:

■ Both the Webotrans 3.0 Patch and Webotrans 4.0 projects use the FCS baselines of
the components in the Webotrans 3.0 project as their foundation baselines. The
purpose of the patch release is to fix a problem detected after Webotrans 3.0 was
released. Webotrans 4.0 represents the next major release of the Webotrans
product.

■ Development continues in both the 3.0 Patch and 4.0 projects, with the integrators
creating baselines periodically.

■ The developers working on the 3.0 Patch project finish their work, and the
integrator incorporates the final changes in the BL2 baseline. The integrator then
needs to deliver those changes from the 3.0 Patch integration stream to the 4.0
integration stream so that the 4.0 project contains the fix.
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Figure 38 Incorporating a Patch Release

Delivering Work to Another Project

To deliver work from an integration stream in one project to an integration stream in
another project, perform the following steps:
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1 In the source stream, make one or more baselines that incorporate the changes you
want to deliver. When you deliver work from an integration stream, you must
deliver baselines.

2 Check the deliver policy settings for the target integration stream to confirm that it
allows deliveries from other projects. In the Project Explorer, select the target
integration stream, and click File > Policies. If the Allow interproject deliver to
project or stream policy is not enabled, ask the project manager to change the
setting to enabled.

3 In the Project Explorer, select the source integration stream, and click Tools >
Deliver Baselines To Default or Deliver To Alternate Target. To determine the default
deliver target for the integration stream, select the stream and click File >
Properties. The Deliver to box on the General tab identifies the default deliver
target. You can change the default deliver target by clicking Change. The Deliver To
Alternate Target option opens the Deliver from Stream (alternate target) dialog box,
which lets you select the target stream.

4 In the Deliver from Stream Preview dialog box, use Add, Change, and Remove to
select the baselines that you want to deliver. Make sure that the View box identifies
a view that is attached to the target integration stream. If necessary, click Change to
select a different view. Click OK to start the merge part of the deliver operation.

5 Rational ClearCase merges all nonconflicting changes automatically. If it
encounters conflicting changes, it prompts you to start Diff Merge, a tool with
which you resolve conflicting changes. For details on using Diff Merge, see the Diff
Merge Help and Developing Software.

6 When you finish merging files, click Complete to check in the changes.

Using a Mainline Project

If you anticipate that your team will develop and release numerous versions of your
system, you may want to create a mainline project. A mainline project serves as a single
point of integration for related projects over a period of time. It is not specific to any
single release.

For example, assume the Webotrans team plans to develop and release new versions
of their product every six months. For each new version, the project manager could
create a project whose foundation baselines are the final recommended baselines in the
prior project’s integration stream. For example, the foundation baselines of Webotrans
2.0 are the final recommended baselines in Webotrans 1.0’s integration stream; the
foundation baselines for Webotrans 3.0 are the final recommended baselines in
Webotrans 2.0’s integration stream, and so on. This approach is referred to as a
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cascading projects design. The disadvantage to this approach is that you must look at
all integration streams to see the entire history of the Webotrans projects.

In the mainline project approach, the Webotrans project manager creates a mainline
project with an initial set of baselines, and then creates Webotrans 1.0 based on those
initial baselines. When developers finish working on Webotrans 1.0, the project
manager delivers the final recommended baselines to the mainline project’s
integration stream. These baselines in the mainline project’s integration stream serve
as the foundation baselines for the Webotrans 2.0 project. When the Webotrans 2.0 team
finishes its work, the project manager delivers the final recommended baselines to the
mainline project’s integration stream, and so on. The advantage to this approach is that
each project’s final recommended baselines are available in the mainline project’s
integration stream.

Merging from a Project to a Non-UCM Branch

You may be in a situation in which part of the development team works in a project,
and the rest of the team works in base ClearCase. If you are a longtime ClearCase user,
you may decide to use UCM initially on a small part of your system. This approach
would allow you to migrate from base ClearCase to UCM gradually, rather than all at
once.

In this case, you need to merge work periodically from the project’s integration stream
to the branch that serves as the integration branch for the system. To do so, use a script
similar to the one shown here, which uses base ClearCase functionality to merge
changes.

# Sample Perl script for delivering contents of one UCM project to 
# a nonUCM project. Run this script while set to a view that sees the
# destination branch.
#
# Usage: Perl <this-script> <project-name> <project-vob>

use strict;

my $mergeopts = '–print';
my $project = shift @ARGV;
my $pvob = shift @ARGV;
my $bl;

chdir ($pvob) or die("can’t cd to project VOB '$pvob'");

print("######## Getting recommended baselines for project 
'$project'\n");

my @recbls = split(' ', ‘cleartool lsproject –fmt "%[rec_bls]p" 
$project‘);

foreach $bl (@recbls) {
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my $comp = ‘cleartool lsbl –fmt "%[component]p" $bl‘;
my $vob = ‘cleartool lscomp –fmt "%[root_dir]p" $comp‘;

print("######## Merging changes from baseline '$bl' of $vob\n");

my $st = system("cleartool findmerge $vob –fver $bl 
$mergeopts");

$st == 0 or die("findmerge error");
}

exit 0;

The script finds the recommended baselines for the integration stream from which you
are merging. It then uses the cleartool findmerge command to find differences
between the versions represented by those recommended baselines and the latest
versions in the target branch. For details, see the findmerge reference page.

We recommend that you add error handling and other logic appropriate for your site
to this script before using it.
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10Managing Projects in
Base ClearCase
As a project manager, you are responsible for planning, staffing, and managing the
technical aspects of a software development project. You decide what will be worked
on, assign work to the project’s team members, establish the work schedule, and
perhaps the policies and procedures for doing the work.

When development is underway, you monitor progress and generate project status
reports. You may also approve the specific work items included in a build and
subsequently a baseline.

You may also be the project integrator, responsible for incorporating work that each
developer completes into a deliverable and buildable system. You create the project’s
baselines and establish the quality level of those baselines.

Base ClearCase offers many features to make this work easier. Before development
begins, you need to complete several planning and setup tasks:

■ Setting up the project environment
■ Implementing development policies
■ Defining and implementing an integration policy

This chapter introduces these topics. The remaining chapters cover the implementation
details. Chapter 16, Using ClearCase Throughout the Development Cycle, follows a project
throughout the development cycle to show how you can use Rational ClearCase.

Before reading this part of the manual, read Developing Software to become familiar
with the concepts of VOBs, views, and config specs.

Setting Up the Project

This section describes the planning and setup work you need to do before
development begins.

Creating and Populating VOBs

If your project is migrating to ClearCase from another version control product or is
adopting a configuration and change management plan for the first time, you must
populate the VOBs for your project with an initial collection of data (file and directory
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elements). If your site has a dedicated ClearCase administrator, he or she may be
responsible for creating and maintaining VOBs, but not for importing data into them.

The Administrator’s Guide includes detailed information on these topics.

Planning a Branching Strategy

ClearCase uses branches to enable parallel development. A branch is an object that
specifies a linear sequence of versions of an element. Every element has one main
branch, which represents the principal line of development, and may have multiple
subbranches, each of which represents a separate line of development. For example, a
project team can use two branches concurrently: the main branch for new development
work and a subbranch to fix a bug. The aggregated main branches of all elements
constitutes the main branch of a code base.

Subbranches can have subbranches. For example, a project team designates a
subbranch for porting a product to a different platform; the team then decides to create
a bug-fixing subbranch off that porting subbranch. ClearCase allows you to create
complex branch hierarchies. Figure 1 on page 2 illustrates a multilevel branching
hierarchy. As a project manager in such an environment, you need to ensure that
developers are working on the correct branches. To do that, you must tell them which
rules to include in their config specs so that their views access the appropriate set of
versions.

Chapter 11, Defining Project Views, describes config specs and branches in detail. Before
you read it, a little background on branching strategies may be helpful.

Branching policy is influenced by the development objectives of the project and
provides a mechanism to control the evolution of the code base. There are as many
variations of branching policy as organizations that use ClearCase. But there are also
similarities that reflect common adherence to best practices. Some of the more common
branch types and uses are presented here.

Task branches are short-lived, typically involve a small percentage of files, and are
merged into their parent branch after the task is completed. Task branches promote
accountability by leaving a permanent audit trail that associates a set of changes with
a particular task; they also make it easy to identify the task artifacts, such as views and
derived objects, that can be removed when they are no longer needed. If individual
tasks do not require changes to the same files, it is easy to merge a task branch to its
parent.

Private development branches are useful when a group of developers need to make a
more comprehensive set of changes on a common code base. By branching as much of
the main branch as needed, developers can work in isolation as long as necessary.
Merging back to the main branch can be simplified if, before merging, each developer
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merges the main branch to the private branch to resolve any differences there before
checking in the changed files.

Integration branches provide a buffer between private development branches and the
main branch and can be useful if you delegate the integration task to one person, rather
than making developers responsible for integrating their own work.

Branch Names

It is a good idea to establish naming conventions that indicate the work the branch
contains. For example, rel2.1_main is the branch on which all code for Release 2.1
ultimately resides, rel2.1_feature_abc contains changes specific to the ABC feature,
and rel2.1_bl2 is the second stable baseline of Release 2.1 code. (If necessary, branch
names can be much longer and more descriptive, but long branch names can crowd a
version tree display.)

Note: Make sure that you do not create a branch type with the same name as a label
type. This can cause problems when config specs use labels in version selectors. For
example, make all branch names lowercase, and make all label names uppercase.

Branches and ClearCase MultiSite

Product Note: Rational ClearCase LT does not support ClearCase MultiSite.

Branches are particularly important when your team works in VOBs that have been
replicated to other sites with the ClearCase MultiSite product. Developers at different
sites work on different branches of an element. This scheme prevents collisions—for
example, developers at two sites creating version /main/17 of the same element. In some
cases, versions of files cannot or should not be merged, and developers at different sites
must share branches. For more information, see Certain Branches Are Shared Among
MultiSite Sites on page 187.

Creating Shared Views and Standard Config Specs

As a project manager, you want to control the config specs that determine how
branches are created when developers check out files. There are several ways to handle
this task:

■ Create a config spec template that each developer must use. Developers can either
paste the template into their individual config specs or use the ClearCase include
file facility to get the config spec from a common source.

■ Create a view that developers will share. This is usually a good way to provide an
integration view for developers to use when they check in work that has evolved
in isolation on a private branch.
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Note: Working in a single shared view is not recommended because doing so can
degrade system performance.

■ On Windows you can use the ClearCase View Profiles mechanism to configure
views that the project team will use. The View Profile tools promote a specific
model for the effective use of ClearCase. Project teams that adhere to this model
can take advantage of several areas of automated support, significantly
simplifying their ability to exploit some of the more advanced features of
ClearCase. For more information on View Profiles, see the Help.

Product Note: Rational ClearCase LT does not support view profiles.

■ To ensure that all team members configure their views the same way, you can
create files that contain standard config specs. For example:

❑ /public/config_specs/ABC contains the ABC team’s config spec

❑ /public/config_specs/XYZ contains the XYZ team’s config spec

Store these config spec files in a standard directory outside a VOB, to ensure that all
developers get the same version.

Recommendations for View Names

You may want to establish naming conventions for views for the same reason that you
do for branches: it is easier to associate a view with the task it is used for. The ClearCase
view-creation tools suggest appropriate view names, but you may want to use
something different. For example, you can require all view names (called view-tags) to
include the owner’s name and the task (bill_V4.0_bugfix) or the name of the computer
hosting the view (platinum_V4.0_int).

Implementing Development Policies

To enforce development policies, you can create ClearCase metadata to preserve
information about the status of versions. To monitor the progress of the project, you can
generate a variety of reports from this data and from the information captured in event
records.

Using Labels

A label is a user-defined name that can be attached to a version. Labels are a powerful
tool for project managers and system integrators. By applying labels to groups of
elements, you can define and preserve the relationship of a set of file and directory
versions to each other at a given point in the development lifecycle. For example, you
can apply labels to these versions:
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■ All versions considered stable after integration and testing. Use this baseline label
as the foundation for new work.

■ All versions that are partially stable or contain some usable subset of functionality.
Use this checkpoint label for intermediate testing or as a point to which
development can be rolled back in the event that subsequent changes result in
regressions or instability.

■ All versions that contain changes to implement a particular feature or that are part
of a patch release.

Using Attributes, Hyperlinks, Triggers, and Locks

Attributes are name/value pairs that allow you to capture information about the state
of a version from various perspectives. For example, you can attach an attribute named
CommentDensity to each version of a source file, to indicate how well the code is
commented. Each such attribute can have the value unacceptable, low, medium, or
high.

Hyperlinks allow you identify and preserve relationships between elements in one or
more VOBs. This capability can be used to address process-control needs, such as
requirements tracing, by allowing you to link a source file to a requirements document.

Triggers allow you to control the behavior of cleartool commands and ClearCase
operations by arranging for a specific program or executable script to run before or
after the command executes. Virtually any operation that modifies an element can fire
a trigger. Special environment variables make the relevant information available to the
script or program that implements the procedure.

Preoperation triggers fire before the designated ClearCase command is executed. A
preoperation trigger on checkin can prompt the developer to add an appropriate
comment. Postoperation triggers fire after a command has exited and can take
advantage of the command’s exit status. For example, a postoperation trigger on the
checkin command can send an e-mail message to the QA department, indicating that
a particular developer modified a particular element.

Triggers can also automate a variety of process management functions. For example:

■ Applying attributes or attaching labels to objects when they are modified

■ Logging information that is not included in the ClearCase event records

■ Initiating a build and/or source code analysis whenever particular objects are
modified

For more information on these mechanisms, see Chapter 12, Implementing Project
Development Policies.
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A lock on an element or directory prevents all developers (except those included on an
exception list) from modifying it. Locks are useful for implementing temporary
restrictions. For example, during an integration period, a lock on a single object—the
main branch type—prevents all users who are not on the integration team from
making any changes.

The effect of a lock can be small or large. A lock can prevent any new development on
a particular branch of a particular element; another lock can apply to the entire VOB,
preventing developers from creating any new element of type compressed_file or
using the version label RLS_1.3.

Locks can also be used to retire names, views, and VOBs that are no longer used. For
this purpose, the locked objects can be tagged as obsolete, effectively making them
invisible to most commands.

Global Types

The ClearCase global type facility makes it easy for you to ensure that the branch, label,
attribute, hyperlink, and element types they need are present in all VOBs your project
uses. The Administrator’s Guide has more information about creating and using global
types.

Generating Reports

ClearCase creates and stores an event record each time an element is modified or
merged. Many ClearCase commands include selection and filtering options that you
can use to create reports based on these records. The scope of such reports can cover a
single element for a set of objects or for entire VOBs.

Chapter 12, Implementing Project Development Policies, provides more detail on using
event records and metadata to implement project policies. Event records and other
metadata can also be useful if you need to generate reports on activities managed by
ClearCase (for example, the complete history of changes to an element). ClearCase
provides a variety of report-generation tools. For more information on this topic, see
the fmt_ccase reference page in the Command Reference.

Integrating Changes

During the lifetime of a project, the contents of individual elements diverge as they are
branched and usually converge in a merge operation. Typically, the project manager
periodically merges most branches back to the main branch to ensure that the code
base maintains a high degree of integrity and to have a single latest version of each
element from which new versions can safely branch. Without regular merges, the code
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base quickly develops a number of dangling branches, each with slightly different
contents. In such situations, a change made to one version must be propagated by hand
to other versions, a tedious process that is prone to error.

As a project manager, you must establish merge policies for your project. Typical
policies include the following:

■ Developers merge their changes to the main branch. This can work well when the
number of developers and/or the number of changed files is small and the
developers are familiar with the mechanics of merging. Developers must also
understand the nature of other changes they may encounter when the merge target
is not the immediate predecessor of the version being merged, which happens
when several developers are working on the same file in parallel.

■ Developers merge their changes to an integration branch. This provides a buffer
between individual developers’ merges and the main branch. The project manager
or system integrator then merges the integration branch to the main branch.

■ Developers must merge from the main branch to their development branch before
merging to the main branch or integration branch. This type of merge promotes
greater stability by forcing merge-related instability to the developers’ private
branches, where problems can be resolved before they affect the rest of the team.

■ The project manager designates slots for developer merges to the main branch.
This is a variation on several of the mechanisms already described. It provides an
additional level of control in situations where parallel development is going on.

There are other scenarios as well. Chapter 14, Integrating Changes, describes merging in
detail.
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11Defining Project
Views
This chapter explains how config specs work and provides sample config specs useful
for project development work, for nondevelopment tasks such as monitoring progress
and doing research, and for running project builds. It also explains how to share config
specs between Windows and UNIX systems.

How Config Specs Work

When you create views for your project, you must prepare one or more config specs
(configuration specifications). Config specs allow you to achieve the degree of control
that you need to have over project work by controlling which versions developers see
and what operations they can perform in specific views. You can narrow a view to a
specific branch or open it to an entire VOB. You can also disallow checkouts of all
selected versions or restrict checkouts to specific branches.

A config spec contains a series of rules that Rational ClearCase uses to select the
versions that appear in the view. When team members use a view, they see the versions
that match at least one of the rules in the config spec. ClearCase searches the version
tree of each element for the first version that matches the first rule in the config spec. If
no versions match the first rule, ClearCase searches for a version that matches the
second rule. If no versions of an element match any rule in the config spec, no versions
of the element appear in the view.

The order in which rules appear in the config spec determine which version of a given
element is selected. The various examples in this chapter examine this behavior in
different contexts. For details about preparing config specs, see the config_spec
reference page.

Default Config Spec

This config spec defines a dynamic configuration, which selects changes made on the
main branch of every element throughout the entire source tree, by any developer:

(1)
(2)

element * CHECKEDOUT 
element * /main/LATEST
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This is the default config spec, to which each newly created view is initialized. When you
create a view with the mkview command or the View Creation Wizard (Windows
only), the contents of file default_config_spec (located in ccase-home-dir) become the
new view’s config spec.

A view with this config spec provides a private work area that selects your checked-out
versions (Rule 1). By default, when you check out a file, you check out from the latest
version on the main branch (Rule 2). While an element is checked out to you, you can
change it without affecting anyone else’s work. As soon as you check in the new
version, the changes are available to developers whose views select /main/LATEST

versions.

The view also selects all other elements (that is, all elements that you have not checked
out) on a read-only basis. If another user checks in a new version on the main branch
of such an element, the new LATEST version appears in this dynamic view immediately.

By default, snapshot views also include the two version selection rules shown above. In
addition, snapshot view config specs include load rules, which specify which elements
or subtrees to load into the snapshot view. For details on creating snapshot views see
Developing Software or the Help.

Product Note: Rational ClearCase LT supports only snapshot views.

The Standard Configuration Rules

The two configuration rules in the default config spec appear in many of this chapter’s
examples. The CHECKEDOUT rule allows you to modify existing elements. If you try
to check out elements in a view that omits this rule, you can do so, but cleartool
generates this warning:

% cleartool checkout –nc cmd.c
cleartool: Warning: Unable to rename "cmd.c" to "cmd.c.keep": 
Read-only filesystem.
cleartool: Error: Checked out version, but could not copy to "cmd.c": 
File exists.
Correct the condition, then uncheckout and re-checkout the element.
cleartool: Warning: Copied checked out version to "cmd.c.checkedout".
cleartool: Warning: Checked-out version is not selected by view.
Checked out "cmd.c" from version "/main/7".

In this example, the config spec continues to select version 7 of element cmd.c, which
is read-only. A read-write copy of this version, cmd.c.checkedout, is created in
view-private storage. (This is not a recommended way of working.)

The /main/LATEST rule selects the most recent version on the main branch to appear in
the view.
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In addition, a /main/LATEST rule is required to create new elements in a view. If you
create a new element when this rule is omitted, your view cannot “see” that element.
(Creating an element involves creating a main branch and an empty version, /main/0.)

Omitting the Standard Configuration Rules

It makes sense to omit one or both of the standard configuration rules only if a view is
not going to be used to modify data. For example, you can configure a historical view,
to be used only for browsing old data. Similarly, you can configure a view in which to
compile and test only or to verify that sources have been labeled properly.

Config Spec Include Files

ClearCase supports an include file facility, which makes it easy to ensure that all team
members are using the same config spec. For example, the configuration rules in this
config spec can be placed in file /public/c_specs/major.csp. Each developer then needs a
one-line config spec:

Note: If you are sharing config specs between UNIX and Windows NT computers
where the VOB-tags are different, you must have two sources, or you must store the
config spec in a UNIX directory that is accessible from both platforms.

If you want to modify this config spec (for example, to adopt the
no-directory-branching policy), only the contents of major.csp need to change. You can
use this command to reconfigure your view with the modified config spec:

% cleartool setcs –current 

Project Environment for Sample Config Specs

You can use different config specs for different kinds of development and management
tasks. The three sections that follow present sample config specs useful for various
aspects of project development, project management and research, and project builds.
This section presents the development environment that these config specs are based
on.

Product Note: In the examples that follow, arguments that show multicomponent
VOB-tags, such as /vobs/monet, are not applicable to ClearCase LT on UNIX, which
recognizes only single-component VOB-tags, such as /monet.

Developers use a VOB whose VOB-tag is /vobs/monet, which has this structure:

(1) include /public/c_specs/major.csp
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For the purposes of this chapter, suppose that the lib directory has this substructure:

Sources for libraries are located in subdirectories of lib. After a library is built in its
source directory, it can be staged to /vobs/monet/lib.

UNIX: The build scripts for the project’s executable programs can instruct the link
editor, ld(1), to use the libraries in this directory (the library staging area) instead of a
more standard location (for example, /usr/local/lib).

/vobs/monet (VOB-tag, VOB mount point)

src/ (C language source files)

include/ (C language header files)

lib/ (project’s libraries)

lib/

libcalc.a (checked-in staged version of
library)

libcmd.a (checked-in staged version of
library)

libparse.a (checked-in staged version of
library)

libpub.a (checked-in staged version of
library)

libaux1.a (checked-in staged version of
library)

libaux2.a (checked-in staged version of
library)

libcalc/ (sources for calc library)

libcmd/ (sources for cmd library)

libparse/ (sources for parse library)

libpub/ (sources for pub library)

libaux1/ (sources for aux1 library)

libaux2/ (sources for aux2 library)
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Windows: You can use the libraries in this directory (the library staging area) instead
of a more standard location by setting the LIB environment variable or by changing the
makefile.

The following labels are assigned to versions of monet elements.

These version labels have been assigned to versions on the main branch of each
element. Most project development work takes place on the main branch. For some
special tasks, development takes places on a subbranch.

Windows Note: Config specs allow absolute VOB pathnames—absolute pathnames that
begin with a VOB-tag but do not include drive letter or view-tag prefixes. This form of
pathname is required to specify VOB elements without regard for current drive
assignments or active views. For example:

Version Labels Description

R1.0 First customer release

R2_BL1 Baseline 1 prior to second customer release

R2_BL2 Baseline 2 prior to second customer release

R2.0 Second customer release

Subbranches Description

major Used for work on the application’s
graphical user interface, certain
computational algorithms, and other
major enhancements

r1_fix Used for fixing bugs in Release 1.0

\vob_gopher\lib\* (absolute VOB pathname, where \vob_gopher is the
VOB-tag)

\monet\src\* (absolute VOB pathname, where \monet is the
VOB-tag)

Z:\monet\src\* (drive-specific pathname; not recommended)

M:\myview\vob_gopher\lib\* (view-extended pathname; not recommended)
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Views for Project Development

The config specs in this section are useful for project development because they enforce
various branching policies.

View for New Development on a Branch

You can use this config spec for work to be isolated on branches named major:

In this scheme, all checkouts occur on branches named major (Rule 2).

major branches are created at versions that constitute a consistent baseline: a major
release, a minor release, or a set of versions that produces a working version of the
application. In this config spec, the baseline is defined by the version label
BASELINE_X.

Variation That Uses a Time Rule

Sometimes, other developers check in versions that become visible in your view, but
are incompatible with your own work. In such cases, you can continue to work on
sources as they existed before those changes were made. For example, Rule 2 in this
config spec selects the latest version on the main branch as of 4:00 P.M. on November
12:

Note that this rule has no effect on your own checkouts.

View to Modify an Old Configuration

This config spec allows developers to modify a configuration defined with version
labels:

(1)
(2)
(3)
(4)

element * CHECKEDOUT
element * .../major/LATEST
element * BASELINE_X –mkbranch major 
element * /main/LATEST –mkbranch major

(1)
(2)
(3)
(4)

element * CHECKEDOUT
element * /major/LATEST –time 12-Nov.16:00
element * BASELINE_X –mkbranch major
element * /main/LATEST –mkbranch major

(1)
(2)
(3)

element * CHECKEDOUT
element * .../r1_fix/LATEST 
element * R1.0 –mkbranch r1_fix
162 Managing Software Projects



Note the following:

■ Elements can be checked out (Rule 1).

■ The checkout command creates a branch named r1_fix at the initially selected
version (the auto-make-branch clause in Rule 3).

A key aspect of this scheme is that the same branch name, r1_fix, is used in every
modified element. The only administrative overhead is the creation of a single branch
type, r1_fix, with the mkbrtype command.

This config spec is efficient: two rules (Rules 2 and 3) configure the appropriate
versions of all elements:

■ For elements that have been modified, this version is the most recent on the r1_fix
subbranch (Rule 2).

■ For elements that have not been modified, this version is the one labeled R1.0
(Rule 3).

Figure 39 illustrates these elements. The r1_fix branch is a subbranch of the main
branch. But Rule 2 handles the more general case, too: the ... wildcard allows the r1_fix
branch to occur anywhere in any element’s version tree, and at different locations in
the version trees of different elements.

Figure 39 Making a Change to an Old Version
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Omitting the /main/LATEST Rule

The config spec in View to Modify an Old Configuration on page 162 omits the standard
/main/LATEST rule. This rule is not useful for work with VOBs in which the version label
R1.0 does not exist. In addition, it is not useful in situations where new elements are
created. If your development policy is to not create new elements during maintenance
of an old configuration, the absence of a /main/LATEST rule is appropriate.

To allow creation of new elements during the modification process, add a fourth
configuration rule:

When a new element is created with mkelem, the –mkbranch clause in Rule 4 causes
the new element to be checked out on the r1_fix branch (which is created
automatically). This rule conforms to the scheme of localizing all changes to r1_fix
branches.

Variation That Uses a Time Rule

This baseline configuration is defined with a time rule.

View to Implement Multiple-Level Branching

This config spec implements and enforces consistent multiple-level branching.

A view configured with this config spec is appropriate in the following situation:

■ All changes from the baseline designated by the BASELINE_X version label must
be made on a branch named major.

■ Moreover, you are working on a special project, whose changes are to be made on
a subbranch of major, named autumn.

(1)
(2)
(3)
(4)

element * CHECKEDOUT 
element * /main/r1_fix/LATEST 
element * R1.0 –mkbranch r1_fix
element * /main/LATEST –mkbranch r1_fix

(1)
(2)
(3)

element * CHECKEDOUT
element * /main/r1_fix/LATEST
element * /main/LATEST –time 4-Sep:02:00 –mkbranch r1_fix

(1)
(2)
(3)
(4)
(5)

element * CHECKEDOUT 
element * .../major/autumn/LATEST 
element * .../major/LATEST –mkbranch autumn
element * BASELINE_X –mkbranch major 
element * /main/LATEST –mkbranch major 
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Figure 40 shows what happens in such a view when you check out an element that has
not been modified since the baseline:

1 Upon checking out an element, the mkbranch clause in Rule 4 creates the major
branch at the BASELINE_X version.

2 The mkbranch clause in Rule 3 creates the autumn branch at \main\major\0.

3 When the checkout operation finishes, Rule 2 applies; the most recent version,
\main\major\autumn\0, is checked out.

For more on multiple-level branching, see the config_spec and checkout reference
pages.

Figure 40 Multiple-Level Auto-Make-Branch
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The most recent version of each element is selected (Rules 2 and 3), but Rule 3 prevents
checkouts to all elements except those in the directory specified.

Note that Rule 2 matches elements in any directory named src, in any VOB. The pattern
/vobs/monet/src/* restricts matching to only one VOB.

This config spec can be extended easily with additional rules that allow additional
areas of the source tree to be modified.

Views to Monitor Project Status

The config specs presented here are useful for views used for research and monitoring
project status.

View That Uses Attributes to Select Versions

Suppose that the QA team also works on the major branch. Individual developers are
responsible for making sure that their modules pass a QA check. The QA team builds
and tests the application, using the most recent versions that have passed the check.

The QA team can work in a view that uses this config spec:

To make this scheme work, you must create an attribute type, QAOK. Whenever a new
version that passes the QA check is checked in on the major branch, an instance of
QAOK with the value Yes is attached to that version. (This can be done manually or
with a ClearCase trigger.)

If an element in the /src directory has been edited on the major branch, this view selects
the branch’s most recent version that has been marked as passing the QA check (Rule
1). If no version has been so marked or if no major branch has been created, the most
recent version on the main branch is used (Rule 2).

Note: Rule 1 on this config spec does not provide a match if an element has a major
branch, but no version on the branch has a QAOK attribute. This command can locate
the branches that do not have this attribute:

UNIX:

% cleartool find . –branch '{brtype(major) && \! attype_sub(QAOK)}' –print 

The backslash ( \ ) is required in the C shell only, to keep the exclamation point ( ! ) from
indicating a history substitution.

Windows:

(1)
(2)

element –file src/* /main/major/{QAOK=="Yes"} 
element * /main/LATEST 
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cleartool find . –branch "{brtype(major) && ! attype_sub(QAOK)}" –print 

The attype_sub primitive searches for attributes on an element’s versions and
branches, as well as on the element itself.

This scheme allows the QA team to monitor the progress of the rest of the group. The
development config spec always selects the most recent version on the major branch,
but the QA config spec may select an intermediate version (Figure 41).

Figure 41 Development Config Spec vs. QA Config Spec
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schemes introduce complications. Suppose that the config spec above selects version
/main/major/2 of element .../src/cmd.c (Figure 42).

Figure 42 Checking Out a Branch of an Element

Performing a checkout in this view checks out version /main/major/3, not version
/main/major/2:

cleartool: Warning: Version checked out is different from version 
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A particular date, April 25, is used as the milestone. The configuration is a snapshot of
the main line of development at that date (Rule 2), overlaid with all changes that user
jackson has made on the main branch since then (Rule 1).

The output of the cleartool ls command distinguishes jackson’s files from the others:
each entry includes an annotation as to which configuration rule applies to the selected
version.

This is a research view, not a development view. The selected set of files may not be
consistent: some of jackson’s changes may rely on changes made by others, and those
other changes are excluded from this view. Thus, this config spec omits the standard
CHECKEDOUT and /main/LATEST rules.

Historical View Defined by a Version Label

This config spec defines a historical configuration:

This view always selects the set of versions labeled R1.0. In this scenario, all these
versions are on the main branch of their elements. If the R1.0 label type is
one-per-element, not one-per-branch, this config spec selects the R1.0 version on a
subbranch. (For more information, see the mklbtype reference page.)

The –nocheckout qualifier prevents any element from being checked out in this view.
(It also prevents creation of new elements, because the parent directory element must
be checked out.) Thus, there is no need for the CHECKEDOUT configuration rule.

Note: The set of versions selected by this view can change, because version labels can
be moved and deleted. For example, using the command mklabel –replace to move
R1.0 from version 5 of an element to version 7 changes which version appears in the
view. Similarly, using rmlabel suppresses the specified elements from the view. (The
cleartool ls command lists them with a [no version selected] annotation.) If the
label type is locked with the lock command, the configuration cannot change.

You can use this configuration to rebuild Release 1.0, verifying that all source elements
have been labeled properly. You can also use it to browse the old release.

(1)
(2)

element * '/main/{created_by(jackson) && created_since(25-Apr)}'
element * /main/LATEST –time 25-Apr

Note: Rule 1 must be contained on a single physical text line.

(1) element * R1.0 –nocheckout
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Historical View Defined by a Time Rule

This config spec defines a frozen configuration in a slightly different way than the
previous one:

This configuration selects the version that was the most recent on the main branch on
September 4 at 2 A.M. Subsequent checkouts and checkins cannot change which
versions satisfy this criterion; only deletion commands such as rmver or rmelem can
change the configuration. The –nocheckout qualifier prevents anyone from checking
out or creating elements.

This configuration can be used to view a set of versions that existed at a particular point
in time. If modifications must be made to this source base, you must modify the config
spec to “unfreeze” the configuration.

Views for Project Builds

The config specs in this section are useful for running the various types of builds
required for a project.

View That Uses Results of a Nightly Build

Many projects use scripts to run unattended software builds every night. The success
or failure of these builds determine the impact of any checked-in changes on the
application. In layered build environments, they can also provide up-to-date versions
of lower-level software (libraries, utility programs, and so on).

Suppose that every night, a script does the following:

■ Builds libraries in various subdirectories of vobs/monet/lib
■ Checks them in as DO versions in the library staging area, /vobs/monet/lib
■ Labels the versions LAST_NIGHT

You can use this config spec if you want to use the libraries produced by the nightly
builds:

The LAST_NIGHT version of a library is selected whenever such a version exists (Rule
2). If a nightly build fails, the previous night’s build still has the LAST_NIGHT label

(1) element * /main/LATEST –time 4-Sep.02:00 –nocheckout

(1)
(2)
(3)
(4)

element * CHECKEDOUT
element lib/*.a LAST_NIGHT 
element lib/*.a R2_BL2
element * /main/LATEST 
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and is selected. If no LAST_NIGHT version exists (the library is not currently under
development), the stable version labeled R2_BL2 is used instead (Rule 3).

For each library, selecting versions with the LAST_NIGHT label rather than the most
recent version in the staging area allows developers to stage new versions the next day,
without affecting developers who use this config spec.

Variations That Select Versions of Project Libraries

The scheme already described uses version labels to select particular versions of
libraries. For more flexibility, the LAST_NIGHT version of some libraries may be
selected, the R2_BL2 version of others, and the most recent version of still others:

(Rule 3b is not required here, because Rule 4 handles all other libraries. It is included
for clarity only.)

Other kinds of metadata can also be used to select library versions. For example,
lib_selector attributes can take values such as experimental, stable, and released. A
config spec can mix and match library versions like this:

View That Selects Versions of Application Subsystems

This config spec selects specific versions of the application’s subsystems:

In this situation, a developer is making changes to the application’s source files on the
main branch (Rule 4). Builds of the application use the libraries in directory /lib that

(1)
(2a)
(2b)
(3a)
(3b)
(4)

element * CHECKEDOUT 
element lib/libcmd.a LAST_NIGHT 
element lib/libparse.a LAST_NIGHT 
element lib/libcalc.a R2_BL2
element lib/*.a /main/LATEST 
element * /main/LATEST 

(1)
(2)
(3)
(4)
(5)
(6)

element * CHECKEDOUT 
element lib/libcmd.a {lib_selector=="experimental"}
element lib/libcalc.a {lib_selector=="experimental"} 
element lib/libparse.a {lib_selector=="stable"} 
element lib/*.a {lib_selector=="released"}
element * /main/LATEST 

(1)
(2)
(3)
(4)
(5)

element * CHECKEDOUT 
element /vobs/monet/lib/... R2_BL1
element /vobs/monet/include/... R2_BL2 
element /vobs/monet/src/... /main/LATEST 
element * /main/LATEST 
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were used to build Baseline 1, and the header files in directory /include that were used
to build Baseline 2.

View That Selects Versions That Built a Particular Program

This config spec defines a view that selects only enough files required to rebuild a
particular program or examine its sources:

All elements that were not involved in the build of monet appear in the output of
ClearCase ls with a [no version selected] annotation.

This config spec selects the versions listed in the config record (CR) of a particular
derived object (and in the config records of all its build dependencies). It can be a
derived object that was built in the current view, or another view, or it can be a DO
version.

In this config spec, monet is a derived object in the current view. You can reference a
derived object in another view with an extended pathname that includes a DO-ID:

But typically, this kind of config spec is used to configure a view from a derived object
that has been checked in as a DO version.

Configuring the Makefile

By default, a derived object’s config record does not list the version of the makefile that
was used to build it. Instead, the CR includes a copy of the build script itself. (Why?
When a new version of the makefile is created with a revision to one target’s build
script, the configuration records of all other derived objects built with that makefile are
not rendered out of date.)

But if the monet program is to be rebuilt in this view using clearmake (or standard
make on UNIX or omake on Windows), a version of the makefile must be selected
somehow. You can have clearmake record the makefile version in the config record by
including the special clearmake macro invocation $(MAKEFILE) in the target’s
dependency list:

Windows:

monet.exe: $(MAKEFILE) monet.obj ...
link –out:monet.exe monet.obj ...

UNIX:

(1) element * –config /vobs/monet/src/monet

(1) element * –config /vobs/monet/src/monet@@09-Feb.13:56.812 
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monet: $(MAKEFILE) monet.o ...
cc –o monet ...

clearmake always records the versions of explicit dependencies in the CR.

Alternatively, you can configure the makefile at the source level: attach a version label
to the makefile at build time, and then use a config spec like the one in Historical View
Defined by a Version Label on page 169 or View to Modify an Old Configuration on page 162
to configure a view for building. You can also use the special target
.DEPENDENCY_IGNORED_FOR_REUSE; for more information, see Building
Software.

Fixing Bugs in the Program

If a bug is discovered in the monet program, as rebuilt in a view that selects only
enough files required to rebuild a particular program, it is easy to convert the view
from a build configuration to a development configuration. As usual, when making
changes in old sources, follow this strategy:

■ Create a branch at each version to be modified

■ Use the same branch name (that is, create an instance of the same branch type) in
every element

If the fix branch type is r1_fix, this modified config spec reconfigures the view for
performing the fix:

Selecting Versions That Built a Set of Programs

It is easy to expand the config spec that selects only enough files required to rebuild a
particular program to configure a view with the sources used to build a set of
programs, rather than a single program:

There can be version conflicts in such configurations, however. For example, different
versions of file params.h may have been used in the builds of monet and xmonet. In
this situation, the version used in monet is configured, because its configuration rule
came first. Similarly, there can be conflicts when using a single –config rule: if the

(1)
(2)
(3)
(4)

element * CHECKEDOUT
element * .../r1_fix/LATEST
element * –config /vobs/monet/src/monet –mkbranch r1_fix
element * /main/LATEST –mkbranch r1_fix

(1)
(2)
(3)

element * –config /proj/monet/src/monet 
element * –config /proj/monet/src/xmonet 
element * –config /proj/monet/src/monet_conf 
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specified derived object was created by actually building some targets and using DO
versions of other targets, multiple versions of some source files may be involved.

You can modify this config spec as described in Fixing Bugs in the Program on page 173,
to change the build configuration to a development configuration.

Sharing Config Specs Between UNIX and Windows

You can, in principle, share config specs between UNIX and Windows systems. That is,
users on both systems, using views whose storage directories reside on either platform,
can set and edit the same set of config specs.

We recommend that you avoid sharing config specs across platforms. If possible,
maintain separate config specs for each platform. However, if you must share config
specs, adhere to the following requirements:

■ Use slashes (/), not backslashes (\) in pathnames.

■ Use relative, not full, pathnames whenever possible, and do not use VOB-tags in
pathnames. You can ignore this restriction if your UNIX and Windows VOB-tags
both use single, identical pathname components that differ only in their leading
slash characters—\src and /src, for example.

■ Always edit and set config specs on UNIX.

The following sections describe these requirements in detail.

Pathname Separators

When writing config specs to be shared by Windows and UNIX computers, you must
use slash (/), not backslash (\), as the pathname separator. ClearCase on UNIX
recognizes slashes only. (Note that cleartool recognizes both slashes and backslashes
in pathnames; clearmake is less flexible. See Building Software for more information.)

Pathnames in Config Spec Element Rules

Windows and UNIX network regions often use different VOB-tags to register the same
VOBs. Only single-component VOB-tag names, such as \proj1, are permitted on
Windows computers; multiple-component VOB-tags, such as /vobs/src, are common on
UNIX.

When VOB-tags differ between regions, any config spec element rules that use full
pathnames (which include VOB-tags) can be resolved when the config spec is
compiled (cleartool edcs and setcs commands) but only by computers in the applicable
network region. This implies a general restriction regarding shared config specs: a
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given config spec must be compiled only on the operating system for which full
pathnames in element rules make sense. That is, a config spec with full pathnames is
shareable across network regions, even when VOB-tags disagree, but it must be
compiled in the right place.

The restrictions do not apply if either of the following is true (see Example on page 175):

■ The config spec’s element rules use only relative pathnames, which do not include
VOB-tags.

■ Shared VOBs are registered with identical, single-component VOB-tags in both
Windows and UNIX network regions. (The VOB-tags \r3vob and /r3vob are treated
as if they were identical because they differ only in the leading slashes.)

Config Spec Compilation

A config spec that is in use exists in both text file and compiled formats. A config spec’s
compiled form is portable. The restriction is that full VOB pathnames in element rules
must be resolvable at compile time. A config spec is compiled when you edit or set it
(with the cleartool edcs or cleartool setcs command or a ClearCase GUI). If a user on
the other operating system recompiles a config spec (by issuing the edcs or setcs
command or causing the GUI to execute one of these commands) the config spec
becomes unusable by any computer using that view. If this happens, recompile the
config spec on the original operating system.

Example

This config spec element rule may cause problems:

element \vob_p2\abc_proj_src\* \main\rel2\LATEST

If the VOB is registered with VOB-tag \vob_p2 on a Windows network region, but with
VOB-tag /vobs/vob_p2 on a UNIX network region, only Windows computers can
compile the config spec.

To address the problem, do one of the following:

■ Use relative pathnames that do not include VOB-tags, for example:

element ...\abc_proj_src\* \main\rel2\LATEST

■ On UNIX, change the VOB-tag so that it has a single component, /vob_p2.
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12Implementing Project
Development Policies
This chapter presents brief scenarios that show how you can implement and enforce
common development policies with Rational ClearCase. The scenarios use various
combinations of these functions and metadata:

■ Attributes
■ Labels
■ Branches
■ Triggers
■ Config specs
■ Locks
■ Hyperlinks

Sharing Triggers Between UNIX and Windows on page 188 describes how to define
triggers for use on UNIX and Windows computers.

Good Documentation of Changes Is Required

Each ClearCase command that modifies a VOB creates one or more event records. Many
such commands (for example, checkin) prompt for a comment. The event record
includes the user name, date, comment, host, and description of what was changed.

To prevent developers from subverting the system by providing empty comments, you
can create a preoperation trigger to monitor the checkin command. The trigger action
script analyzes the user’s comment (passed in an environment variable), disallowing
unacceptable ones.

Windows Note: When ClearCase fires a trigger, it proceeds based on the success or
failure of the trigger operation, as determined by the trigger script’s exit code. A .bat
file returns the exit code of its last command. Preoperation triggers are the only kind of
trigger that cause the ClearCase execution to fail.

UNIX Trigger Definition:

% cleartool mktrtype –element –all –preop checkin –c "must enter descriptive
comment" \
–exec /public/scripts/comment_policy.sh CommentPolicy 

Windows Trigger Definition:
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cleartool mktrtype –element –all –preop checkin ^
–c "must enter descriptive comment" –exec \\neon\scripts\comm_pol.bat
CommentPolicy 

UNIX Trigger Action Script:

#!/bin/sh
#
# comment_policy
#
ACCEPT=0
REJECT=1
WORDCOUNT=‘echo $CLEARCASE_COMMENT | wc -w‘

if [ $WORDCOUNT -ge 10 ] ; then
exit $ACCEPT

else
exit $REJECT

fi

Windows Trigger Action Script:

@echo off
rem comm_pol.bat
rem 
rem Check for null comment
rem
if "%CLEARCASE_COMMENT%"=="" copy > NUL:

All Source Files Require a Progress Indicator

You may want to monitor the progress of individual files or determine which or how
many files are in a particular state. You can use attributes to preserve this information
and triggers to collect it.

In this case, you can create a string-valued attribute type, Status, which accepts a
specified set of values.

Attribute Definition:

UNIX:

% cleartool mkattype –c "standard file levels" \
–enum ' "inactive","under_devt","QA_approved" ' Status
Created attribute type "Status". 

Windows:

cleartool mkattype –c "standard file levels" ^
–enum "\"inactive\",\"under_devt\",\"QA_approved\"" Status
Created attribute type "Status".
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Developers apply the Status attribute to many different versions of an element. Its
value in early versions on a branch is likely to be inactive and under_devt; on later
versions, its value is QA_approved. The same value can be used for several versions,
or moved from an earlier version to a later version.

To enforce conscientious application of this attribute to versions of all source files, you
can create a CheckStatus trigger whose action script prevents developers from
checking in versions that do not have a Status attribute.

Trigger Definition:

UNIX:

% cleartool mktrtype –element –all –preop checkin \
–c "all versions must have Status attribute" \
–exec 'Perl /public/scripts/check_status.pl' CheckStatus 

Windows:

cleartool mktrtype –element –all –preop checkin ^
–c "all versions must have Status attribute" ^
–exec "ccperl \\neon\scripts\check_status.pl" CheckStatus 

Trigger Action Script:

$pname = $ENV{’CLEARCASE_PN’};
$val = "";
$val = ‘cleartool describe -short -aattr Status $pname‘;

if ($val eq "") {
exit (1);
} else {

exit (0);
}

Label All Versions Used in Key Configurations

To identify which versions of which elements contributed to a particular baseline or
release, you can attach labels to these versions. For example, after Release 2 is built and
tested, you can create label type REL2, using the mklbtype command. You can then
attach REL2 as a version label to the appropriate source versions, using the mklabel
command.

Which are the appropriate versions? If Release 2 was built from the bottom up in a
particular view, you can label the versions selected by that view:

% cleartool mklbtype –c "Release 2.0 sources" REL2

% cleartool mklabel –recurse REL2 top-level-directory 
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Alternatively, you can use the configuration records of the release’s derived objects to
control the labeling process:

% clearmake vega

... sometime later, after QA approves the build:

% cleartool mklabel –config vega@@17-Jun.18:05 REL2 

Using configuration records to attach version labels ensures accurate and complete
labeling, even if developers have created new versions since the release build.
Development work can continue while quality assurance and release procedures are
performed.

To prevent version label REL2 from being used again, you must lock the label type:

% cleartool lock –nusers vobadm lbtype:REL2 

The object is locked to all users except those specified with the –nusers option, in this
case, vobadm.

Isolate Work on Release Bugs to a Branch

You may want to fix bugs found in the released system on a named bug-fix branch, and
to begin this work with the exact configuration of versions from that release.

This policy reflects the ClearCase baseline-plus-changes model. First, a label (REL2, for
example) must be attached to the release configuration. Then, you or any team member
can create a view with the following config spec to implement the policy:

element * CHECKEDOUT
element * .../rel2_bugfix/LATEST
element * REL2 -mbranch rel2_bugfix

If all fixes are made in one or more views with this configuration, the changes are
isolated on branches of type rel2_bugfix. The –mkbranch option causes such branches
to be created, as needed, when elements are checked out.

This config spec selects versions from rel2_bugfix branches, where branches of this
type exist; it creates such a branch whenever a REL2 version is checked out.

Avoid Disrupting the Work of Other Developers

To work productively, developers need to control when they see changes and which
changes they see. The appropriate mechanism for this purpose is a view. Developers
can modify an existing config spec or create a new one to specify exactly which changes
to see and which to exclude.
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To implement this policy, you can also require developers to write and distribute the
config spec rule that filters out their checked-in changes. Some sample config specs:

■ To select your own work, plus all the versions that went into the building of
Release 2:

element * CHECKEDOUT

element * REL2

■ To select your own work, plus the latest versions as of Sunday evening:

element * CHECKEDOUT

element * /main/LATEST -time Sunday.18:00

■ To select your own work, new versions created in the graphics directory, and the
versions that went into last night’s build:

element * CHECKEDOUT

element graphics/* /main/LATEST

element * -config myprog@@12-Jul.00:30

■ To select your own work, the versions either you (jones) or Mary has checked in
today, and the most recent quality-assurance versions:

element * CHECKEDOUT

element * ’/main/{ created_since(06:00) && ( created_by(jones) || 

created_by(mary) ) }’

element * /main/{QAed=="TRUE"}

■ You can also use the config spec include facility to set up standard sets of
configuration rules for developers to add to their own config specs:

element * CHECKEDOUT

element msg.c /main/18

include /usr/cspecs/rules_for_rel2_maintenance

Deny Access to Project Data When Necessary

Occasionally, you may need to deny access to all or most project team members. For
example, you may want to prevent changes to public header files until further notice.
The lock command is designed to enforce such temporary policies:

■ Lock all header files in a certain directory:

% cleartool lock src/pub/*.h 

■ Lock the header files for all users except Mary and Fred:

% cleartool lock –nusers mary,fred src/pub/*.h 

■ Lock all header files in the VOB:
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% cleartool lock eltype:c_header 

■ Lock an entire VOB:

% cleartool lock vob:/vobs/myproj 

Notify Team Members of Relevant Changes

To help team members keep track of changes that affect their own work, you can use
postoperation triggers to send notifications of various events. For example, when
developers change the GUI, an e-mail message to the doc group ensures that these
changes are documented.

To enforce this policy, create a trigger type that sends mail, and then attach it to the
relevant elements.

UNIX Trigger Definition:

% cleartool mktrtype –nc -element –postop checkin \
–exec /public/scripts/informwriters.sh InformWriters

Created trigger type "InformWriters".

UNIX Trigger Action Script:

#!/bin/sh
#
#Init
tmp=/tmp/checkin_mail

# construct mail message describing checkin

cat > $tmp <<EOF
Subject: Checkin $CLEARCASE_PNAME by $CLEARCASE_USER
$CLEARCASE_XPNAME
Checked in by $CLEARCASE_USER.

Comments:
$CLEARCASE_COMMENT
EOF

# send the message

mail docgrp <$tmp

# clean up

#rm -f $tmp 

Windows Trigger Definition:

cleartool mktrtype –nc -element –postop checkin ^
–exec "ccperl \\neon\scripts\informwriters.pl" InformWriters
Created trigger type "InformWriters".
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Windows Trigger Action Script:

use Net::SMTP;

my $smtp = new Net::SMTP ’neon.purpledoc.com’;

$smtp->mail(’ClearCase Admin’);
$smtp->to(’ClearCase Admin’);
$smtp->to(’docgrp’);

$smtp->data();
$smtp->datasend("From: ClearCase Admin\n");
$smtp->datasend("To: docgrp\n");
$smtp->datasend("Subject: checkin\n");
$smtp->datasend("\n");

# create variables for pathname/user/comment

$ver = $ENV{’CLEARCASE_XPN’};
$user = $ENV{’CLEARCASE_USER’};
$comment = $ENV{’CLEARCASE_COMMENT’};

$var = "Version: $ver\nUser: $user\nComment: $comment\n";

$smtp->datasend($var);
$smtp->dataend();
$smtp->quit; 

To attach triggers to existing elements:

1 Place the trigger on the inheritance list of all existing directory elements within the
GUI source tree:

% cleartool find /vobs/gui_src –type d \
–exec 'cleartool mktrigger –nattach InformWriters $CLEARCASE_PN' 

2 Place the trigger on the attached list of all existing file elements within the GUI
source tree:

% cleartool find /vobs/gui_src –type f \
–exec 'cleartool mktrigger InformWriters $CLEARCASE_PN' 

All Source Files Must Meet Project Standards

To ensure that developers are following coding guidelines or other standards, you can
evaluate their source files. You can create preoperation triggers to run user-defined
programs, and cancel the commands that trigger them.

For example, you may want to disallow checkin of C-language files that do not satisfy
quality metrics. Suppose that you have defined an element type, c_source, for C
language files (*.c).
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UNIX Trigger Definition:

% cleartool mktrtype –element –all –eltype c_source \
–preop checkin –exec '/public/scripts/apply_metrics.sh $CLEARCASE_PN'
ApplyMetrics 

Windows Trigger Definition:

cleartool mktrtype –element –all –eltype c_source ^
–preop checkin –exec "\\neon\scripts\appl_met.bat %CLEARCASE_PN%"
ApplyMetrics 

This trigger type ApplyMetrics applies to all elements; it fires when any element of
type c_source is checked in. (When a new c_source element is created, it is monitored.)
If a developer attempts to check in a c_source file that fails the apply_metrics.sh or
appl_met.bat test, the checkin fails.

Note: The apply_metrics.sh script and the appl_met.bat file can read the value of
CLEARCASE_PN from its environment. Having it accept a file name argument provides
flexibility because the script or batch file can be invoked as a trigger action, and
developers can also use it manually.

Associate Changes with Change Orders

To keep track of work done in response to an engineering change order (ECO), you can
use attributes and triggers. For example, to associate a version with an ECO, define
ECO as an integer-valued attribute type:

cleartool mkattype –c "bug number associated with change" –vtype integer ECO
Created attribute type "ECO".

Then, define an all-element trigger type, EcoTrigger, which fires whenever a new
version is created and runs a script to attach the ECO attribute:

Trigger Definition:

cleartool mktrtype –element –all –postop checkin –c "associate change with bug
number" \
–execunix 'Perl /public/scripts/eco.pl' –execwin 'ccperl \\neon\scripts\eco.pl'
EcoTrigger
Created trigger type "EcoTrigger". 

Trigger Action Script:
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$pname = $ENV{’CLEARCASE_XPN’};

print "Enter the bug number associated with this checkin: ";
$bugnum = <STDIN>;
chomp ($bugnum);
$command = "cleartool mkattr ECO $bugnum $pname";

@returnvalue = ‘$command‘;
$rval = join "",@returnvalue;
print "$rval";

exit(0);

When a new version is created, the attribute is attached to the version. For example:

cleartool checkin –c "fixes for 4.0" src.c 
Enter the bug number associated with this checkin: 2347 
Created attribute "ECO" on "/vobs/dev/src.c@@/main/2".
Checked in "src.c" version "/main/2".

cleartool describe src.c@@/main/2 
version "src.c@@/main/2"
... 

Attributes:
ECO = 2347

Associate Project Requirements with Source Files

You can implement requirements tracing with hyperlinks, which associate pairs of VOB
objects. The association should be at the version level (rather than the branch or
element level): each version of a source code module must be associated with a
particular version of a related design document.

For example, the project manager creates a hyperlink type named DesignDoc, which
is used to associate source code with design documents:

cleartool mkhltype –c "associate code with design docs" \
DesignDoc@/vobs/dev DesignDoc@/vobs/design 
Created hyperlink type "DesignDoc". 
Created hyperlink type "DesignDoc".

The hyperlink inheritance feature makes the implementation of requirements tracing
easy:

■ When the source module, hello.c, and the design document, hello_dsn.doc, are
updated, the project manager creates a new hyperlink connecting the two updated
versions:

cleartool mkhlink -c "source doc" DesignDoc hello.c /vobs/design/hello_dsn.doc 
Created hyperlink "DesignDoc@90@/vobs/dev".
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■ When either the source module or the design document incorporates a minor
update, no hyperlink-level change is required: the new version inherits the
hyperlink connection of its predecessor.

cleartool checkin -c "fix bug" hello.c 
Checked in "hello.c" version "/main/2".

To list the inherited hyperlink, use the –ihlink option to the describe command:

■ When either the source module or the design document incorporates a significant
update, which renders the connection invalid, the project manager creates a
null-ended hyperlink to sever the connection:

cleartool mkhlink -c "sever connection to design doc" DesignDoc hello.c 
Created hyperlink "DesignDoc@94@/vobs/dev".

Figure 43 illustrates the hyperlinks that connect the source file to the design doc.

Figure 43 Requirements Tracing

Prevent Use of Certain Commands

To control which users can execute certain commands on ClearCase objects, you can
create a pair of trigger types—one to control the use of the command on
element-related objects, and one to control the use of the command on type objects.
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Both trigger types use the –nuser flag to specify the users who are allowed to use the
command.

Note: You cannot use triggers to prevent a command from being used on an object that
is not element related or a type object. For example, you cannot create a trigger type to
prevent operations on VOB objects or replica objects.

For a list of commands that can be triggered, see the events_ccase and mktrtype
reference pages.

For example, the following commands create two trigger types that prevent all users
except stephen, hugh, and emma from running the chmaster command on
element-related objects and type objects in the current VOB:

cleartool mktrtype –element –all –preop chmaster –nusers stephen,hugh,emma \ 
–execunix 'Perl –e "exit –1;"' –execwin 'ccperl –e "exit (–1);"' \ 
–c "ACL for chmaster" elem_chmaster_ACL 

cleartool mktrtype –type –preop chmaster –nusers stephen,hugh,emma \
–execunix 'Perl –e "exit –1;"' –execwin 'ccperl –e "exit (–1);"' \
–attype –all –brtype –all –eltype –all –lbtype –all –hltype –all \
–c "ACL for chmaster" type_chmaster_ACL 

When user tony tries to run the chmaster command on a restricted object, the
command fails. For example:

cleartool chmaster –c "give mastership to london" london@/vobs/dev \
/vobs/dev/acc.c@@/main/lex_dev 
cleartool: Warning: Trigger "elem_chmaster_ACL" has refused to let 
chmaster proceed.
cleartool: Error: Unable to perform operation "change master" in 
replica "lex" of VOB "/vobs/dev". 

Certain Branches Are Shared Among MultiSite Sites

Product Note: Rational ClearCase LT does not support ClearCase MultiSite.

If your company uses ClearCase MultiSite to support development at different sites,
you must tailor your branching strategy to the needs of these sites. The standard
MultiSite development model is to have a replica of the VOB at each site. Each replica
controls (masters) a site-specific branch type, and developers at one site cannot work
on branches mastered at another site. (For more information on MultiSite mastership,
see the Administrator’s Guide for Rational ClearCase MultiSite.)

However, sometimes you cannot, or may not want to, branch and merge an element.
For example, some file types cannot be merged, so development must occur on a single
branch. In this scenario, all developers must work on a single branch (usually, the main
branch). MultiSite allows only one replica to master a branch at any given time.
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Therefore, if a developer at another site needs to work on the element, mastership of
the branch must be transferred to that site.

MultiSite provides two models for transferring mastership of a branch:

■ The push model, in which the administrator at the replica that masters the branch
uses the chmaster command to give mastership to another replica.

This model is not efficient in a branch-sharing situation, because it requires
communication with an administrator at a remote site. For more information about
this model, see the Administrator’s Guide for Rational ClearCase MultiSite.

■ The pull model, in which the developer who needs to work on the branch uses the
reqmaster command to request mastership of it.

Note: The developer can also request mastership of branch types. For more
information, see the Administrator’s Guide for Rational ClearCase MultiSite.

This model requires the MultiSite administrators to enable requests for mastership
in each replica and to authorize individual developers to request mastership. If
you decide to implement this model, you must provide the following information
to your MultiSite administrator:

❑ Replicated VOBs that should be enabled to handle mastership requests

❑ Identities (domain names and user names) of developers who should be
authorized to request mastership

❑ Branch types and branches for which mastership requests should be denied (for
example, branch types that are site specific, or branches that must remain under
the control of a single site)

The Administrator’s Guide for Rational ClearCase MultiSite describes the process of
enabling the pull model and a scenario in which developers use the pull model.
The Developing Software manual describes the procedure developers use to request
mastership.

Sharing Triggers Between UNIX and Windows

You can define triggers that fire correctly on both UNIX and Windows computers. The
following sections describe two techniques. With one, you use different pathnames or
different scripts; with the other, you use the same script for both platforms.

Using Different Pathnames or Different Scripts

To define a trigger that fires on UNIX, Windows, or both, and that uses different
pathnames to point to the trigger scripts, use the –execunix and –execwin options with
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the mktrtype command. These options behave the same as –exec when fired on the
appropriate platform (UNIX or Windows, respectively). On the other platform, they do
nothing. This technique allows a single trigger type to use different paths for the same
script or to use completely different scripts on UNIX and Windows computers. For
example:

cleartool mktrtype –element –all –nc –preop checkin \
–execunix /public/scripts/precheckin.sh –execwin 
\\neon\scripts\precheckin.bat \ 
pre_ci_trig 

On UNIX, only the script precheckin.sh runs. On Windows, only precheckin.bat runs.

To prevent users on a new platform from bypassing the trigger process, triggers that
specify only –execunix always fail on Windows. Likewise, triggers that specify only
–execwin fail on UNIX.

Using the Same Script

To use the same trigger script on both Windows and UNIX platforms, you must use a
batch command interpreter that runs on both operating systems. For this purpose,
ClearCase includes the ccperl program. On Windows, ccperl is a version of the Perl
program available on UNIX.

The following mktrtype command creates sample trigger type pre_ci_trig and names
precheckin.pl as the executable trigger script.

% cleartool mktrtype –element –all –nc –preop checkin \ 
–execunix 'Perl /public/scripts/precheckin.pl' \ 
–execwin 'ccperl \\neon\scripts\precheckin.pl' \ 
pre_ci_trig 

Notes
■ To conditionalize script execution based on operating system, use environment

variables in Perl scripts.

■ To collect or display information interactively, you can use the clearprompt
command.

■ For more information on using the –execunix and –execwin options, see the
mktrtype reference page.
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13Setting Up the Base
ClearCase-ClearQuest
Integration
This chapter provides an overview of the base ClearCase-ClearQuest integration and
describes how to set up the integration. For information on working in the integration,
see Developing Software.

Overview of the Integration

Rational ClearQuest manages change requests, which report defects or request
modifications for a project or product. Rational ClearCase manages versions of the
elements that represent a project or product. Each version embodies one or more
changes to an element.

The integration of ClearQuest and base ClearCase associates one or more ClearQuest
change requests with one or more ClearCase versions.

A single change request may be associated with more than one version. The set of
versions that implement the requested change is called the change set for that request.

A single version may be associated with more than one change request. These change
requests are called the request set for that version.

The integration has the following interfaces:

■ As a ClearCase project manager, you specify the conditions under which users are
prompted to associate versions with change requests. You can specify VOBs,
branches, and element types for which users can or must associate change
requests.

■ As a ClearQuest administrator, you add ClearCase definitions to a ClearQuest
schema. These definitions enable change requests in databases that use the schema
to contain and display associated change sets.

■ As a ClearCase developer, you can:

❑ Associate a version with one or more change requests at the time you check in
or check out the version.

❑ View the change set for a request.
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❑ Submit queries to identify the change requests that are associated with a project
over a period of time.

Configuring ClearQuest and ClearCase

Before developers can associate ClearCase versions with ClearQuest change requests,
you need to configure ClearQuest and ClearCase as follows:

1 Add ClearCase definitions to a ClearQuest schema. If you have ClearQuest 2.0 (or
a more recent release) installed, use the ClearQuest Designer’s Package Wizard to
add these definitions. If you have an earlier release of ClearQuest installed, use the
ClearQuest Integration Configuration application on Windows to add the
definitions. You associate the ClearCase definitions with one or more record types
and their related forms. Each form then contains a ClearCase tab that displays the
change set for a change request.

2 Use the ClearQuest Designer to upgrade the database with the new version of the
schema. See the Upgrading an existing database topic in the ClearQuest Designer
Help. If you move the integration to a different database, be sure to repeat this step
for that database. For example, you can try out the integration on a sample
database before deciding to use it on a production database.

3 Using the ClearQuest Integration Configuration application, set a policy for each
VOB that determines the conditions under which users are prompted to associate
versions with change requests. You can specify that users are prompted on
checking out a version, checking in a version, or both. You can also specify that
prompting occurs only for some branch types or element types. Associations of
checked-in versions with change requests can be either optional or required.

4 The integration uses ClearCase triggers to allow developers to associate change
requests with versions. If you use the V2 trigger, you need to modify a
configuration file to set database connectivity information and additional policy
parameters. See Installing Triggers in ClearCase VOBs on page 193 for details about
triggers.

Adding ClearCase Definitions to a ClearQuest Schema

A ClearQuest schema contains the attributes associated with a set of ClearQuest user
databases, including definitions of record types, fields, and forms. Before developers
can associate ClearCase versions with ClearQuest change requests in a user database,
you must add some ClearCase definitions to the schema that the database uses. To do
so, use the Package Wizard within ClearQuest Designer, as follows:
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1 Click Start > Programs > Rational Software > Rational ClearQuest > ClearQuest
Designer.

2 In ClearQuest Designer, click Package > Package Wizard.

3 In the Package Wizard, look for the ClearCase 1.0 and ClearCase Upgrade 1.0
packages. If these packages are not listed, click More Packages, and add them to
the list from the Install Packages dialog box.

4 If you are enabling a schema to use the ClearCase-ClearQuest integration for the
first time, select ClearCase 1.0, and click Next. If you are upgrading a schema that
currently uses the ClearCase-ClearQuest integration from ClearQuest release 1.1 to
release 2.0, select ClearCase Upgrade 1.0, and click Next.

5 Select the schema for the ClearQuest user database that you want to use in the
integration with ClearCase. Click Next.

6 If you use the V1 trigger, select the record type of ClearQuest records to be
associated with ClearCase versions. This record type must match the record type
that you specify on the ClearCase tab of the ClearQuest Integration Configuration
application. If you use the V2 trigger, you can specify multiple record types. Click
Finish.

7 Click File > Check In to save the new version of the schema.

8 Click Database > Upgrade Database to upgrade the ClearQuest user database with
the new version of the schema.

If you are using a pre-2.0 release of ClearQuest, use the ClearQuest Integration
Configuration application to add ClearCase definitions to a ClearQuest schema. To
start the application, click Start > Programs > Rational Software > Rational ClearCase >
Administration > Integrations > ClearQuest Integration Configuration. Alternatively, you
can start the application by entering cqconfig at the command prompt. Click the
ClearQuest tab. Click Help for instructions on completing the fields on the tab.

Installing Triggers in ClearCase VOBs

The integration uses ClearCase triggers on cleartool checkin, checkout, and
uncheckout commands to allow developers to associate versions with ClearQuest
change requests. To install these triggers in a VOB, use the ClearQuest Integration
Configuration application.

Product Note: To start the ClearQuest Integration Configuration:

■ In ClearCase, click Start > Programs > Rational Software > Rational ClearCase >
Administration > Integrations > ClearQuest Integration Configuration.
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■ In ClearCase LT, click Start > Programs > Rational Software > Rational ClearCase
LT > ClearQuest Integration Configuration.

Alternatively, you can start the Configuration application by entering cqconfig at the
command prompt.

Prior to ClearCase v2002.05.00, the integration used a Visual Basic trigger on Windows
and a Perl trigger on UNIX. ClearCase v2002.05.00 added a new Perl trigger that runs
on Windows and UNIX. (This trigger is also available in a patch to ClearCase Release
4.2). Specify which trigger you want to use by clicking V1 or V2 in the Windows Trigger
Selection and UNIX Trigger Selection fields of the application. V1 refers to the old Visual
Basic and Perl triggers. V2 refers to the new cross-platform Perl trigger.

The V2 trigger provides a text-based user interface for developers who use the
cleartool command-line interface and a GUI for developers who use one of the
ClearCase GUIs such as ClearCase Explorer (on Windows) or xclearcase (on UNIX). If
you are configuring the integration for the first time, we recommend that you use the
V2 trigger. If you currently use the V1 trigger, we recommend that you evaluate the V2
trigger and consider migrating to it.

The V2 trigger uses a configuration file, which specifies your local configuration
parameters. When you select V2, the Configuration application fills in the Path field
with CQCC/config.pl, the path to the configuration file. In this path, CQCC resolves to
ccase-home-dir/lib/perl5/CQCCTrigger/CQCC on each local client. You can change the path
to a UNC path name so that the integration uses one central configuration file.

For information on completing the other fields in the application, click Help within the
application.

Quick Start for Evaluations (V2 Triggers Only)

The default configuration file is set to use the SAMPL user database that ClearQuest
provides for evaluations. You can test the integration with the SAMPL ClearQuest user
database. If ClearQuest is installed on the client machine, the integration uses the
ClearQuest Perl API to communicate with the ClearQuest user database. If ClearQuest
is not installed on the client machine, the integration uses the ClearQuest Web Interface
to communicate with the ClearQuest user database.

Setting Environment Variables for the ClearQuest Web Interface

To enable a client to use the ClearQuest Web Interface, set the following environment
variables from the command-line prompt or in the configuration file:

■ CQCC_SERVER: name of the host where the ClearQuest Web server resides
■ CQCC_SERVERROOT: root directory where the ClearQuest Web Interface files are

installed
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■ CQCC_WEB_DATABASE_SET: name of the database set

Database sets allow users to select from multiple schema repositories when they start
ClearQuest or the base ClearCase-ClearQuest integration. You need to set the
CQCC_WEB_DATABASE_SET environment variable only if your site uses more than one
database set.

Setting the Environment for the ClearQuest Perl API

To enable a client to use the ClearQuest Perl API, you may need to set the
CQCC_DATABASE_SET environment variable. Database sets allow users to select from
multiple schema repositories when they start ClearQuest or the base
ClearCase-ClearQuest integration. You need to set the CQCC_DATABASE_SET

environment variable only if your site uses more than one database set.

Editing the Configuration File (V2 Triggers Only)

The configuration file contains parameters that define local policy choices and how to
access ClearQuest. The configuration file is set to access the ClearQuest SAMPL user
database and use the defect record type. To use the integration with a different
ClearQuest user database or record type, you need to change parameters. The
configuration file contains documentation that describes how to set the parameters.
Additional information about the configuration file is available in the README file in
the same folder as the configuration file. Before you can edit the configuration file,
change its permissions to make it modifiable.

Testing the Integration (V2 Triggers Only)

After you install the triggers on one or more VOBs and edit the configuration file, you
can test the connection between ClearCase and ClearQuest by entering the following
command:

On Windows:

cqcc_launch CQCC\config.pl -test

On UNIX:

cqcc_launch CQCC/config.pl -test

Note: The preceding commands use the default path for the configuration file. If you
specified a different path when you installed the triggers, use that path when invoking
the cqcc_launch command.

The command displays output indicating whether it is able to connect to the target
ClearQuest user database. For more detailed output messages, set the CQCC_DEBUG

environment variable to 2.
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Checking Performance (V2 Triggers Only)

The performance of the integration triggers can vary depending on how they access
ClearCase and ClearQuest. You can set the CQCC_TIMER environment variable to 1 to
record timing information about the trigger session. The integration writes the
information to standard output and cqcc_output.log in the directory defined by the
TMPDIR environment variable.

Using the Integration Query Wizard

After you establish associations between ClearCase versions and ClearQuest change
requests, you can use the ClearQuest Integration Query wizard on Windows to
identify the change requests that are associated with a project over a period of time. For
example, you might use the wizard to answer the question, “Which change requests
were associated with Release 3.1 of Project X?”

To start the wizard from the Windows Start menu, click Start > Programs > Rational
Software > Rational ClearCase > Administration > ClearQuest Integration Query.
Alternatively, you can start the wizard by entering cqquery at the command prompt.
Click Help for instructions on completing each page of the wizard.
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14Integrating Changes
In a parallel development environment, the opposite of branching is merging. In the
simplest scenario, merging incorporates changes on a subbranch into the main branch.
However, you can merge work from any branch into any other branch. This chapter
describes techniques and scenarios for merging versions of elements and branches.
ClearCase includes automated merge facilities for handling almost any scenario.

How Merging Works

A merge combines the contents of two or more files or directories into a single new
file/directory. The ClearCase merge algorithm uses the following files during a merge
(see Figure 44):

■ Contributors, which are typically one version from each branch you are merging.
(You can merge up to 15 contributors.) You specify which versions are
contributors.

■ The base contributor, which is typically the closest common ancestor of the
contributors. (For selective merges, subtractive merges, and merges in an
environment with complex branch structures, the base contributor may not be the
closest common ancestor.) ClearCase determines which contributor is the base
contributor.

■ The target contributor, which is typically the latest version on the branch that will
contain the results of the merge. You determine which contributor is the target
contributor.

■ The merge output file, which contains the results of the merge and is usually
checked in as a successor to the target contributor. By default, the merge output file
is the checked-out version of the target contributor, but you can choose a different
file to contain the merge output.
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Figure 44 Versions Involved in a Typical Merge

To merge files and directories, ClearCase takes the following steps:

1 It identifies the base contributor.

2 It compares each contributor against the base contributor. (See Figure 45.)

3 For any line that is unchanged between the base contributor and any other
contributor, it copies the line to the merge output file.

4 For any line that has changed between the base contributor and one other
contributor, it accepts the change in the contributor; depending on how you
started the merge operation, ClearCase may copy the change to the merge output
file. However, you can disable the automated merge capability for any given
merge operation. If you disable this capability, you must approve each change to
the merge output file.
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5 For any line that has changed between the base contributor and more than one
other contributor, ClearCase requires that you resolve the conflicting difference.

Figure 45 ClearCase Merge Algorithm

To merge versions, you can use the GUI tools, described briefly in the next section, or
the command-line interface, described in Using the Command Line to Merge Elements on
page 200.

Using the GUI to Merge Elements

ClearCase provides three graphical tools to help you merge elements:

■ Merge Manager
■ Diff Merge
■ Version Tree Browser

The Merge Manager manages the process of merging one or more ClearCase elements.
It automates the processes of gathering information for a merge, starting a merge, and
tracking a merge. It can also save and retrieve the state of a merge for a set of elements.

You can use the Merge Manager to merge from many directions:

■ From a branch to the main branch
■ From the main branch to another branch
■ From one branch to another branch

UNIX: To start the Merge Manager, type clearmrgman at a command prompt.

Windows: You can start the Merge Manager in several ways:

■ Click Start > Programs > Rational Software > Rational ClearCase > Merge Manager.
■ In ClearCase Explorer, click Base ClearCase, and then click Merge Manager.
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The Diff Merge utility shows the differences between two or more versions of file or
directory elements. Use this tool to compare up to 16 versions at a time, navigate
through versions, merge versions, and resolve differences between versions.

UNIX: To start the Diff Merge utility, type xcleardiff or use the cleartool merge
–graphical command at a command prompt.

Windows: You can start Diff Merge in several ways:

■ On the shortcut menu in Windows Explorer, click Compare.
■ In the Merge Manager, click Compare.

The Version Tree Browser displays the version tree for an element. The version tree is
useful when merging to do the following:

■ Locate versions or branches that have contributed to or resulted from a merge
■ Start a merge by clicking on the appropriate symbol

The merge can be recorded with a merge arrow, which is implemented as a hyperlink
of type Merge.

UNIX: To start the Version Tree Browser, use one of these methods:

■ At a command prompt, type cleartool lsvtree –graphical
■ In the ClearCase File Browser, click an element and click Versions > Show version

tree

Windows: You can start the Version Tree Browser in several ways:

■ Click Start > Programs > Rational Software > Rational ClearCase > Version Tree
Browser

■ On the shortcut menu in Windows Explorer, click Version Tree.

Using the Command Line to Merge Elements

Use the following commands to perform merges from the command line:

■ cleartool merge
■ cleartool findmerge
■ cleardiff

For more information on these commands, see the Command Reference.

Common Merge Scenarios

The following sections present a series of merge scenarios that require work on one
branch of an element to be incorporated into another branch. Each scenario shows the
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version tree of an element that requires a merge and indicates the appropriate
command to perform the merge.

Scenario: Selective Merge from a Subbranch

In this scenario, you want to incorporate the changes in version /main/r1_fix/4 into new
development. To perform the merge, you specify which versions on the r1_fix branch to
include. See Figure 46.

Figure 46 Selective Merge from a Subbranch
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You can also specify a range of consecutive versions to be merged. For example, this
command merges only the changes in versions /main/r1_fix/2 through /main/r1_fix/4:

% cleartool merge –to opt.c –insert –version /main/r1_fix/2 /main/r1_fix/4 

No merge arrow is created for a selective merge.

Scenario: Removing the Contributions of Some Versions

A new feature, implemented in versions 14 through 16 on the main branch, will not be
included in the product. You must remove the changes made in those versions. See
Figure 47.

Figure 47 Removing the Contributions of Some Versions
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Scenario: Merging All Project Work

Your team has been working on a branch. Now, your job is to merge all the changes into
the main branch.

The findmerge command can handle most common cases easily. It can accommodate
the following schemes for isolating the project’s work.

All Project Work Is Isolated on a Branch

The standard approach to parallel development isolates all project work on the same
branch. More precisely, all new versions of source files are created on like-named
branches of their respective elements (that is, on branches that are instances of the same
branch type). This makes it possible for a single findmerge command to locate and
incorporate all the changes. Suppose the common branch is named gopher. You can
enter these commands in a view configured with the default config spec:

% cd root-of-source-tree 
% cleartool findmerge . –fversion .../gopher/LATEST –merge –graphical 

The –merge –graphical syntax causes the merge to take place automatically whenever
possible, and to start the graphical merge utility if an element’s merge requires user
interaction. If the project has made changes in several VOBs, you can perform all the
merges at once by specifying several pathnames, or by using the –avobs option to
findmerge.

All Project Work Isolated in a View

Some projects are organized so that all changes are made in a single view (typically, a
shared view). For such projects, use the –ftag option to findmerge. Suppose the
project’s work has been done in a view whose view-tag is goph_vu. These commands
perform the merge:

% cd root-of-source-tree 
% cleartool findmerge . –ftag goph_vu –merge –graphical 

Note: Working in a single shared view is not recommended because doing so can
degrade system performance.

Scenario: Merging a New Release of an Entire Source Tree

Your team has been using an externally supplied source-code product, maintaining the
sources in a VOB. The successive versions supplied by the vendor are checked in to the
main branch and labeled VEND_R1, VEND_R2, and VEND_R3. Your team’s fixes
and enhancements are created on subbranch enhance. The views that your team works
in are configured to branch from the VEND_R3 baseline:
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element * CHECKEDOUT
element * .../enhance/LATEST
element * VEND_R3 -mkbranch enhance
element * /main/LATEST -mkbranch enhance

The version trees in Figure 48 show various likely cases:

■ An element that your team started changing at Release 1 (enhance branch created
at the version labeled VEND_R1)

■ An element that your team started changing at Release 3

■ An element that your team has never changed

Figure 48 Merging a New Release of an Entire Source Tree

Release 4 has arrived, and you need to integrate this release with your team’s changes.
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To prepare for the merge, add the new release to the main branch and label the versions
VEND_R4. Merging the source trees involves merging from the version labeled
VEND_R4 to the most recent version on the enhance branch; if an element has no
enhance branch, nothing is merged.

This procedure accomplishes the integration:

1 Load the vendor’s Release 4 media into a standard directory tree:

%cd /usr/tmp
% tar –xv

The directory tree created is mathlib_4.0.

2 As the VOB owner, run clearexport_ffile, to create a datafile containing
descriptions of the new versions.

% cd ./mathlib_4.0
% clearexport_ffile
 . (lots of output)
 . 

3 In a view configured with the default config spec, start clearimport on the file
clearexport_ffile created. This creates Release 4 versions on the main branches of
elements (and creates new elements as needed).

% cleartool setview mainline
% cd /vobs/proj/mathlib
% clearimport /usr/tmp/mathlib_4.0/cvt_data 

4 Label the new versions:

% cleartool mklbtype –c "Release 4 of MathLib sources" VEND_R4
Created label type "VEND_R4".

% cleartool mklabel –recurse VEND_R4 /vobs/proj/mathlib
 . (lots of output)
 .

5 Set to a view that is configured with your team’s config spec and selects the
versions on the enhance branch:

% cleartool setview enh_vu

6 Merge from the VEND_R4 configuration to your view:

% cleartool findmerge -nback /vobs/proj/mathlib –fver VEND_R4 –merge
–graphical 

The –merge –graphical syntax instructs findmerge to merge automatically if
possible, but if not, start the graphical merge tool.

7 Verify the merges, and check in the modified elements.
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You have now established Release 4 as the new baseline. Developers on your team can
update their view configurations as follows:

Elements that have been active continue to evolve on their enhance branches. When
elements are revised for the first time, their enhance branches are created at the
VEND_R4 version.

Scenario: Merging Directory Versions

One of the most powerful features of ClearCase is versioning of directories. Each
version of a directory element catalogs a set of file elements, directory elements, and
VOB symbolic links (UNIX). In a development project, directories change as often as
files do. Merging the changes to another branch is as easy merging files.

Take a closer look at the source tree scenario from the previous section. Suppose you
find that the vendor has made several changes in directory /vobs/proj/mathlib/src:

■ File elements Makefile, getcwd.c, and fork3.c have been revised.
■ File elements readln.c and get.c have been deleted.
■ A new file element, newpaths.c, has been created.

When you use findmerge to merge the changes made in the VEND_R4 sources to the
enhance branch, the changes to both the files and the directory are handled
automatically. The following findmerge excerpt shows the directory merge activity:

element * CHECKEDOUT
element * .../enhance/LATEST

element * VEND_R4 –mkbranch enhance
element * /main/LATEST –mkbranch enhance

(change from VEND_R3 to VEND_R4)

********************************
<<< directory 1: /vobs/proj/mathlib/src@@/main/3
>>> directory 2: .@@/main/enhance/1
>>> directory 3: .
********************************
-------[ removed directory 1 ]-------|----------[ directory 2]------------
get.c 19-Dec-1991 drp |-
*** Automatic: Applying REMOVE from directory 2
-----------[ directory 1 ]-----------|--------[ added directory 2]---------
 -| newpaths.c  08-Mar.21:49 drp
*** Automatic: Applying ADDITION from directory 2
-------[ removed directory 1 ]-------|-----------[ directory 2]------------
readln.c  19-Dec-1991 drp              |-
*** Automatic: Applying REMOVE from directory 2
Recorded merge of ".".
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If you have changes to merge from both files and directories, it may be a good idea to
run findmerge twice: first to merge directories, and again to merge files. Using the
–print option to a findmerge command does not report everything that is merged,
because findmerge does not see new files or subdirectories in the merge-from version
of a directory until after the directories are merged. To report every merge that takes
place, use findmerge to merge the directories only, and then use findmerge –print to
get information about the file merges needed. Afterward, you can cancel the directory
merges by using the uncheckout command on the directories.

Using Your Own Merge Tools

You can create a merged version of an element manually or with any available analysis
and editing tools. Check out the target version, revise it, and check it in. Immediately
before (or after) the checkin, record your activity by using the merge command with
the –ndata (no data) option:

% cleartool checkout nextwhat.c
Checkout comments for "nextwhat.c":
merge enhance branch
.
Checked out "nextwhat.c" from version "/main/1".

% <invoke your own tools to merge data into checked-out version>

% cleartool merge –to nextwhat.c –ndata –version .../enhance/LATEST
Recorded merge of "nextwhat.c".

This form of the merge command does not change any file system data; it merely
attaches a merge arrow (a hyperlink of type Merge) to the specified versions. After you
have made this annotation, your merge is indistinguishable from one performed with
ClearCase tools.
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15Using Element Types
to Customize File
Element Processing
Most projects involve many different file types. For example, in a typical software
release, developers may work on C-language source files, C-language header files,
document files in binary format, and library files.

Every file that is stored in a ClearCase VOB is associated with an element type. Rational
ClearCase provides predefined element types for various kinds of file types, and every
element type has an associated type manager, which handles the operations performed
on versions of the element.

For some file types in your project, you may want to create your own element types so
that you can customize the handling of the files. You can also create your own type
managers.

This chapter describes how ClearCase uses element types and type managers to
classify and manage files. It also describes how you can customize file classification
and management.

File Types in a Typical Project

Table 5 lists the files used in a typical development project.

Table 5 Files Used in a Typical Project (Part 1 of 2)

Type of File Identifying Characteristic

Source Files

C-language source file .c file name extension

C-language header file .h file name extension

FrameMaker binary file .doc or .mif file name extension, first line of
file begins with <Maker

UNIX: manual page source file .1 – .9 file name extension

Derived Files
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How ClearCase Assigns Element Types

In various contexts, ClearCase determines one or more file types for an existing file
system object, or for a name to be used for a new object. When you create a new
element and do not specify an element type, ClearCase determines the file type for the
element.

The file-typing routines use predefined and user-defined magic files, as described in the
cc.magic reference page. A magic file can use many different techniques to determine
a file type, including file name pattern-matching, stat(2) data, and standard UNIX
magic numbers.

For example, the following magic files specify several file types for each kind of file
listed in Table 5.

Element Types and Type Managers

ClearCase can handle different classes of files differently because it uses element types
to categorize elements. Each file element in a VOB must have an element type. An
element gets its type when it is created; you can change an element’s type
subsequently, with the chtype command. (An element is an instance of its element type,
in the same way that an attribute is an instance of an attribute type and a version label
is an instance of a label type.)

UNIX: ar(1) archive (library) .a file name extension

Windows: library, shared library .lib, .dll file name extension

compiled executable UNIX: <varies with system architecture>
Windows: .exe file name extension

Sample UNIX Magic File

(1)
(2)
(3)
(4)
(5)
(6)

c_src src_file text_file file:      -name "*.c" ;
hdr_file text_file file:            -name "*.h" ;
frm_doc binary_delta_file doc file: -magic 0, "<MakerFile" ;
manpage src_file text_file file:    -name "*.[1-9]" ;
archive derived_file file:          -magic 32, "archive" ;
sunexec derived_file file:          -magic 40, "SunBin" ;

Table 5 Files Used in a Typical Project (Part 2 of 2)

Type of File Identifying Characteristic
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Each element type has an associated type manager, a suite of programs that handle the
storage and retrieval of versions from storage pools. (See the type_manager reference
page for information on how type managers work.) Thus, the way in which a file
element’s data is handled depends on its element type.

Note: Each directory element also has an element type. But directory elements do not
use type managers; the contents of a directory version are stored in the VOB database
itself, not in storage pools.

When you create an element without specifying the element type, ClearCase assigns
an element type as follows:

1 ClearCase reads one or more magic files to find the file types for the name of the
element.

2 ClearCase retrieves the list of file types associated with the first rule in the magic
file that matches the name.

3 ClearCase compares this list with the set of element types defined for the VOB that
stores the element, and creates the element by using the first element type in the
list that matches an element type in the VOB.

For example, a new element named monet_adm.1 is assigned an element type as
follows:

1 A developer creates an element:

% cleartool mkelem monet_adm.1 

2 Because the developer did not specify an element type (–eltype option), mkelem
uses one or more magic files to determine the file types of the specified name.

Note: ClearCase supports a search path facility, using the environment variable
MAGIC_PATH. See the cc.magic reference page for details.

Suppose that the magic file shown in Sample UNIX Magic File on page 210 is the
first (or only) one to be used. In this case, rule (4) is the first to match the name
monet_adm.1, yielding this list of file types:

manpage src_file text_file file

3 This list is compared with the set of element types defined for the new element’s
VOB. Suppose that text_file is the first file type that names an existing element
type; in this case, monet_adm.1 is created as an element of type text_file.

4 Data storage and retrieval for versions of element monet_adm.1 are handled by
the type manager associated with the text_file element type; its name is
text_file_delta:
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% cleartool describe eltype:text_file
element type "text_file"

...

type manager: text_file_delta

supertype: file

meta-type of element: file element 

File-typing mechanisms are defined on a per-user or per-site basis; element types are
defined on a per-VOB basis. (To ensure that element types are consistent across VOBs,
the ClearCase administrator can use global types.) In this case, a new element,
monet_adm.1, is created as a text_file element; in a VOB with a different set of element
types, the same magic file may have created it as a src_file element.

Other Applications of Element Types

Element types allow differential and customized handling of files beyond the selection
of type managers. Following are some examples.

Using Element Types to Configure a View

Creating all C-language header files as elements of type hdr_file allows flexibility in
configuring views. Suppose that one developer has reorganized the project header
files, working on a branch named header_reorg to avoid disrupting the team’s work.
To compile with the new header files, another developer can use a view reconfigured
with one additional rule:

element * CHECKEDOUT
element -eltype hdr_file * /main/header_reorg/LATEST
element * /main/LATEST

Processing Files by Element Type

Suppose that a coding-standards program named check_var_names is to be executed
on each C-language source file. If all such files have element type c_src, a single
cleartool command runs the program:

UNIX:

% cleartool find –avobs –visible –element 'eltype(c_src)' \
–exec 'check_var_names $CLEARCASE_PN' 

Windows:

cleartool> find –avobs –visible –element 'eltype(c_src)' ^
–exec 'check_var_names %CLEARCASE_PN%' 
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Predefined and User-Defined Element Types

Some of the element types described in this chapter (for example, text_file) are
predefined. Others (for example, c_src and hdr_file) are not; the previous examples
work only if user-defined element types with these names are created with the
mkeltype command.

When a new VOB is created, it contains a full set of the predefined element types. Each
is associated with one of the type managers provided with ClearCase. The mkeltype
reference page describes the predefined element types and their type managers.

When you create a new element type with mkeltype, you must specify an existing
element type as its supertype. By default, the new element type uses the same type
manager as its supertype; in this case, the only distinction between the new and old
types is for the purposes described in Other Applications of Element Types on page 212.
For differential data handling, use the –manager option to create an element type that
uses a different type manager from its supertype.

Predefined and User-Defined Type Managers

ClearCase provides predefined type managers. The type managers are described in the
type_manager reference page. Each type manager is implemented as a suite of
programs in a subdirectory of ccase-home-dir/lib/mgrs; the name of the subdirectory is the
name of the type manager.

The mkeltype –manager command creates an element type that uses an existing type
manager. You can further customize ClearCase by creating new type managers and
creating new element types that use them. Architecturally, type managers are mutually
independent, but new type managers can use symbolic links to inherit some of the
functions of existing ones.

UNIX—Creating a New Type Manager

The remainder of this chapter describes how to create a type manger on UNIX. You can
create any number of new type managers for use throughout the local network. Use
these guidelines:

1 Choose a name for the new type manager—ideally one that shows its relationship
to the data format (for example, bitmap_mgr). Create a subdirectory of
ccase-home-dir/lib/mgrs with this name.

Note: Names of user-defined type managers must not begin with underscore.
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2 Create symbolic links to make the new type manager inherit some of its methods
(file-manipulation operations) from an existing type manager.

3 Create your own program for the methods that you want to customize. See
UNIX—Writing a Type Manager Program.

4 On each other ClearCase or ClearCase LT client host in the network, either make a
copy of the new type manager directory, or create a symbolic link to it. The
standard storage, performance, and reliability trade-offs apply.

5 If your company uses ClearCase MultiSite, repeat Step 4 at every site.

Note: An element type belongs to a VOB, and thus is available on every host that
mounts its VOB. But a type manager is host-specific; it is some host’s
ccase-home-dir/lib/mgrs/manager-name directory.

See the type_manager reference page and the file ccase-home-dir/lib/mgrs/mgr_info.h for
additional information on type managers.

UNIX—Writing a Type Manager Program

When invoking a type manager method, cleartool passes to it all the arguments needed
to perform the operation, in ASCII format. For example, many methods accept a
new_container_name argument, specifying the pathname of a data container to which
data is to be written.

In many cases, one or more of the parameters can be ignored. For example, the
create_version method is passed pred_container_name, the pathname of the
predecessor version’s data container. If the type manager implements incremental
differences, this is required information; otherwise, the predecessor’s data container is
of no interest.

Arguments are often object identifiers (OIDs). You need not know anything about how
OIDs are generated; consider each OID to be a unique name for an element, branch, or
version. In general, only type managers that store multiple versions in the same data
container need be concerned with OIDs.

For more information on argument processing, see files
ccase-home-dir/lib/mgrs/mgr_info.h (for C language programs) and
ccase-home-dir/lib/mgrs/mgr_info.sh (for Bourne shell scripts).

Exit Status of a Method

A user-defined type manager method must return an exit status to cleartool, indicating
how the command is to be completed. The symbolic constants in
ccase-home-dir/lib/mgrs/mgr_info.sh specify all valid exit statuses. For example, an
invocation of create_version may create a new data container, and return the exit status
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MGR_STORE_KEEP_JUST_NEW; if creation of the new data container fails, it returns
the exit status MGR_STORE_KEEP_JUST_OLD.

Type Manager for Manual Page Source Files

One kind of file listed in Table 5 is a manual page source file, a file coded in nroff(1)
format. A type manager for this kind of file may have these characteristics:

■ It stores all versions in compressed form in separate data containers, like the
z_whole_copy type manager.

■ It implements version-comparison (compare method) by running diff on
formatted manual pages instead of the source versions.

The basic strategy is to use most of the z_whole_copy type manager’s methods. The
compare method uses nroff(1) to format the versions before displaying their
differences.

Creating the Type Manager Directory

The name mp_mgr (manual page manager) is appropriate for this type manager. The
first step is to create a subdirectory with this name in the ccase-home-dir/lib/mgrs

directory. For example:

# mkdir /usr/rational/lib/mgrs/mp_mgr 

Inheriting Methods from Another Type Manager

Most of the mp_mgr methods are inherited from the z_whole_copy type manager,
through symbolic links. You can enter the following commands as the root user in a
Bourne shell:

# MP=$CLEARCASEHOME/lib/mgrs/mp_mgr
# for FILE in create_element create_version construct_version \

create_branch delete_branches_versions \
merge xmerge xcompare get_cont_info

> do
> ln –s ../z_whole_copy/$FILE $MP/$FILE
> done
# 

Any methods that the new type manager does not support can be omitted from this
list. The lack of a symbolic link causes ClearCase to generate an Unknown Manager 

Request error.

The following sections describe two of these inherited methods, create_version and
construct_version, which can serve as models for user-defined methods. Both are
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actually implemented as scripts in the same file,
ccase-home-dir/lib/mgrs/z_whole_copy/Zmgr.

The create_version Method

The create_version method is invoked when a checkin command is entered. The
create_version method of the z_whole_copy type manager does the following:

1 Compresses the data in the checked-out version

2 Stores the compressed data in a data container located in a source storage pool

3 Returns an exit status to the calling process, indicating what to do with the new
data container

The file ccase-home-dir/lib/mgrs/mgr_info.h lists the arguments passed to the method from
the calling program (usually cleartool or xclearcase):

/*********************************************************************
*******
 * create_version
 * Store the data for a new version.
 * Store the version's data in the supplied new container, combining it
 * with the predecessor's data if desired (e.g for incremental deltas).
 *
 * Command line:
 *  create_version create_time new_branch_oid new_ver_oid new_ver_num
 *                new_container_pname pred_branch_oid pred_ver_oid
 *                pred_ver_num pred_container_pname data_pname

The only arguments that require special attention are new_container_pname (fifth
argument), which specifies the pathname of the new data container, and data_pname

(tenth argument), which specifies the pathname of the checked-out file.

The file ccase-home-dir/lib/mgrs/mgr_info.sh lists the appropriate exit statuses and
provides a symbolic name for the create_version method:

# Any unexpected value is treated as failure
MGR_FAILED=1

# Return Values for store operations
MGR_STORE_KEEP_NEITHER=101
MGR_STORE_KEEP_JUST_OLD=102
MGR_STORE_KEEP_JUST_NEW=103
MGR_STORE_KEEP_BOTH=104
 .
 .
MGR_OP_CREATE_VERSION="create_version"

The example here is the code that implements the create_version method.
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The Bourne shell allows only nine command-line arguments. The shift 1 in Line 1
discards the first argument (create_time), which is unneeded. Thus, the pathname of the
checked-out version (data_pname), originally the tenth argument, becomes $9.

In Line 6, the contents of data_pname are compressed, then appended to the new, empty
data container: new_container_pname, originally the fifth argument, but shifted to
become $4. (Lines 2 through 5 verify that the new data container is, indeed, empty.)

Finally, the exit status of the gzip command is checked, and the appropriate value is
returned (Lines 7 through 11). The exit status of the create_version method indicates
that both the old data container (which contains the predecessor version) and the new
data container (which contains the new version) are to be kept.

The construct_version Method

An element’s construct_version method is invoked when standard UNIX software
reads a particular version of the element (unless the contents are already cached in a
cleartext storage pool). For example, the construct_version method of element
monet_admin.1 is invoked by the view_server when a user enters these commands:

It is also invoked during a checkout command, which makes a view-private copy of
the most recent version on a branch.

The construct_version method of the z_whole_copy type manager does the following:

1 Uncompresses the contents of the data container

(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)
(9)
(10)
(11)

shift 1
if [ -s $4 ] ; then

echo '$0: error: new file is not of length 0!’
exit $MGR_FAILED

fi
if $gzip < $9 > $4 ; ret=$? ; then : ; fi
if [ "$ret" = "2" -o "$ret" = "0" ] ; then

exit $MGR_STORE_KEEP_BOTH
else

exit $MGR_FAILED
fi 

% cp monet_admin.1 /usr/tmp (read version selected by view) 

% cat monet_admin.1@@/main/4 (read a specified version) 
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2 Returns an exit status to the calling process, indicating what to do with the new
data container

The file ccase-home-dir/lib/mgrs/mgr_info.h lists the arguments passed to the method.

/*********************************************************************
*******
 * construct_version
 * Fetch the data for a version.
 * Extract the data for the requested version into the supplied 
pathname, or
 * return a value indicating that the source container can be used as 
the
 * cleartext data for the version.
 *
 * Command line:
 *  construct_version source_container_pname data_pname version_oid

The file ccase-home-dir/lib/mgrs/mgr_info.sh lists the appropriate exit statuses and
provides a symbolic name for the construct_version method:

# Any unexpected value is treated as failure
MGR_FAILED=1

# Return Values for construct operations
MGR_CONSTRUCT_USE_SRC_CONTAINER=101
MGR_CONSTRUCT_USE_NEW_FILE=102
 .
 .
MGR_OP_CONSTRUCT_VERSION="construct_version"

This example is the code that implements the construct_version method.

In Line 1, the contents of source_container_pname are uncompressed and stored in the
cleartext container, data_pname. The remaining lines return the appropriate value to the
calling process, depending on the success or failure of the gzip command.

Implementing a New compare Method

The compare method is invoked by a cleartool diff command. This method does the
following:

1 Formats each version using nroff(1), producing an ASCII text file

construct_version Method

(1)
(2)
(3)
(4)
(5)

if $gzip -d < $1 > $2 ; then
exit $MGR_CONSTRUCT_USE_NEW_FILE

else
exit $MGR_FAILED

fi 
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2 Compares the formatted versions, using cleardiff or xcleardiff

The file ccase-home-dir/lib/mgrs/mgr_info.h lists the arguments passed to the method from
cleartool or xclearcase.

/*********************************************************************
*******
 * compare
 * Compare the data for two or more versions.
 * For more information, see man page for cleartool diff.
 *
 * Command line:
 *  compare [-tiny | -window] [-serial | -diff | -parallel] [-columns 
n]
 *          [pass-through-options] pname pname ...

This listing shows that a user-supplied implementation of the compare method must
accept all the command-line options that the ClearCase diff command supports. The
strategy here is to pass the options to cleardiff, without attempting to interpret them.
After all options are processed, the remaining arguments specify the files to be
compared.

The file ccase-home-dir/lib/mgrs/mgr_info.sh lists the appropriate exit statuses and
provides a symbolic name for the compare method.

# Return Values for COMPARE/MERGE Operations
MGR_COMPARE_NODIFFS=0
MGR_COMPARE_DIFF_OR_ERROR=1
 .
 .
MGR_OP_COMPARE="compare" 

The Bourne shell script listed in Script for compare Method implements the compare
method. (You can modify this script to implement the xcompare method as a slight
variant of compare.)
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Testing the Type Manager

You can test a new type manager only by using it on some ClearCase host. This process
need not be obtrusive. Because the type manager has a new name, no existing element
type—and therefore, no existing element—uses it automatically. To place the type
manager in service, create a new element type, create some test elements of that type,
and run some tests.

The following testing sequence continues the mp_mgr example.

Script for compare Method

#!/bin/sh -e
MGRDIR=${CLEARCASEHOME:-/usr/rational}/lib/mgrs

#### read file that defines methods and exit statuses
. $MGR_DIR/mgr_info.sh

#### process all options: pass them through to cleardiff
OPTS=""
while (expr $1 : '\-' > /dev/null) ; do
    OPTS="$OPTS $1"
    if [ "$1" = "$MGR_FLAG_COLUMNS" ] ; then
        shift 1
        OPTS="$OPTS $1"
    fi
    shift 1
done
#### all remaining arguments ($*) are files to be compared
#### first, format each file with NROFF
COUNT=1
TMP=/usr/tmp/compare.$$
for X in $* ; do
    nroff -man $X | col | ul -Tcrt > $TMP.$COUNT
    COUNT=‘expr $COUNT + 1‘
done

#### then, compare the files with cleardiff
cleardiff -quiet $OPTS $TMP.*

#### cleanup and return appropriate exit status
if [ $? -eq MGR_COMPARE_NODIFFS ] ; then
    rm -f $TMP.*
    exit MGR_COMPARE_NODIFFS
else
    rm -f $TMP.*
    exit MGR_COMPARE_DIFF_OR_ERROR
fi
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Creating a Test Element Type. To make sure that an untested type manager is not used
accidentally, associate it with a new element type, manpage_test, of which you are the
only user.

% cleartool mkeltype –nc –supertype compressed_file \
–manager mp_mgr manpage_test

% cleartool lock –nusers $USER eltype:manpage_test 

Creating and Using a Test Element. These commands create a test element that uses
the new type manager, and tests the various data-manipulation methods:

% cd directory-in-test-VOB
% cleartool checkout –nc . (tests create_element method)
% cleartool mkelem –eltype manpage_test –nc –nco test.1
% cleartool checkout –nc test.1 (tests construct_version
method)
% vi test.1 (edit checked-out version)
% cleartool checkin –c "first" test.1 (tests create_ version method)
% cleartool checkout –nc test.1 (tests construct_ version
method)
% vi test.1 (edit checked-out version)
% cleartool checkin –c "second" test.1 (tests create_ version method)
% cleartool diff test.1@@/main/1 test.1@@/main/2 (tests compare method) 

Installing and Using the Type Manager

After a type manager has been fully tested, you can make it available to all users with
the following procedure.

1 Install the type manager.

A VOB is a networkwide resource; it can be mounted on any ClearCase host. But a
type manager is a host resource: a separate copy must be installed on each host
where ClearCase client programs run. If the copy is not installed, elements of the
new type cannot be used. (It need not be installed on hosts that serve only as
repositories for VOBs and/or views.)

If the VOB is replicated, you must install the type manager at all sites. Custom type
managers are not replicated.

To install the type manager on a particular host, create a subdirectory in
ccase-home-dir/lib/mgrs, and populate it with the programs that implement the
methods. You can create symbolic links across the network to a master copy on a
server host.

2 Create element types.

Create one or more element types that use the type manager, just as you did in
Testing the Type Manager (do not include “test” in the name of the element type).
For example, you can name the element type manpage or nroff_src.
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3 Convert existing elements.

You will probably want to have at least a few existing elements use the new type
manager. The chtype command changes an element’s type:

% cleartool chtype –force manpage pathname ... 

Permission to change an element’s type is restricted to the element’s owner, the
VOB owner, and the root user.

4 Revise magic files.

If you want the new element types to be used automatically for certain newly
created elements, create (or update) a local.magic file in each host’s
ccase-home-dir/config/magic directory:

manpage src_file text_file file: -name "*.[1-9]" ;

5 Inform the project team (and other teams, if appropriate).

Advertise the new element types to all team members, describing the features and
benefits of the new type manager. Be sure to provide directions on how to gain
access to the new functionality automatically (through file names that match
magic-file rules) and explicitly (with mkelem –eltype).

Icon Use by GUI Browsers

An xclearcase browser can display file system objects either by name or graphically. In
the latter case, xclearcase selects an icon for each file system object as follows:

1 The object’s name or its contents determines a list of file types, as described in How
ClearCase Assigns Element Types on page 210.

2 One by one, the file types are compared to the rules in predefined and
user-defined icon files, as described in the cc.icon reference page. For example, the
file type c_source matches this icon file rule:

c_source : -icon c ;

When a match is found, the search ends. The token that follows –icon names the
file that contains the icon to be displayed.

3 xclearcase searches for the file, which must be in bitmap(1) format, in directory
$HOME/.bitmaps, or ccase-home-dir/config/ui/bitmaps, or the directories specified by
the environment variable BITMAP_PATH.

4 If a valid bitmap file is found, xclearcase displays it; otherwise, the search for an
icon continues with the next file type.
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The name of an icon file must include a numeric extension, which need not be specified
in the icon file rule. The extension specifies how much screen space xclearcase must
allocate for the icon. Each bitmap supplied with ClearCase is stored in a file with a .40
suffix (for example, lib.40), indicating a 40x40 icon.

This procedure causes xclearcase to display manual page source files with a
customized icon. All manual pages have file type manpage.

1 Add a rule to your personal magic file (in directory $HOME/.magic) that includes
manpage among the file types assigned to all manual page source files:

manpage src_file text_file file:  -name "*.[1-9]" ;

2 Add a rule to your personal icon file (in directory $HOME/.icon) that maps
manpage to a user-defined bitmap file:

manpage : -icon manual_page_icon ;

3 Create a manpage icon in your personal bitmaps directory ($HOME/.bitmaps) by
revising one of the standard icon bitmaps with the standard X bitmap utility:

% mkdir $HOME/.bitmaps
% cd $HOME/.bitmaps
% cp $RATIONALHOME/config/ui/bitmaps/c.40 manual_page_icon.40
% bitmap manual_page_icon.40 

4 Test your work by having an xclearcase browser display a manual page source file
(Figure 49).

Figure 49 User-Defined Icon Display

checkin.1 clearmake.1

lookup of file name
in magic file yields
manpage file type

lookup of manpage in icon
file yields customized

manpage_icon bitmap
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16Using ClearCase
Throughout the
Development Cycle
The previous chapters describe various aspects of managing a project with Rational
ClearCase. This chapter presents one way in which you can use ClearCase to organize
the work throughout a development project. During this cycle, developers create a new
release and maintain the previous release.

This chapter describes concepts and methods to address typical organizational needs.
There are many other approaches that ClearCase supports. Instead of using
command-line tools that are described here, consider using GUI tools such as the
Merge Manager to accomplish similar goals.

Project Overview

Release 2.0 development of the monet project includes the following kinds of work:

■ Patches. Several high-priority bug fixes to Release 1.0 are needed.

■ Minor enhancements. Some commands need new options; some option names
need to be shortened (–recursive becomes –r); some algorithms need performance
work.

■ Major new features. A graphical user interface is required, as are many new
commands and internationalization support.

These three development efforts can proceed largely in parallel (Figure 50), but critical
dependencies and milestones must be considered:

■ Several Release 1.0 patch releases will ship before Release 2.0 is complete.
■ New features take longer to complete than minor enhancements.
■ Some new features depend on the minor enhancements.
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Figure 50 Project Plan for Release 2.0 Development

The plan uses a baseline-plus-changes approach. Periodically, developers stop writing
new code, and spend some time integrating their work, building, and testing. The
result is a baseline: a stable, working version of the application. ClearCase makes it easy
to integrate product enhancements incrementally and frequently. The more frequent
the baselines, the easier the tasks of merging work and testing the results.

After a baseline is produced, active development resumes; any new efforts begin with
the set of source versions that went into the baseline build.

You define a baseline by assigning the same version label (for example, R2_BL1 for
Release 2.0, Baseline 1) to all the versions that go into, or are produced by, the baseline
build.

The project team is divided into three smaller teams, each working on a different
development effort: the MAJ team (new features), the MIN team (minor
enhancements), and the FIX team (Release 1.0 bug fixes and patches).

Note: Some developers may belong to multiple teams. These developers work in
multiple views, each configured for the respective team’s tasks.

Product Note: In the examples that follow, arguments that show multicomponent
VOB-tags, such as /vobs/monet, do not apply to Rational ClearCase LT on UNIX, which
recognizes only single-component VOB-tags, such as /monet.

The development area for the monet project is shown here. At the beginning of Release
2.0 development, the most recent versions on the main branch are labeled R1.0.

2.01.0 1

MAJ Team

MIN Team

FIX Team

2

1.0.21.0.1

= Release

= Baseline

= Freeze

= Merge
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Development Strategy

This section describes the ClearCase issues to be resolved before development begins.

Project Manager and ClearCase Administrator

In most development efforts, the project manager and the system administrator are
different people. The user name of the project manager is meister. The administrator is
the vobadm user, who creates and owns the monet and libpub VOBs.

Use of Branches

In general, different kinds of work is done on different branches. The Release 1.0 bug
fixes, for example, are made on a separate branch to isolate this work from new
development. The FIX team can then create patch releases that do not include any of
the Release 2.0 enhancements or incompatibilities.

Because the MIN team will produce the first baseline release on its own, the project
manager gives the main branch to this team. The MAJ team will develop new features
on a subbranch, and will not be ready to integrate for a while; the FIX team will fix
Release 1.0 bugs on another subbranch and can integrate its changes at any time.

Each new feature can be developed on its own subbranch, to better manage integration
and testing work. For simplicity, this chapter assumes that work for new features is
done on a single branch.

The project manager has created the first baseline from versions on the main branches
of their elements. But this is not a requirement; you can create a release that uses
versions on any branch, or combination of branches.

The evolution of a typical element during Release 2.0 development (Figure 51),
proceeds as follows:

1 Start minor and major enhancements, along with R1.0 bug fixing (all branches).

2 Freeze minor enhancements work (main branch).

3 Merge bug fixes from Release 1.0.1 into minor enhancements (main).

/vobs/monet (project top-level directory)

src/ (sources)

include/ (include files)

lib/ (shared libraries)
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4 Create Baseline 1 release (main).

5 Freeze major enhancements work (major).

6 Merge Baseline 1 changes into major enhancements (major).

7 Freeze minor enhancements work (main).

8 Merge additional bugfixes into minor enhancements (main).

9 Freeze major enhancements work (major).

10 Merge major enhancements work with minor enhancements work (main).

11 Create Baseline 2 release (main).

12 Begin Final testing (main).

13 Release 2.0 is done (main).
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Figure 51 Development Milestones: Evolution of a Typical Element

Creating Project Views

The MAJ team works on a branch named major and uses this config spec:

(1)
(2)
(3)
(4)

element * CHECKEDOUT 
element * .../major/LATEST 
element * R1.0 –mkbranch major 
element * /main/LATEST –mkbranch major 
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The MIN team works on the main branch and uses the default config spec:

The FIX team works on a branch named r1_fix and uses this config spec:

For the MAJ and FIX teams, use of the auto-make-branch facility in Rule (3) and Rule (4)
enforces consistent use of subbranches. It also relieves developers of the task of
creating branches explicitly and ensures that all branches are created at the version
labeled R1.0.

Creating Branch Types

The project manager creates the major and r1_fix branch types required for the config
specs in Creating Project Views on page 229:

cleartool mkbrtype –c "monet R2 major enhancements" \
major@/vobs/libpub major@/vobs/monet 
Created branch type "major".
Created branch type "major".

cleartool mkbrtype –c "monet R1 bugfixes" r1_fix@/vobs/libpub
r1_fix@/vobs/monet 
Created branch type "r1_fix".
Created branch type "r1_fix".

Note: Because each VOB has its own set of branch types, the branch types must be
created separately in the monet VOB and the libpub VOB.

Creating Standard Config Specs

To ensure that all developers in a team configure their views the same way, the project
manager creates files containing standard config specs:

■ /public/config_specs/MAJ contains the MAJ team’s config spec.

■ /public/config_specs/FIX contains the FIX team’s config spec.

These config spec files are stored in a standard directory outside a VOB, to ensure that
all developers get the same version.

(1)
(2)

element * CHECKEDOUT 
element * .../main/LATEST 

(1)
(2)
(3)
(4)

element * CHECKEDOUT 
element * .../r1_fix/LATEST 
element * R1.0 –mkbranch r1_fix 
element * /main/LATEST –mkbranch r1_fix 
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Creating, Configuring, and Registering Views

Each developer creates a view under his or her home directory. For example, developer
arb enters these commands:

% mkdir $HOME/view_store
% cleartool mkview –tag arb_major $HOME/view_store/arb_major.vws
Created view.
Host-local path: phobos:export/home/arb/view_store/arb_major.vws
Global path:     /net/phobos/export/home/arb/view_store/arb_major.vws
It has the following rights:
User : arb : rwx
Group: user : rwx
Other: : r-x

A new view has the default config spec. Thus, developers on the MAJ and FIX teams
must reconfigure their views, using the standard file for their team. arb edits her config
spec with the cleartool edcs command, deletes the existing lines, and adds the
following line:

/public/config_specs/MAJ 

If the project manager changes the standard file, arb must enter the command cleartool
setcs –current to pick up the changes.

Development Begins

To begin the project, a developer sets a properly configured view, checks out one or
more elements, and starts work. For example, developer david on the MAJ team enters
these commands:

% cleartool setview david_major
% cd /vobs/monet/src
% cleartool checkout –nc opt.c prs.c
Created branch "major" from "opt.c" version "/main/6".
Checked out "opt.c" from version "/main/major/0".
Created branch "major" from "prs.c" version "/main/7".
Checked out "prs.c" from version "/main/major/0".

The auto-make-branch facility causes each element to be checked out on the major
branch (see Rule 4 in the MAJ team’s config spec in Creating Project Views on page 229).
If a developer on the MIN team enters this command, the elements are checked out on
the main branch, with no conflict.

ClearCase is fully compatible with standard development tools and practices. Thus,
developers use the editing, compilation, and debugging tools they prefer (including
personal scripts and aliases) while working in their views.
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Developers check in work periodically to make their work available to other team
members (that is, those whose views select the most recent version on the team’s
branch). This allows intrateam integration and testing to proceed throughout the
development period.

Techniques for Isolating Your Work

Individual developers may need or prefer to isolate their work from the changes made
by other team members. To do so, they can use these techniques to configure their
views:

■ Time rules. When someone checks in an incompatible change, a developer can
reconfigure the view to select the versions at a point before those changes were
made.

■ Private subbranches. A developer can create a private subbranch in one or more
elements (for example, /main/major/anne_wk). The config spec must be changed to
select versions on the /main/major/anne_wk branch instead of versions on the
/main/major branch.

■ Viewing only their own revisions. Developers can use a ClearCase query to
configure a view that selects only their own revisions to the source tree.

Creating Baseline 1

The MIN team has implemented and tested the first group of minor enhancements,
and the FIX team has produced a patch release, whose versions are labeled R1.0.1. It is
time to combine these efforts, to produce Baseline 1 of Release 2.0 (Figure 52).
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Figure 52 Creating Baseline 1

Merging Two Branches

The project manager asks the MIN developers to merge the R1.0.1 changes from the
r1_fix branch to their own branch (main). All the changes can be merged by using the
findmerge command once. For example:

% cleartool findmerge /vobs/libpub /vobs/monet/src \
–fversion .../r1_fix/LATEST –merge –graphical

.

. <lots of output>

.

Integration and Test

After the merges are complete, the /main/LATEST versions of certain elements represent
the efforts of the MIN and FIX teams. Members of the MIN team now compile and test
the monet application to find and fix incompatibilities in the work of both teams.

The developers on the MIN team integrate their changes in a single, shared view. The
project manager creates the view storage area in a location that is accessible from all
developer hosts:

MIN Team

FIX Team

Release
1.0 Freeze

Release
1.0.1

Baseline
1
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% umask 2
% mkdir /netwide/public
% cleartool mkview –tag base1_vu /netwide/public/base1_vu.vws
Created view.
Host-local path: infinity:/netwide/public/base1_vu.vws
Global path:     /net/infinity/netwide/public/base1_vu.vws.
It has the following rights:
User : meister  : rwx
Group: mon      : rwx
Other:          : r-x

Because all integration work takes place on the main branch, there is no need to change
the configuration of the new view from the ClearCase default. MIN developers set this
view (cleartool setview base1_vu) and coordinate builds and tests of the monet
application. Because they are sharing a single view, the developers are careful not to
overwrite each other’s view-private files. Any new versions created to fix
inconsistencies (and other bugs) go onto the main branch.

Labeling Sources

The monet application’s minor enhancements and bug fixes are now integrated, and a
clean build has been performed in view base1_vu. To create the baseline, the project
manager assigns the same version label, R2_BL1, to the /main/LATEST versions of all
source elements. He begins by creating an appropriate label type:

% cleartool mklbtype –c "Release, Baseline 1" R2_BL1@/vobs/monet
R2_BL1@/vobs/libpub
Created label type "R2_BL1".
Created label type "R2_BL1".

He then locks the label type, preventing all developers (except himself) from using it:

% cleartool lock –nusers meister lbtype:R2_BL1@/vobs/monet
lbtype:R2_BL1@/vobs/libpub
Locked label type "R2_BL1".
Locked label type "R2_BL1".

Before applying labels, he verifies that all elements are checked in on the main branch
(checkouts on other branches are still permitted):

% cleartool lscheckout –all /vobs/monet /vobs/libpub 

No output from this command indicates that all elements for the monet project are
checked in. Now, the project manager attaches the R2_BL1 label to the currently
selected version (/main/LATEST) of every element in the two VOBs:

% cleartool mklabel –recurse R2_BL1 /vobs/monet /vobs/libpub 
Created label "R2_BL1" on "/vobs/monet" version "/main/1".
Created label "R2_BL1" on "/vobs/monet/src" version "/main/3".
 <many more label messages> 
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Removing the Integration View

The view registered as base1_vu is no longer needed, so the project manager removes
it:

% cleartool rmview –force –tag base1_vu 

Merging Ongoing Development Work

After Baseline 1 is created, the MAJ team merges the Baseline 1 changes into its work
(Figure 53). The team now has access to the minor enhancements it needs for further
development. Team members also have an early opportunity to determine whether
any of their changes are incompatible.

Figure 53 Updating Major Enhancements Development

Accordingly, the project manager declares a freeze of major enhancements
development. MAJ team members check in all elements and verify that the monet
application builds and runs, making small source changes as necessary. When all such
changes have been checked in, the team has a consistent set of main\major\LATEST

versions.

Note: Developers working on other major enhancements branches can merge at other
times, using the same merge procedures described here.

Preparing to Merge

1 The project manager makes sure that no element is checked out on the major
branch:

MAJ Team

MIN Team Baseline
1

Release
1.0

Freeze

Freeze
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% cleartool lscheckout –all /vobs/monet /vobs/libpub 

Note: Any MAJ team members who want to continue with nonmerge work can
create a subbranch at the “frozen” version (or work with a version that is checked
out as unreserved).

2 The project manager performs any required directory merges:

% cleartool setview major_vu(use any MAJ team view)

% cleartool findmerge /vobs/monet /vobs/libpub –type d \
–fversion /main/LATEST –merge
Needs merge /vobs/monet/src [automatic to /main/major/3 from 

/main/LATEST] 

.

. <lots of output>

.

Log has been written to “findmerge.log.04-Feb-99.09:58:25”.

3 After checking in the files, the project manager determines which elements need to
be merged:

% cleartool findmerge /vobs/monet /vobs/libpub –fversion /main/LATEST
–print 

.

. <lots of output>

.

A 'findmerge' log has been written to

"findmerge.log.04-Feb-99.10:01:23"

This last findmerge log file is in the form of a shell script: it contains a series of
cleartool findmerge commands, each of which performs the required merge for
one element:

% cat findmerge.log.04-Feb-99.10:01:23
cleartool findmerge /vobs/monet/src/opt.c@@/main/major/1 -fver /main/LATEST 
–merge
cleartool findmerge /vobs/monet/src/prs.c@@/main/major/3 -fver /main/LATEST 
–merge

.

.
cleartool findmerge /vobs/libpub/src/dcanon.c@@/main/major/3 -fver 
/main/LATEST -merge
cleartool findmerge /vobs/libpub/src/getcwd.c@@/main/major/2 -fver 
/main/LATEST -merge
cleartool findmerge /vobs/libpub/src/lineseq.c@@/main/major/10 -fver 
/main/LATEST -merge

4 The project manager locks the major branch, allowing it to be used only by the
developers who are performing the merges:
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cleartool lock –nusers meister,arb,david,sakai brtype:major@/vobs/monet \
brtype:major@/vobs/libpub 
Locked branch type "major".

Locked branch type "major".

Merging Work

Because the MAJ team is not contributing to a baseline soon, it is not necessary to
merge work (and test the results) in a shared view. MAJ developers can continue
working in their own views.

Periodically, the project manager sends an excerpt from the findmerge log to an
individual developer, who executes the commands and monitors the results. (The
developer can send the resulting log files back to the project manager, as confirmation
of the merge activity.)

A merged version of an element includes changes from three development efforts:
Release 1.0 bug fixing, minor enhancements, and new features (Figure 54).
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Figure 54 Merging Baseline 1 Changes into the major Branch

The project manager verifies that no more merges are needed, by entering a findmerge
command with the –whynot option:

% cleartool findmerge /vobs/monet /vobs/libpub –fversion /main/LATEST –whynot
–print

.

.
No merge "/vobs/monet/src" [/main/major/4 already merged from /main/3]
No merge "/vobs/monet/src/opt.c" [/main/major/2 already merged from 
/main/12]

.

.

The merge period ends when the project manager removes the lock on the major
branch:
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% cleartool unlock brtype:major@/vobs/monet brtype:major@/vobs/libpub 
Unlocked branch type "major".
Unlocked branch type "major".

Creating Baseline 2

The MIN team is ready to freeze for Baseline 2, and the MAJ team will be soon
(Figure 55). Baseline 2 will integrate all three development efforts, thus requiring two
sets of merges:

■ Bug fix changes from the most recent patch release (versions labeled R1.0.2) must
be merged to the main branch.

■ New features must be merged from the major branch to the main branch. (This is
the opposite direction from the merges described in Merging Ongoing Development
Work on page 235.)

Figure 55 Baseline 2

Baseline
2

Release
1.0.2

Freeze

Freeze
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ClearCase supports merges from more than two directions, so both the bug fixes and
the new features can be merged to the main branch at the same time. In general,
though, it is easier to verify the results of two-way merges.

Merging from the r1_fix Branch

The first set of merges is almost identical to those described in Merging Two Branches on
page 233.

Preparing to Merge from the major Branch

After the integration of the r1_fix branch is completed, the project manager prepares to
manage the merges from the major branch. These merges are performed in a tightly
controlled environment, because the Baseline 2 milestone is approaching and the
major branch is to be abandoned.

Note: It is probably more realistic to build and verify the application, and then apply
version labels before proceeding to the next merge.

The project manager verifies that everything is checked in on both the main branch and
major branches:

% cleartool lscheckout –brtype main –recurse /vobs/monet /vobs/libpub
% cleartool lscheckout –brtype major –recurse /vobs/monet /vobs/libpub
% 

No output from these commands indicates that no element is checked out on either its
main branch or its major branch.

Next, the project manager determines which elements require merges:

% cleartool setview minor_vu (use any MIN team view)

% cleartool findmerge /vobs/monet /vobs/libpub –fversion .../major/LATEST –print
.
. <lots of output>
.

A 'findmerge' log has been written to
"findmerge.log.26-Feb-99.19:18:14"

All development on the major branch will stop after this baseline. Thus, the project
manager locks the major branch to all users, except those who are performing the
merges. Locking allows ClearCase to record the merges with a hyperlink of type
Merge:

% cleartool lock –nusers arb,david brtype:major@/vobs/monet
brtype:major@/vobs/libpub 
Locked branch type "major".
Locked branch type "major".
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Because the main branch will be used for Baseline 2 integration by a small group of
developers, the project manager asked vobadm to lock the main branch to everyone
else:

% cleartool lock –nusers meister,arb,david,sakai \
brtype:main@/vobs/monet brtype:main@/vobs/libpub 
Locked branch type "main".
Locked branch type "main".

(To lock the branch, you must be the branch creator, element owner, VOB owner, or root
user (UNIX) or a member of the ClearCase administrators group (Windows). See the lock
reference page.)

Merging from the major Branch

Because the main branch is the destination of the merges, developers work in a view
with the default config spec. The situation is similar to the one described in Preparing
to Merge on page 235. This time, the merges take place in the opposite direction, from
the major branch to the main branch. Accordingly, the findmerge command is very
similar:

% cleartool findmerge /vobs/monet /vobs/libpub –fversion /main/major/LATEST \
–merge –graphical

.

. <lots of output>

.
A 'findmerge' log has been written to
"findmerge.log.23-Mar-99.14:11:53"

After checkin, the version tree of a typical merged element appears as in Figure 56.
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Figure 56 Element Structure After the Pre-Baseline-2 Merge

Decommissioning the major Branch

After all data has been merged to the main branch, development on the major branch
will stop. The project manager enforces this policy by making the major branch
obsolete:

% cleartool lock –replace –obsolete brtype:major@/vobs/monet 
brtype:major@/vobs/libpub 
Locked branch type "major".
Locked branch type "major".

Integration and Test

Structurally, the Baseline 2 integration-and-test phase is identical to the one for
Baseline 1 (see Integration and Test on page 233). At the end of the integration period,
the project manager attaches version label R2_BL2 to the /main/LATEST version of each
element in the monet and libpub VOBs. (The Baseline 1 version label was R2_BL1.)
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Final Validation: Creating Release 2.0

Baseline 2 has been released internally, and further testing has found only minor bugs.
These bugs have been fixed by creating new versions on the main branch (Figure 57).

Figure 57 Final Test and Release

Before it is shipped to customers, the monet application goes through a validation
phase:

■ All editing, building, and testing is restricted to a single, shared view.

■ All builds are performed from sources with a particular version label (R2.0).

■ Only the project manager has permission to make changes involving that label.

■ All labels must be moved by hand.

■ Only high-priority bugs are fixed, using this procedure:

a The project manager authorizes a particular developer to fix the bug, by
granting her permission to create new versions (on the main branch).

b The developer’s checkin activity is tracked by a ClearCase trigger.

c After the bug is fixed, the project manager moves the R2.0 version label to the
fixed version and revokes the developer’s permission to create new versions.

Labeling Sources

In a view with the default config spec, the project manager creates the R2.0 label type
and locks it:

cleartool mklbtype –c "Release 2.0" R2.0@/vobs/monet R2.0@/vobs/libpub 
Created label type "R2.0".
Created label type "R2.0".

cleartool lock –nusers meister lbtype:R2.0@/vobs/monet lbtype:R2.0@/vobs/libpub 
Locked label type "R2.0".
Locked label type "R2.0".

The project manager labels the /main/LATEST versions throughout the entire monet and
libpub development trees:

Minor bugfixes Release
2.0

Baseline
2
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cleartool mklabel –recurse R2.0 /vobs/monet /vobs/libpub 
<many label messages> 

During the final test phase, the project manager moves the label forward, using
mklabel –replace, if any new versions are created.

Restricting Use of the main Branch

At this point, use of the main branch is restricted to a few users: those who performed
the merges and integration leading up to Baseline 2 (see Merging from the major Branch
on page 241). Now, the project manager asks vobadm to close down the main branch
to everyone except himself, meister:

% cleartool lock –replace –nusers meister brtype:main
Locked branch type "main".

The main branch is opened only for last-minute bug fixes (see Fixing a Final Bug on
page 245.)

Setting Up the Test View

The project manager creates a new shared view, r2_vu, that is configured with a
one-rule config spec:

% umask 2
% cleartool mkview –tag r2_vu /public/integrate_r2.vws
% cleartool edcs –tag r2_vu 

This is the config spec:

element * R2.0 

This config spec guarantees that only properly labeled versions are included in final
validation builds.

Setting Up the Trigger to Monitor Bug-fixing

The project manager places a trigger on all elements in the monet and libpub VOBs;
the trigger fires whenever a new version of any element is checked in. First, he creates
a script that sends mail (for an example script, see Notify Team Members of Relevant
Changes on page 182).

Then, he asks vobadm to create an all-element trigger type in the monet and libpub
VOBs, specifying the script as the trigger action:

% cleartool mktrtype –nc -element –all –postop checkin –brtype main \
–exec /public/scripts/notify_manager.sh \
r2_checkin@/vobs/monet r2_checkin@/vobs/libpub
Created trigger type "r2_checkin".
Created trigger type "r2_checkin".
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Only the VOB owner or root user (UNIX) or a member of the ClearCase administrators
group (Windows) can create trigger types.

Fixing a Final Bug

This section demonstrates the final validation environment in action. Developer arb
discovers a serious bug and requests permission to fix it. The project manager grants
her permission to create new versions on the main branch, by having vobadm enter
this command.

% cleartool lock –replace –nusers arb,meister brtype:main
Locked branch type "main".

arb fixes the bug in a view with the default config spec and tests the fix there. This
involves creating two new versions of element prs.c and one new version of element
opt.c. Each time arb uses the checkin command, the r2_checkin trigger sends mail to
the project manager. For example:

Subject: Checkin /vobs/monet/src/opt.c by arb
/vobs/monet/src/opt.c@@/main/9
Checked in by arb.

Comments:
fixed bug #459: made buffer larger

When regression tests verify that the bug has been fixed, the project manager revokes
arb’s permission to create new versions. Once again, the command is executed by
vobadm:

% cleartool lock –replace –nusers meister brtype:main
Locked branch type "main".

The project manager then moves the version labels to the new versions of prs.c and
opt.c, as indicated in the mail messages. For example:

% cleartool mklabel –replace R2.0 /vobs/monet/src/opt.c@@/main/9
Moved label "R2.0" on "prs.c" from version "/main/8" to "/main/9".

Rebuilding from Labels

After the labels have been moved, developers rebuild the monet application again, to
verify that a good build can be performed using only those versions labeled R2.0.

Wrapping Up

When the final build in the r2_vu passes the final test, Release 2.0 of monet is ready to
ship. After the distribution medium has been created from derived objects in the r2_vu,
the project manager asks the ClearCase administrator to clean up and prepare for the
next release:
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■ The ClearCase administrator removes the checkin triggers from all elements by
deleting the all-element trigger type:

cleartool rmtype trtype:r2_checkin@/vobs/monet
trtype:r2_checkin@/vobs/libpub 
Removed trigger type "r2_checkin".

Removed trigger type "r2_checkin".

■ The ClearCase administrator reopens the main branch:

cleartool unlock brtype:main
Unlocked branch type "main".
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AMoving from View
Profiles to UCM
This appendix compares view profile features with UCM features and describes how
to move a project from view profiles to UCM.

Product Note: View profiles are available only with Rational ClearCase on Windows.
Rational ClearCase LT does not support view profiles.

View Profiles and UCM

Base ClearCase includes a set of features called view profiles, which you can use to
automate much of the work required to set up and maintain your team’s shared
Rational ClearCase configuration. The Unified Change Management (UCM) process
provides a more complete solution for organizing software development teams. If you
currently use view profiles, you may want to move to UCM.

Feature Comparison

This section compares the features of view profiles and UCM.

Branches and Streams

In UCM, the project and its integration stream take the place of the view profile. Views
attached to the integration stream are configured to select the project’s shared
integration branch, just as a view profile’s config spec selects a shared common branch.

In view profiles, developers can work independently by setting up private branches for
development work. In UCM, team members join a project at which time they create
their own development work areas. A development work area consists of a
development stream and a development view.

Moving Work Among Branches or Streams

When working on a private branch in view profiles, there is no automated way to
incorporate changes from other developers onto the private branch. In UCM,
developers use the rebase operation to update their development work areas with the
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latest work delivered by other developers to the integration stream and incorporated
into a baseline.

In view profiles, developers finish a private branch when they complete a task.
Finishing a private branch closes that branch and merges work to the integration
branch, where it is merged with other sources. In UCM, activities record the versions
that you create to complete a development task as change sets. The deliver operation
moves activities from the development stream to the integration stream or a
feature-specific development stream. Your development stream remains in place after
a deliver operation, and you can continue to work in it.

VOBs and Components

View profiles contain a list of VOBs that hold project data. UCM projects organize
directory and file elements into components, and each stream keeps a list of
components.

Checkpoints and Baselines

View profiles capture stable configurations of a project with checkpoints, a set of
labeled versions. UCM uses baselines, which capture a set of versions per component.

Table 6 summarizes the key differences between view profiles and UCM features.

Table 6 View Profile Features and Their UCM Counterparts

View profile construct UCM counterpart

View profile Project and integration stream

Integration branch Integration stream

Private branch Development stream

Set up private branch Create a development stream/join
project

Finish private branch Deliver work to integration stream

Branch is closed when work is completed
and merged to integration branch.

Development stream is not closed after a
deliver operation.

No automated support for updating
private branch with work from other
developers.

Rebase operation adds changes from the
integration stream to private work area.

Views are configured with information
from profiles.

Views are configured with information
from streams.
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How to Move View Profile Information to UCM

This section presents some general guidelines on how to move projects from view
profiles to UCM.

Preparing Your View Profile Project

Before moving work to UCM, finish all private branches. Work on private branches
cannot be moved directly to a UCM project. After work has been merged into the
integration branch, create a checkpoint that labels all versions to be migrated to the
UCM project.

Moving the View Profile Information

1 Convert each VOB of the view profile project into a component.

2 For each component, import the label used for the checkpoint created in Step 1. By
importing a label, you are creating a new baseline for each component.

3 Create a UCM project, adding each baseline created in Step 2.

Members of the project team can now join the project, creating their own development
streams and views.

For more information about creating a UCM project, see Chapter 6, Setting Up the
Project.
A - Moving from View Profiles to UCM 249



250 Managing Software Projects



BClearCase-ClearQuest
Integrations
Rational ClearCase supports two integrations with Rational ClearQuest. This
appendix provides information that you need to manage both integrations in the same
development environment.

Understanding the ClearCase-ClearQuest Integrations

The integration of ClearQuest and ClearCase associates one or more ClearQuest
records with one or more ClearCase versions, allowing you to use features of each
product. ClearCase supports two separate integrations with ClearQuest:

■ The base ClearCase-ClearQuest integration
■ The UCM-ClearQuest integration

For information on setting up the base ClearCase-ClearQuest integration, see
Chapter 13, Setting Up the Base ClearCase-ClearQuest Integration. Note that this
integration cannot be used with UCM projects.

For more information on the UCM-ClearQuest integration, see Part 1 of this book.

In general, we recommend that you use the base ClearCase and UCM integrations
separately, and avoid using a common ClearQuest user database. However, it is
possible for both integrations to use the same ClearQuest user database. This can be
useful if you are moving a project to UCM and have a substantial amount of
information in a ClearQuest user database that was created with the base
ClearCase-ClearQuest integration. You may want the new work in UCM to be reflected
in new ClearQuest records in the same ClearQuest user database.

The remainder of this appendix discusses considerations in managing the coexistence
of the base ClearCase-ClearQuest integration and the UCM-ClearQuest integration.

Managing Coexisting Integrations

When a ClearQuest user database that had been integrated with ClearCase previously
is configured for integration with UCM, the existing change sets are preserved intact
in the ClearQuest user database, but cannot be migrated to the UCM integration.
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Change sets of existing records in the ClearQuest user database are preserved, and you
can access them from ClearQuest. To continue work on a task in a project that has been
migrated to UCM, create a new, corresponding, UCM activity and continue work there.

See Planning How to Use the UCM-ClearQuest Integration on page 47 for related
information.

Schema

A ClearQuest schema can contain modifications from both the base
ClearCase-ClearQuest integration and the UCM-ClearQuest integration. A record type
in such a schema would include both the ClearCase package and the Unified Change
Management package.

An individual record of that record type can store either ClearCase or UCM change set
information, but not both.

Presentation

The form for a record type that uses both integrations includes two tabs to show the
change set information associated with each integration, as shown in Figure 58. The
Unified Change Management tab lists the change set for a UCM activity. The ClearCase
tab shows the change set associated with a ClearQuest record.
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Figure 58 Change Sets in ClearQuest GUI
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CCustomizing
ClearCase Reports
This appendix explains how to customize ClearCase Reports. Specifically, it introduces
the ClearCase Reports Programming Interface and gives examples of how you can
customize the report procedures and the user interface. ClearCase Reports is available
only with the Windows versions of Rational ClearCase and Rational ClearCase LT.

How ClearCase Reports Works

ClearCase Reports consists of two parts:

■ The report procedures, which you can modify

■ The ClearCase Reports applications (Report Builder and Report Viewer), which
you cannot modify

The report procedures are hooks into the applications; they implement all the
operations necessary to generate and view a specific report. The applications collect
user input, interpret it, and run the appropriate report procedure. At run time,
ClearCase Reports executes as two applications: ClearCase Report Builder and
ClearCase Report Viewer. The Report Builder is used to select and define a report’s
parameters; the Report Viewer is used to view the report output.

All report procedures require an interface specification. This specification determines
the user interface information presented to users in the Report Builder and Report
Viewer. When users select a folder, the Report Builder scans the interface specification
of each report in the associated subdirectory and places the contents in a temporary
buffer. When users select a specific report, Report Builder extracts from this buffer the
interface information associated with the report that is displayed in the Report Builder
and Report Viewer. After users provide the required report parameters, the Report
Builder generates the report and passes the data to the Report Viewer.

The commands that the Report Builder uses include an -i option, which extracts the
interface specification from the report procedure. If the report procedure does not
include an interface specification or if the structure and contents of that specification
are not what the Report Builder expects, report processing stops.
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For more information on the processing sequence between the ClearCase Reports
applications and the report procedures, see Run-Time Processing Sequence for Reports
Programming Interface on page 257

What You Can Customize in ClearCase Reports

The ClearCase programming interface enables you to customize four parts of the
Report Builder user interface and two parts of the Report Viewer. You can customize
by adding, changing, or removing information for the annotated areas of the Report
Builder (Figure 59):

■ Area 1. The name of the folders in the tree pane.
■ Area 2. The directory organization displayed in the tree pane.
■ Area 3. The report description.
■ Area 4. The report parameters

Figure 59 Customizable Areas of Report Builder Interface

You can customize by adding, changing, or removing information for the annotated
areas of the Report Viewer (Figure 60).

2

1
3

4
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■ Area 1. The position of a column heading can be moved, a column heading name
can be added, modified, or deleted and a default sort order can be added or
removed from any column heading.

■ Area 2. The commands on the shortcut menu.

Figure 60 Customizable Interface for Report Viewer Window

For programming examples that demonstrate how you can make these
customizations, see Report Programming Examples on page 274.

Run-Time Processing Sequence for Reports Programming Interface

Before you begin to customize report procedures, it is important to understand the
run-time processing flow for Report Builder and Report Viewer. Processing occurs in
three phases.

In phase 1, the user opens one of the subfolders in the Reports folder. The Report
Builder processes the interface specification of all report procedures associated with
the reports in that subfolder and presents the description of each report in the reports
pane of the Report Builder. The parameters associated with the first report listed

1

2
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appear in the parameters pane. This processing is done with the command that uses
the -i option.

In phase 2, the user selects a report in the reports pane. The Report Builder populates
the parameters pane with the parameters required for that report. When the user clicks
a parameter, the associated parameter chooser prompts the user to provide a value.
When all parameters have values, the user can run the report. (The Run Report button
is not available until all parameters have values.)

In phase 3, the report is generated. A command line, whose parameters are defined in
the interface specification, is passed to the Report Viewer, with the parameter values.
The Report Viewer runs the report procedure and uses either cleartool or the
ClearCase Automation Library (CAL) interface to retrieve information from the VOB.
The report procedure returns the information to the Report Viewer, which sorts,
formats, and displays it. The right-click behavior for all rows in the report (as defined
in the interface specification) is now enabled, and the user can also manipulate the
report data.

Figure 61 illustrates this processing sequence.
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Figure 61 Run-Time Processing Sequence

To execute these processing steps correctly, a report procedure must meet the following
requirements:
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■ The directory that contains the report procedure must be found at known location.
The Report Builder reads the \reports\scripts directory to determine the report
procedure file names, which it calls when a user clicks the associated directory
folder.

■ The report procedure must have a valid interface specification. If the expected
format is not present, the report will not run.

■ The interface specification in the report procedure must use parameters and
choosers supplied by ClearCase Reports. See Parameters Supplied with ClearCase
Reports on page 265.

■ The report procedure must support a command line interface that the Report
Viewer can use to pass user-defined parameter values to the report procedure.

Configuring Shared Report Directories

When ClearCase is installed on the client, the files for ClearCase Reports are installed
in ccase-home-dir\reports. Before you modify the contents of this directory, create a copy
of it in a shared location. You can then delete or rename folders and add or modify
report procedures.

To create the copy, do one of the following:

■ Copy the files to a new directory.

■ Place a copy of the files under source control and create a ClearCase view to serve
as the shared location.

We recommend that you place the copy of the report procedures under source control.

You must remove the .dll and .exe files from the customization directory. The
subdirectories for \scripts,\script_tools, and \scripts_rightclick must be present. The \scripts

directory becomes the root node Reports in the Report Builder tree pane; you can
modify this directory tree. We recommend that you do not delete any files that are in
\script_tools and \scripts_rightclick; you may add your own, of course.

The help file used by the reports cannot be modified and is not included in the \reports

directory. The help file for ClearCase Reports is located in
ccase-home-dir\bin\cc_reports.hlp.

Adding Report Procedures to Source Control

To place a copy of ccase-home-dir\reports under source control:

1 Copy all files to a temporary directory.

2 In the temporary directory, enter a command of this form:
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clearexport_ffile -o name-of-data-file

3 In the \reports directory in an existing VOB, enter a command of this form:

clearimport -verbose -directory \reports\name-of-data-file

4 Create a dynamic or snapshot view for the ClearCase reports data that is now
under source control.

Setting the Report Builder to the Customized Directory

After you have copied the installed files for ClearCase Reports from
ccase-home-dir\reports to a shared directory location, you can set Report Builder to use
this location:

1 In the Report Builder window, click Report > Set Scripts Location to open the
Configure Reports Directory dialog box.

2 In the dialog box, do one of the following:

❑ Type the directory path for the customized directory in the text box.
❑ Click ... to open the Browse for scripts location dialog box to select a directory

location.

Note: After changing the ClearCase Reports user interface, you must restart Report
Builder to activate the changes.

Default Directory Structure for ClearCase Reports

All files for ClearCase Reports are stored in ccase-home-dir\reports. This is the directory
structure:

reports\
ccreportbuilder.exe
ccreportviewer.exe
cctypechooser.dll
ccpathchooser.dll
scripts\

ClearCase_Tools\
Elements\

Attributes\
Branches\
Labels\
Triggers\

UCM_Projects\
UCM_Streams\
Views\
VOBs\

scripts_rightclick\
script_tools\
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Populating the Report Builder Tree Pane

As Figure 62 shows, the Report Builder window contains three panes: the left pane is
the tree pane, the top-right pane is the reports pane, and the bottom-right pane is the
parameter pane. When the user clicks any folder in the tree pane, the Report Builder
runs the associated report procedures from the command line. The -i option in the
command line enables the Report Builder to use a discovery algorithm to collect the
user interface information for Report Builder.

Figure 62 Report Builder User Interface

The Report Builder “walks” through the \scripts subdirectory. Directories in the tree
appear as folders in the tree pane. Any files whose extensions match those listed below
are listed in the reports pane.

.exe Typically a Visual C++ application that uses ClearCase Automation Library
(CAL) to extract data
262 Managing Software Projects



All other files are ignored. The file name extension of report procedures supplied with
ClearCase Reports is .prl, which the Report Builder associates with ccperl.exe.

At run time, the Report Builder displays all folder names, substituting a space for the
underscore and dropping the file name extension. There is one exception: the root
directory is always named Reports. This convention cannot be changed.

For example, for this on-disk directory tree

scripts\
Admin_Reports

view_aging.prl
all_views.prl

UCM_Reports\
lagging_streams.prl
completed_acts.prl

the Report Builder displays text in the tree pane as

\Reports
Admin Reports\
UCM Reports\

Report Procedure Interface Specifications

As the Report Builder finds report procedures in the customized directory, it queries
each report procedure for its interface specification. It does this by starting a separate
process with CreateProcess(). A valid report procedure must implement an interface
specification and return formatted text to STDOUT that conforms to this specification:

description : ["<text to display in description pane for this report>"]

id : <numeric help id>

helpfile : ["<full path to user-written help file for what’s this 
report help>"]

parameters : [<parameter_spec_1>] [<parameter_spec_2>] ... 
[<parameter_spec_N>]

rightclick : [<rightclick_spec_1>] [<rightclick_spec_2>] ... 
[<rightclick_spec_N>]

fields : [<field_spec_1>] [<field_spec_2> ... [<field_spec_N>]

.pl Perl, executed under perl.exe from user’s PATH environment variable, for
example, ActiveState Perl

.prl ccperl

.js JavaScript, run under Windows Scripting Host (cscript.exe)

.vbs VBScript, run under Windows Scripting Host (cscript.exe)
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If a serious parsing error occurs in processing the interface specification, the report
does not appear in the reports pane. The helpfile specification is reserved for future
use and is not supported in this release. For information on troubleshooting parsing
errors, see Troubleshooting on page 294.

The examples in the following sections show how the interface specification is defined
in specific report procedures.

Interface Specification for All_Views.prl

The Report Builder uses this command to run All_Views.prl:

ccperl "D:\Program
Files\Rational\Clearcase\Reports\scripts\Views\All_Views.prl" -i

This is the interface specification:

description : "All Views"
id : 2001
helpfile :
parameters :
rightclick : Properties_of_View(single)
fields : "View Tag"(view_tag, rightclick, initial_width 30, sort 1) 
"View Owner"(user_dq) 

The report interface attaches the Report Viewer to the View Tag and View Owner
fields; the right-click event in the Report Viewer window calls Properties
_of_View.prl, which is based on a data stream from the View Tag field.

Description Specification

The description is the only required part of an interface specification. When only
description is defined, a report procedure can run other graphical user interfaces (for
example, clearprompt) or otherwise interact with the user. The reports in the
\ClearCase_Tools folder define description only.

Descriptions can contain anything other than the delimiter, a double quote (“). There is
no maximum length for this definition, but long strings do not wrap in the reports
pane.

Help ID Specification

Help IDs for the description and parameter fields are supplied for the Report Builder
user interface. The help id specification is the ID that supports context-sensitive help
for the description or parameter fields in the Report Builder user interface. The IDs are
integers in the following range:

0-999 Context help for parameters
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The help file for ClearCase Reports is ccase-home-dir\bin\cc_reports.hlp. The help IDs for
the parameter and description fields are included in this file. In this version of
ClearCase Reports, you cannot add an ID for your own report.

Parameters Specification

When specifying parameters, you can use only those supplied with ClearCase Reports.
Each parameter has an associated chooser control, parameter text, and a help ID
(Table 7). When you use one of these parameters, naming it is all that is required. For
example, this is the parameters specification for the Elements Changed Between Two
Labels report:

parameters : LOOKIN LABEL LABEL

The order of parameters is important. They are displayed in the parameter pane in the
order of the specification. (Each parameter appears as a link; when users click the link,
they are prompted to enter a parameter value.) At run time, the Report Viewer calls the
report procedure, which must handle the parameter values in the same order as
defined in the specification.

The parameters in Table 7 that are associated with the Type Chooser must also include
the LOOKIN parameter in the interface specification. The LOOKIN parameter must
have a value before any values for other parameters that use the Type Chooser can be
specified. The paths that are the values for the LOOKIN parameter are used to build
the set of VOBs that types can be read from. At run time, if a user attempts to set a type
parameter in reverse order, the Report Builder displays this error message:

Before this parameter can be set, you must first set a value for the 

“Select pathnames in view to report on” parameter.

2000-2999 Context help for report descriptions

Table 7 Parameters Supplied with ClearCase Reports (Part 1 of 3)

Parameter
Default text displayed in
the parameter pane

Help
ID

Chooser Selection

PROJECTS Select projects in UCM
Process VOB

1 Path (UCM) Multiple

STREAMS Select streams in UCM
Process VOB

2 Path (UCM) Multiple

ACTIVITIES Select activities in UCM
Process VOB

3 Path (UCM) Multiple
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PROJECT Select project in UCM
Process VOB

4 Path (UCM) Single

STREAM Select stream in UCM
Process VOB

5 Path (UCM) Single

ACTIVITY Select activity in UCM
Process VOB

6 Path (UCM) Single

ISTREAM Select Integration Stream
in UCM Process VOB

7 Path (UCM) Single

PVOB Select one Process VOB
Tag

8 Path (file
selection)

Single

COMPONENT Type a single UCM
component object selector
(no verification
performed)

9 Text Single

BASELEVEL Type a single UCM
baseline object selector
(no verification
performed)

10 Text Single

ISTREAMS Select Integration
Streams in UCM Process
VOB

11 Path (UCM) Multiple

PVOBS Select Process VOBs Tags 12 Path (file
selection)

Multiple

COMPONENT
S

Type a list of UCM
components object
selectors (no verification
performed)

13 Text Multiple

BASELEVELS Type a list of UCM
baselines object selectors
(no verification
performed)

14 Text Multiple

LOOKIN Select pathnames in view
to report on

15 Path (file
selection)

Multiple

Table 7 Parameters Supplied with ClearCase Reports (Part 2 of 3)

Parameter
Default text displayed in
the parameter pane

Help
ID

Chooser Selection
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Rightclick Specification

The rightclick specification is a list of commands available on the shortcut menu in the
Report Viewer. All right-click events are supported by a list of scripts in the
\scripts_rightclick directory. This specification allows you to control the text on the
shortcut menu. At run time, underscores in these text strings are replaced by spaces.

USER Associated with user
(values are
non-domain-qualified)

17 Text Single

GROUP Associated with group
(values are
non-domain-qualified)

18 Text Single

LABEL With label 19 Type Single

ATTRIBUTE With attribute 20 Type Single

ATTRIBUTE_V
ALUE

With value for attribute 21 Text Single

TRIGGER With trigger 22 Type Single

BRANCH With branch 23 Type Single

ELTYPE With element type 24 Text Single

HLTYPE With hyperlink type 25 Type Single

CCTIME Since date/time 26 Date/time Single

BRANCHLEV
ELS

With integer levels of
branching

27 Text Single

FILE_NAME With filename 28 Text Single

PATH Enter pathname 29 Text Single

STRING With string 30 Text Single

INTEGER Enter integer 31 Text Single

REGULAR_
EXPRESSION

Enter regular expression 32 Text Single

Table 7 Parameters Supplied with ClearCase Reports (Part 3 of 3)

Parameter
Default text displayed in
the parameter pane

Help
ID

Chooser Selection
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rightclick : properties_of_view delete_view

By default, the commands are valid for both single and multiple selections of result
records in the Report Viewer. This behavior can be controlled by using the single
modifier:

rightclick : properties_of_view(single) delete_view(single) 

A special string, sep, allows visual separators to group commands. At run time, these
commands appear on the shortcut menu in the order specified.

Fields Specification

The fields specification defines the names of the field headings and a number of
modifiers to describe the results a report procedure returns to the Report Viewer.
Table 8 describes the supported modifiers.

For example, the following fields specification describes a single field with the
minimum specification allowed. The field_type modifier is required.

fields: "view tag"(view_tag)

Table 8 Fields Modifiers

Modifier Description

sort N Optional. Specifies the sort order for
returned records. If specified, this
modifier must be a sequence of integers
that begin with 1. If no sort specification is
made, the records remain in the same
order as returned from the report
procedure.

Inital_width N Optional. Overrides the default width for
the field.

<field_type> Required.

hidden Optional. Prevents display of values for
this field in the Report Viewer. If this
modifier is used, there is usually an
associated sort N modifier for the field.

rightclick Optional. The field value stream that is
sent where any right-click action occurs in
the Report Viewer. Only one field can be
designated as the rightclick field.
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In this example, the fields specification defines two fields, view tag and last mod time,
with all the allowable modifiers:

fields: "view tag"(view_tag, rightclick, initial_width 10) "last mod 
time"(time_t, hidden, sort 1)

field_type Conventions

Table 9 lists the names for field_types and the kind of data represented. We encourage
you to use these definitions in your own report procedures wherever possible, but you
can use your own definitions.

Depending on the column width required to display for a user-defined field_type, the
fields specification in a report procedure may need to adjust the display column size
with the Inital_width N modifier.

Table 9 Field Type Supplied with ClearCase Reports (Part 1 of 2)

Field name Data description Example

project UCM Project headline
name

V4.1

project_objsel UCM project object selector Project:v4.1@\projects

stream UCM Stream headline
name

George_v4.1

stream_objsel UCM Stream object
selector

George_v4.1@\projects

activity UCM Activity headline
name

My activity

activity_objsel UCM Activity object
selector

Activity:my_act@\projects

view_tag View-tag such as returned
by lsview

main_latest_view

time_t Integer ticks since
1/1/1970

946934277

cctime Readable time, format is
%dfmt_ccase

20-Dec-99.16:01:12

User User name georgem

User_dq Domain-qualified user
name

rational\georgem
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Parameter Choosers

When a user opens a folder in the Report Builder tree pane, the reports pane is
populated with the list of descriptions that the Report Builder discovered in the
interface specification. When the user selects a report, the associated parameters are

string Random text hello world

Host Host name georgemnt

Hpath Local machine path to
view/VOB directory

D:\ClearCase_Storage\vie
ws\jet

View_sttrs View attributes snapshot, ucmview

Element_xpn Full path to element ending
in @@

S:\frontpage\accts\web\
photo.htm@@

Element_pn Full path to element
without @@

S:\frontpage\accts\web\
photo.htm

Version_pn Version specifier, after @@ \main\v4.0.bl5_main\2

label Label instance name V4.0

Integer Integer number 5

Yes_no yes or no enumerated
string

Yes

Branch_xpn Full path to branch S:\frontpage\accts\web\
photo.htm@@\main

version_xpn Full path to version S:\frontpage\accts\web\
photo.htm@@\main\3

branch Branch name main

Attribute Attribute name normalize_html

Objsel Object selector VOB:\my_vob

Trigger Trigger name post_ci

Eltype Element type text_file

Vob_tag VOB Tag \projects

Table 9 Field Type Supplied with ClearCase Reports (Part 2 of 2)

Field name Data description Example
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loaded in the Report Builder. Each parameter in the interface specification has
associated parameter text, a help ID, and a chooser. All parameters have an associated
chooser (Table 7).

These choosers are supplied with ClearCase Reports:

■ Path Chooser
■ UCM Targets Chooser
■ Types Chooser
■ Date/Time Chooser
■ Text Chooser

For user information, click Help in any chooser dialog box.

Path Chooser

The Path Chooser is associated with the LOOKIN parameter. It presents a list of view
pathnames for users to select, and then sends the selected pathnames to the report
procedure. It is also used for the PVOB and PVOBS parameters to choose the VOB-tag
of a UCM project VOB.

UCM Targets Chooser

The UCM Targets Chooser is associated with the PROJECT, PROJECTS, STREAM,
STREAMS, ACTIVITY, ACTIVITIES, ISTREAM, and ISTREAMS parameters and
allows you to select UCM objects.

Type Chooser

The Type Chooser presents values for the BRANCH, ATTRIBUTE, LABEL,
HYPERLINK, and TRIGGER parameters. All parameters that the Type Chooser
supports require an initial value LOOKIN parameter.

Date/Time Chooser

The Date/Time Chooser is used to select date/time values for the CCTIME parameter.

Text Chooser

The Text Chooser presents values for these parameters: COMPONENT,
COMPONENTS, BASELINE, BASELINES, USER, GROUP, ATTRIBUTE_VALUE,
ELTYPE, BRANCHLEVELS, FILE_NAME, PATH, STRING, INTEGER, and
REGULAR_EXPRESSION.
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Data typed into the Text Chooser is not validated or parsed in any way by the Report
Builder or Report Viewer. The report procedure that accepts the parameter value must
perform any validation required.

For most parameters, the text above the text box is Enter value for user. For parameters
that require the name of a baseline, a component, or an element type, the text changes
to reflect the parameter. For example: Enter value for baseline.

Viewing the Report

When all required parameters have values, clicking Run Report opens the Report
Viewer window (Figure 63). The Report Builder creates a command line to pass the
user-defined parameters, in the order defined by interface specification. For example,
if a report procedure asks for parameters LOOKIN LABEL, the Report Viewer passes
these values as follows:

ccperl elements_with_label.prl %LOOKIN='s:\frontpage\acctst';%LABEL=V4.0;

The Report Viewer creates a process to run the report procedure using ccperl.exe for
.prl, perl for .pl, cscript.exe for .js and .vbs, and default activation for .exe. The report
procedure returns results to STDOUT. The results are separated by semicolons, in the
same order, number, and type specified in the fields definition in the interface
specification.

When the report procedure has collected all its data, it exits. The report procedure must
return records to STDOUT in the most efficient manner possible; the Report Viewer
sorts the results and formats them for display. At run time, users can change the
default sorting order by clicking the column headings in the Report Viewer. Simple text
sorting is used for all fields except those whose field_type is time_t, integer, or cctime.
For these three fields only, Report Viewer uses numeric sorting.
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Figure 63 Report Viewer Window

Saving Report Data

Clicking Save As in the Report Viewer window opens a standard file selection dialog
box to prompt the user to save the results in one of the following output formats:

Saving the file is performed by the save_results.prl script in \script_tools. This script
supports two switches, -html and -csv, and the header, followed by
semicolon-separated data rows. This script also needs a pathname value for the -out
option, where pathname is the value that the Report Viewer passes from the Path
Chooser.

XML output is supported directly by the Report Viewer. You can reimplement the
.CSV and .HTML output by modifying save_result.prl. You can also define additional

.CSV Comma-separated, for import into Access or Excel

.HTML For viewing in a Web browser

.XML For viewing in Internet Explorer 5 using XSL style sheets
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XSL style sheets that can be referred to in XML output. We recommend that you start
with the style sheet supplied with ClearCase Reports (\script_tools\table.xsl) to create
customized XSL files.

Report Programming Examples

All report procedures supplied with ClearCase Reports are written in ccperl. The
programming examples presented in this section are modifications of these report
procedures. Report procedures can be written in many other scripts and programming
languages; report procedures that use other programming languages are available
from the ClearCase Customer Web site at
http://www.rational.com/support/downloadcenter/addins/clearcase/contrib/index.jsp in the
T0046 package. The following programming examples are presented in this section:

■ Example 1: Adding a new column to the report for Versions_byDate.prl.

■ Example 2: Changing the directory organization and report description, modifying
the version path to a use different field name, and adding an element type column
to report output for Elements_with_New_Versions_Since_Date.prl.

■ Example 3: Changing the report description, parameter types, and report output
for Elements_Created_by_User.prl.

■ Example 4: Changing the order of commands and adding a command to the
shortcut menu for Element_with_Labels.prl.

■ Example 5: Adding a user-defined command to the shortcut menu for
Element_with_Branches.prl.

In the source code listings that accompany each example, the string ### 

customization change marks the changes to the original report that accomplish the
task.

Example 1: Adding a Column to Report Output

The Versions by Date report lists all versions that exist for the pathname that the user
specified. This report includes the following columns:

■ Version Path
■ Version Creation Time

The change to this report adds a column that lists the user name associated with each
version. The report procedure is located in
ccase-home-dir\Reports\Scripts\Elements\Versions_by_Date.prl
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Processing Logic

The processing logic of Versions_by_Date.prl is as follows:

1 The LOOKIN parameter, which is the sole parameter for this function, is received
in a string of this form:

LOOKIN = "<path1> [<path2> ...]"

This parameter specifies the list of paths with which the cleartool find command
is to be invoked.

2 The routine, when invoked, extracts the paths from the LOOKIN string and passes
them to the check_lookin() routine (located in common_script.prl).

3 check_lookin() then puts the paths into the global variable $ctfind_paths,
enclosing each path in double quotes; it also performs simple validations on the
paths received.

4 The report procedure calls cleartool lshistory, passing $ctfind_paths as the paths
parameter, and with a -fmt parameter to return the necessary information.

5 The report procedure executes a print statement with parameters (that is, the items
to print) of the same number and order as the list passed during interface
specification processing. The Report Builder has the information required to set up
the column headings; the report procedure must conform to this specification to
print its output.

Interface Specification

This is the existing interface specification for Versions_by_Date.prl:

if (/^-i/) {
print "description : 'Versions by Date'\n";
print "id : 2018\n";
print "helpfile :\n";
print "parameters : ";
print "LOOKIN ";
print "\n";
print_version_rightclick();
print "fields : ";
print "\"Version Path\”(version_xpn, rightclick, sort 2) ";
print "\"Version Creation Time\"(cctime) ";
print "\"Version Creation Time\"(time_t, sort 1, hidden) ";
print "\n";
exit(0);

}
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Changes Required

To add an additional column of report output:

1 Add a properly coded print statement to the interface specification that the Report
Builder can pass to the Report Viewer.

2 Add a %Fu; to the -fmt parameter in the cleartool lshist call, to get this
information from ClearCase.

3 Properly extract the user information into some variable after the cleartool lshist
call returns its output, so that it can be printed.

4 Print the user variable in the same order as it appeared in the interface
specification so that it appears under the correct column heading.

Modified Report Procedure

Here is the modified version of Versions_by_Date.prl. This report procedure is
example1.prl in the T0046 package, which is available at
http://www.rational.com/support/downloadcenter/addins/clearcase/contrib/index.jsp.

$start_dir = $0; $start_dir =~ s/\\scripts\\.*/\\scripts/;
$common_dir = $start_dir;
$common_dir =~ s/(.*)\\scripts/$1\\script_tools/;

$cc = ""; if ($cc) {;};
$ct = ""; if ($ct) {;};
$debug = ""; if ($debug) {;};
$skip_path_checks = ""; if ($skip_path_checks) {;};
$CLEARCASE_XN_SFX = ""; if ($CLEARCASE_XN_SFX) {;};
$ctfind_paths = ""; if ($ctfind_paths) {;};
$skip_path_checks = "yes"; if ($skip_path_checks) {;};
$debug = "no"; if ($debug) {;};

sub do_exit {
$err = join(" ", @_);
if ("$err" != "") {

print STDERR "$err\n";
}
sleep(2);
if ("$err" != "") {

exit(1);
} else {
exit(0);

}
}

open(INCLUDE, "<$common_dir\\common_script.prl") or do_exit("error 
opening include file '$common_dir\\common.prl'"); 
$buf = "";
while(<INCLUDE>) {

$buf = $buf . $_;
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}
close(INCLUDE);
eval $buf || do_exit("error on eval of include file 
'$common_dir\\common.prl'"); 

my $args = $ARGV[0];
$args =~ s/%/ /g;
@args = split(";", $args);
$required_args = 0;
foreach(@args) {

s/^[ ]+//;
s/[ ]+$//;
validate_arg_length($_);
if (/^-i/) {

print "description : 'Versions by Date'\n";
print "id : 2018\n";
print "helpfile :\n";
print "parameters : ";
print "LOOKIN ";
print "\n";
print_version_rightclick();
print "fields : ";

print "\"Version Path\"(version_xpn, rightclick, sort 
2) ";

print "\"Version Creation Time\"(cctime) ";
print "\"Version Creation Time\"(time_t, sort 1, 

hidden) ";
### customization change *** added following line

print "\"User'(user) ";
print "\n";
exit(0);

}
if (/^LOOKIN[ ]*=[ ]*('.*')/) {

check_lookin($1);
$required_args++;
next;

}
print STDERR "unrecognized argument: $_\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");
}
if ($required_args != 1) {

print STDERR "usage: not all required arguments specified.\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");

}
$ENV{"d;"} = "‰d;‰";
open(CTHIST, "cleartool lshist -fmt '%d;%e;%n\\n' -recurse -nco 
$ctfind_paths |");
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while(<CTHIST>) {
chomp;
if (/create directory version/ || /create version/) {

($date, $event, $xpn) = split  /;/, $_, 3;
if ($date) {;}
if ($event) {;}
if ($xpn) {;}
$timet = time_to_ticks($date);

### customization change *** added following line
$user = ‘cleartool desc -fmt '%Fu' '$xpn'‘;

### customization change *** added ";$user" to following line
print "$xpn;$date;$timet;$user\n";

}
}
do_exit();

Example 2: Changing Report Directory Organization, Report Description,
and Report Output

The Elements with New Versions Since Date report lists all new versions for the
pathname and since the date and time specified by the user. This report includes the
following columns:

■ Element Path
■ Version Path
■ Version Creation Time

The changes to the report procedure do the following:

■ Display in the Report Builder tree pane a new directory named
ccase-home-dir\Reports\Scripts\Elements\New_Versions directory.

■ Display a new report description: Types of Elements with New Versions Since
Date.

■ Display the version path information in the version_xpn field in a different format.

■ Add a column in the report output to display a new column for Element Type.

The report procedure is located in
ccase-home-dir\Reports\Scripts\Elements\Elements_with_New_Versions_Since_Date.prl.

Processing Logic

The processing logic of Elements_with_New_Versions_Since_Date.prl is as follows:

1 When the Report Builder processes the interface specification, the report
procedure yields two parameters:

LOOKIN
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CCTIME

The mechanics of the LOOKIN parameter are described in Example 1: Adding a
Column to Report Output. When the report procedure receives CCTIME, it is a
string of this form:

CCTIME = "time"

This parameter specifies the times that the cleartool find command uses.

2 When the report procedure is invoked by the Report Viewer using a fully qualified
command line, it extracts the values from the CCTIME string and passes them to
the chooser_time_to_cctime() subroutine (located in common.prl). This routine
converts the string to the correct format (for passing to cleartool) and returns it.

3 The report procedure opens a pipe from a cleartool find -print command, with the
converted cctime value passed in as a created_since(<cctime>) string.
created_since is a query_language(1) predicate, which is frequently used in
conjunction with the find command.

4 As the values from the cleartool find are returned, the report procedure calls
cleartool describe on the output to get the version-creation time. The routine calls
the time_to_ticks() routine (in common.prl) to get the time equivalent in ticks.

5 The report procedure gets the path and version ID from the cleartool find output,
splitting it on the value of the $CLEARCASE_XN_SFX extended naming symbol
for the host. Finally, the report procedure prints the information in the same order
as defined in the interface specification.

Interface Specification

This is the existing interface specification for
Elements_with_New_Versions_Since_Date.prl:

if (/^-i/) {
print "description : 'Elements with New Versions Since Date'\n";
print "id : 2017\n";
print "helpfile :\n";
print "parameters : ";
print "LOOKIN CCTIME";
print "\n";
print_element_rightclick();
print "fields : ";
print "\"Element Path\"(element_pn, sort 2, rightclick) ";
print "\"Version Path\"(version_pn) ";
print "\"Version Creation Time\"(cctime) ";
print "\"Version Creation Time\"(time_t, hidden, sort 1) ";
print "\n";
exit(0);

}
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Changes Required

To change the directory organization and report description, to modify the version
path to use a different field name, and to add an element type column to the report
output:

1 Create a new folder, New_Versions, and move the report procedure there.

2 Add a properly coded print statement to the interface specification that does the
following:

❑ Specifies how to display the report description information in the Report
Builder

❑ Specifies how to display the report in the Report Viewer

3 Add additional processing to the cleartool find output as required to get the
desired information for element type.

4 Properly extract the new information for element type into a variable.

5 Print the new information in the proper position so that it appears under the
correct column heading.

Modified Report Procedure

Here is the modified version of Elements_with_New_Versions_Since_Date.prl. This
report procedure is example2.prl in the T0046 package, which is available at
http://www.rational.com/support/downloadcenter/addins/clearcase/contrib/index.jsp.

$start_dir = $0; $start_dir =~ s/\\scripts\\.*/\\scripts/;
$common_dir = $start_dir;
$common_dir =~ s/(.*)\\scripts/$1\\script_tools/;

$cc = ""; if ($cc) {;};
$ct = ""; if ($ct) {;};
$debug = ""; if ($debug) {;};
$skip_path_checks = ""; if ($skip_path_checks) {;};
$CLEARCASE_XN_SFX = ""; if ($CLEARCASE_XN_SFX) {;};
$ctfind_paths = ""; if ($ctfind_paths) {;};
$skip_path_checks = "yes"; if ($skip_path_checks) {;};
$debug = "no"; if ($debug) {;};

sub do_exit {
$err = join(" ", @_);
if ("$err" != "") {

print STDERR "$err\n";
}
sleep(2);
if ("$err" != "") {

exit(1);
} else {
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exit(0);
}
}
open(INCLUDE, "<$common_dir\\common_script.prl") or do_exit("error 
opening include file '$common_dir\\common.prl'"); 
$buf = "";
while(<INCLUDE>) {

$buf = $buf . $_;
}
close(INCLUDE);
eval $buf || do_exit("error on eval of include file 
'$common_dir\\common.prl'"); 

my $args = $ARGV[0];
$args =~ s/%/ /g;
@args = split(";", $args);
my $cctime = "";
$required_args = 0;
foreach(@args) {

s/^[ ]+//;
s/[ ]+$//;
validate_arg_length($_);
if (/^-i/) {

### customization change *** changed following line
print "description : 'Types of Elements with New Versions 

Since
Date'\n";
print "id : 2017\n";
print "helpfile :\n";
print "parameters : ";

print "LOOKIN CCTIME";
print "\n";
print_element_rightclick();
print "fields : ";

print "\"Element Path\"(element_pn, sort 2, 
rightclick) ";
### customization change *** changed following line

print "\"Version Path\"(version_xpn) ";
print "\"Version Creation Time\"(cctime) ";
print "\"Version Creation Time\"(time_t, hidden, sort 

1) ";
### customization change *** added following line

print "\"Element Type\"(eltype) ";
print "\n";
exit(0);

}
if (/^LOOKIN[ ]*=[ ]*('.*')/) {

check_lookin($1);
$required_args++;
next;

}
if (/^CCTIME[ ]*=[ ]*'*([^']*)'*/)  {
$cctime = chooser_time_to_cctime($1);
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$required_args++;
next;
}
print STDERR "unrecognized argument: $_\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");

}
if ($required_args != 2) {

print STDERR "usage: not all required arguments specified.\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");

}
open(CTFIND, "cleartool find $ctfind_paths -version 
'created_since($cctime)' -print |");
while(<CTFIND>) {

chomp;
if (/CHECKEDOUT/) {next;}
$vertime = ‘cleartool desc -fmt '%d' '$_'‘;

### customization change *** added following line
$eltype = ‘cleartool desc -fmt '%[type]p' '$_'‘;
$vertime_t = time_to_ticks($vertime);
($path, $verid) = split $CLEARCASE_XN_SFX, $_, 2;

### customization change *** changed following line
print "$_;$verid;$vertime;$vertime_t;$eltype\n";
#print "$path;$verid;$vertime;$vertime_t\n";

}
do_exit();

Example 3: Changing Report Description, Parameter Types, and Report
Output

The Elements Created by User report lists all elements created by the user-defined user
name. This report includes the following columns:

■ Element Path
■ Creating User

The changes to this report do the following:

■ Display a new report description: Elements with Group.

■ Remove the existing user parameter and add a new parameters for group.

■ Compare the group associated with an element with the group specified in a
user-defined group parameter.

■ Add a column in the report output for Group and Yes/No. The Yes/No column will
reflect the result of the comparing whether the group associated with each element
is the same as the value of the user-defined group parameter.
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The script is located in
ccase-home-dir\Reports\Scripts\Elements\Elements_Created_by_User.prl.

Processing Logic

The processing logic of Elements_Created_by_User.prl is as follows:

1 When the Report Builder processes the interface specification, the report
procedure yields two parameters:

LOOKIN

USER

The mechanics of the LOOKIN parameter are described in Example 1: Adding a
Column to Report Output on page 274. The report procedure receives USER as a
string of this form:

USER= "user-name"

This parameter specifies the user name that the cleartool subcommand uses.

2 The USER string is extracted and stored as $ccuser. It is then passed to the
created_by($ccuser).

3 The created_by ($ccuser) query language primitive filters the paths specified to
cleartool find and returns only those that match the predicate, in this case, those
created by the user by setting a parameter value for USER.

4 The user variable is printed in the same order specified in the interface
specification so that it appears under the correct column heading.

Interface Specification

This is the existing interface specification for Elements_Created_by_User.prl:

if (/^-i/) {
print "description : 'Elements Created by User'\n";
print "id : 2016\n";
print "helpfile :\n";
print "parameters : ";
print "LOOKIN USER";
print "\n";
print_element_rightclick();
print "fields : ";
print "\"Element Path\"(element_xpn, sort 2, rightclick) ";
print "\"Creating User\"(user, sort 1) ";
print "\n";
exit(0);

}
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Changes Required

To remove the user parameter, to add parameters for group and date/time, and to
adjust the report output for group and date/time information:

1 Change the interface specification of the report procedure to correspond to
required interface changes.

2 Change the logic in the report procedure to handle data requests for group
information; add a %Gu; to the -fmt parameter in the cleartool describe call, to get
group information from ClearCase.

3 Properly extract the group information into a variable after the cleartool describe
call returns its output, so that it can be printed.

4 Determine whether the element’s group is the same group parameter value
entered by the user and print the result of this comparison as a column heading.

5 Print the group variables in the order specified in the interface specification so that
they appear under the correct column heading.

Modified Report Procedure

Here is the modified version of Elements_Created_by_User.prl. This report procedure
is example3.prl in the T0046 package, which is available at
http://www.rational.com/support/downloadcenter/addins/clearcase/contrib/index.jsp.

$start_dir = $0; $start_dir =~ s/\\scripts\\.*/\\scripts/;
$common_dir = $start_dir;
$common_dir =~ s/(.*)\\scripts/$1\\script_tools/;

$cc = ""; if ($cc) {;};
$ct = ""; if ($ct) {;};
$debug = ""; if ($debug) {;};
$skip_path_checks = ""; if ($skip_path_checks) {;};
$CLEARCASE_XN_SFX = ""; if ($CLEARCASE_XN_SFX) {;};
$ctfind_paths = ""; if ($ctfind_paths) {;};
$skip_path_checks = "yes"; if ($skip_path_checks) {;};
$debug = "no"; if ($debug) {;};

sub do_exit {
$err = join(" ", @_);
if ("$err" != "") {
print STDERR "$err\n";
}
sleep(2);
if ("$err" != "") {

exit(1);
} else {
exit(0);
}
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}
open(INCLUDE, "<$common_dir\\common_script.prl") or do_exit("error 
opening include file '$common_dir\\common.prl'"); 
$buf = "";
while(<INCLUDE>) {

$buf = $buf . $_;
}
close(INCLUDE);
eval $buf || do_exit("error on eval of include file 
'$common_dir\\common.prl'"); 

my $args = $ARGV[0];
$args =~ s/%/ /g;
@args = split(";", $args);
my $ccuser = "";
$required_args = 0;
foreach(@args) {

s/^[ ]+//;
s/[ ]+$//;
validate_arg_length($_);
if (/^-i/) {

### customization change *** changed following line
print "description : 'Elements With Group'\n";
print "id : 2016\n";
print "helpfile :\n";
print "parameters : ";

### customization change *** changed following line
print "LOOKIN GROUP";

print "\n";
print_element_rightclick();
print "fields : ";

print "\"Element Path\"(element_xpn, sort 2, 
rightclick) ";
### customization change *** added following 2 lines

print "\"Element’s Group\"(group, sort 1) ";
print "\"Same\"(yes_no) ";

### customization change *** deleted following line
#print "\"Creating User\"(user, sort 1) ";

print "\n";
exit(0);

}
if (/^LOOKIN[ ]*=[ ]*('.*')/) {

check_lookin($1);
$required_args++;
next;

}
### customization change *** deleted following 2 lines

#if (/^USER[ ]*=[\t]*\"*([^\"]*)\"*/) {
#$ccuser = $1;

### customization change *** added following 2 lines
if (/^GROUP[ ]*=[\t]*\"*([^\"]*)\"*/)  {

$ccgroup = $1;
$required_args++;

### customization change *** deleted following line
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#validate_user($ccuser);
next;

}
print STDERR "unrecognized argument: $_\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");
}
if ($required_args != 2) {

print STDERR "usage: not all required arguments specified.\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");

}
### customization change *** deleted following 3 lines
#if ($ccuser =~ /[ ]+/) {
#  do_clearprompt("cleartool find does not allow spaces in user 
names;
# cannot proceed.");
#}

### customization change *** changed following line
open(CTFIND, "cleartool find $ctfind_paths -nxname -print |");
while(<CTFIND>) {

chomp;
### customization change *** added following 6 lines

$grp = ‘cleartool desc -fmt '%Gu' '$_'‘;
if ($grp eq $ccgroup) {

$same = "yes";
} else {
$same = "no";

}
### customization change *** changed following line

print "$_;$grp;$same\n";
#print "$_;$ccuser;\n";

}
do_exit();

Example 4: Changing the Shortcut Menu for the Right-Click Handling
Mechanism

The Elements with Labels report lists all elements with labels for a user-defined
pathname. This report includes one column:

■ Element Path

The change to this report adds the Compare with Previous Version command to the
shortcut menu. Currently, these commands appear on the shortcut menu:

■ Properties of Element
■ Version Tree
■ History
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The report procedure is located in
ccase-home-dir\Reports\Scripts\Elements\Labels\Elements_with_Labels.prl.

Interface Specification

This is the existing interface specification for Elements_with_Labels.prl:

if (/^-i/) {
print "description : ";
print "'Elements with Labels'";
print "\n";
print "id : 2003\n";
print "helpfile :\n";
print "parameters : ";
print "LOOKIN ";
print "LABEL ";
print "\n";
print_element_rightclick();
print "fields : ";
print "\"Element Path\"(element_pn, rightclick, sort 1)";
print "\n";
exit(0);

}

Note the call to print_element_rightclick() in the middle of the interface specification.
The code for this routine is located in\script_tools\common.prl:

sub print_element_rightclick {
print "rightclick : ";
print "Properties_of_Element(single) ";
print "sep ";
print "Version_Tree(single) ";
print "History(single) ";
print "\n";

}

Changes Required

A convention used in the report procedures is to put the same commands on shortcut
menus for all reports that use the same primary sort field. For example, all the reports
whose primary sort key is element or element_xpn display the same set of commands.

To make an additional command available for all reports whose primary sort key is
element or element_xpn, modify the routines stored in \script_rightclick and then edit
the associated routine in \script_tools\common.prl.

To change the report procedure, copy the contents of sub print_element_rightclick
(located in \script_tools\common.prl) and paste it into the appropriate part of the interface
specification. Then, add a declaration to display the new command.
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Modified Report Procedure

Here is the modified version of Elements_with_Labels.prl. This report procedure is
example4.prl in the T0046 package, which is available at
http://www.rational.com/support/downloadcenter/addins/clearcase/contrib/index.jsp.

$start_dir = $0; $start_dir =~ s/\\scripts\\.*/\\scripts/;
$common_dir = $start_dir;
$common_dir =~ s/(.*)\\scripts/$1\\script_tools/;

$cc = ""; if ($cc) {;};
$ct = ""; if ($ct) {;};
$debug = ""; if ($debug) {;};
$skip_path_checks = ""; if ($skip_path_checks) {;};
$CLEARCASE_XN_SFX = ""; if ($CLEARCASE_XN_SFX) {;};
$ctfind_paths = ""; if ($ctfind_paths) {;};
$skip_path_checks = "yes"; if ($skip_path_checks) {;};
$debug = "no"; if ($debug) {;};

sub do_exit {
$err = join(" ", @_);
if ("$err" != "") {

print STDERR "$err\n";
}
sleep(2);
if ("$err" != "") {

exit(1);
} else {
exit(0);

}
}
open(INCLUDE, "<$common_dir\\common_script.prl") or do_exit("error 
opening include file '$common_dir\\common.prl'"); 
$buf = "";
while(<INCLUDE>) {

$buf = $buf . $_;
}
close(INCLUDE);
eval $buf || do_exit("error on eval of include file 
'$common_dir\\common.prl'"); 

my $args = $ARGV[0];
$args =~ s/%/ /g;
@args = split(";", $args);
my $cclabel = "";
$required_args = 0;
foreach(@args) {

s/^[ ]+//;
s/[ ]+$//;
validate_arg_length($_);
if (/^-i/) {

print "description : ";
print "'Elements with Labels'";

print "\n";
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print "id : 2003\n";
print "helpfile :\n";
print "parameters : ";

print "LOOKIN ";
print "LABEL ";

print "\n";
### customization change *** deleted following line

#print_element_rightclick();
### customization change *** added following 7 lines

print "rightclick : ";
print "Properties_of_Element(single) ";
print "sep ";
print "Compare_with_Previous_Version(single) ";
print "Version_Tree(single) ";
print "History(single) ";

print "\n";
print "fields : ";

print "\"Element Path\"(element_pn, rightclick, sort 
1)";

print "\n";
exit(0);

}
if (/^LOOKIN[ ]*=[ ]*('.*')/) {

#print "paths are $1\n";
check_lookin($1);
$required_args++;
next;

}
if (/^LABEL[ ]*=[ ]*'*([^']*)'*/)  {

$cclabel = $1;
#print "label is $cclabel\n";
$required_args++;
next;

}
print STDERR "unrecognized argument: $_\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");
}
if ($required_args != 2) {

print STDERR "usage: not all required arguments specified.\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");

}
open(CTFIND, "cleartool find $ctfind_paths -element 
'lbtype_sub($cclabel)' -print |");
while(<CTFIND>) {

chomp;
($path, $rest) = split $CLEARCASE_XN_SFX, $_, 2;
if ($rest) {;}
print "$path;\n";

}
do_exit();
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Example 5: Adding a New Command to the Report Viewer Shortcut Menu

The Elements with Branches report lists all elements associated with a branch and
pathname that the user provides. This report includes the following columns:

■ Element Path
■ Branch

The report procedure is located in
ccase-home-dir\Reports\Scripts\Elements\Branches\Elements_with_Branches.prl.

The change to this report adds the Merge Manager command to the shortcut menu.
This command is not supplied with ClearCase Reports, so the work required to
included it is different from that in Example 4: Changing the Shortcut Menu for the
Right-Click Handling Mechanism.

These commands currently appear on the shortcut menu:

■ Properties of Element
■ Version Tree
■ History

Interface Specification

This is the existing interface specification for Elements_with_Branches.prl:

if (/^-i/) {
print "description : 'Elements with Branches'\n";
print "id : 2013\n";
print "helpfile :\n";
print "parameters : ";
print "LOOKIN BRANCH";
print "\n";
print_element_rightclick();
print "fields : ";
print "\"Element Path\"(element_xpn, sort 1, rightclick) ";
print "\"Branch\"(branch) ";
print "\n";
exit(0);

}

Changes Required

Making this modification requires a new script for the new command functions.

You must place this script in the \scripts_rightclick directory. (The script can be written in
any of the supported programming languages.) The script must be coded to receive a
stream on input from STDIN from a field that is designated by a rightclick modifier in
the interface specification of the report procedure. For example, to create my_rc.prl,
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which starts clearmrgman.exe (Merge Manager), you must place my_rc.prl in
\scripts_rightclick.

Modified Report Procedure

Here is the modified version of Elements_with_Branches.prl. This report procedure is
example5.prl in the T0046 package, which is available at
http://www.rational.com/support/downloadcenter/addins/clearcase/contrib/index.jsp.

$start_dir = $0; $start_dir =~ s/\\scripts\\.*/\\scripts/;
$common_dir = $start_dir;
$common_dir =~ s/(.*)\\scripts/$1\\script_tools/;

$cc = ""; if ($cc) {;};
$ct = ""; if ($ct) {;};
$debug = ""; if ($debug) {;};
$skip_path_checks = ""; if ($skip_path_checks) {;};
$CLEARCASE_XN_SFX = ""; if ($CLEARCASE_XN_SFX) {;};
$ctfind_paths = ""; if ($ctfind_paths) {;};
$skip_path_checks = "yes"; if ($skip_path_checks) {;};
$debug = "no"; if ($debug) {;};

sub do_exit {
$err = join(" ", @_);
if ("$err" != "") {

print STDERR "$err\n";
}
sleep(2);
if ("$err" != "") {

exit(1);
} else {

exit(0);
}

}
open(INCLUDE, "<$common_dir\\common_script.prl") or do_exit("error 
opening include file '$common_dir\\common.prl'"); 
$buf = "";
while(<INCLUDE>) {

$buf = $buf . $_;
}
close(INCLUDE);
eval $buf || do_exit("error on eval of include file 
'$common_dir\\common.prl'"); 

my $args = $ARGV[0];
$args =~ s/%/ /g;
@args = split(";", $args);
my $ccbranch = "";
$required_args = 0;
foreach(@args) {

s/^[ ]+//;
s/[ ]+$//;
validate_arg_length($_);
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if (/^-i/) {
print "description : 'Elements with Branches'\n";
print "id : 2013\n";
print "helpfile :\n";
print "parameters : ";

print "LOOKIN BRANCH";
print "\n";

### customization change *** deleted following line
#print_element_rightclick();

### customization change *** added following 8 lines
print "rightclick : ";

print "my_rc(single) ";
print "Properties_of_Element(single) ";
print "sep ";
print "Compare_with_Previous_Version(single) ";
print "Version_Tree(single) ";
print "History(single) ";

print "\n";
print "fields : ";

print "\"Element Path\"(element_xpn, sort 1, 
rightclick) ";

print "\"Branch\"(branch) ";
print "\n";

exit(0);
}

if (/^LOOKIN[ ]*=[ ]*('.*')/) {
#print "paths are $1\n";
check_lookin($1);
$required_args++;
next;

}
if (/^BRANCH[ ]*=[ ]*'*([^']*)'*/)  {

$ccbranch = $1;
$required_args++;
next;

}
print STDERR "unrecognized argument: $_\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");
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}
if ($required_args != 2) {

print STDERR "usage: not all required arguments specified.\n";
print STDERR "  ccperl $0 -i\n";
print STDERR "    for script’s interface.\n";
do_exit("\n");

}
open(CTFIND, "cleartool find $ctfind_paths -nxname -branch 
'brtype($ccbranch)' -print |");
while(<CTFIND>) {

chomp;
print "$_;$ccbranch;\n";

}
do_exit();

Here is the new command of my_rc.prl that has been created to support a new shortcut
menu command for starting Merge Manager. This report procedure is available in the
T0046 package, which is available at
http://www.rational.com/support/downloadcenter/addins/clearcase/contrib/index.jsp.

# these are all set by set_record_vars in common_rightclick.prl
#
$CLEARCASE_PN = "", $CLEARCASE_XN_SFX = "", $CLEARCASE_ID_STR = "",
$CLEARCASE_XPN = "";
$CLEARCASE_BRANCH_PATH = "", $CLEARCASE_VERSION_NUMBER = "";
$ELEMENT_RESULTS = "", $BRANCH_RESULTS = "", $VERSION_RESULTS = "";
$results = "";

$debug = "no";

$start_dir = $0; $start_dir =~
s/\\scripts_rightclick\\.*/\\scripts_rightclick/;
$common_dir = $start_dir;
$common_dir =~ s/(.*)\\scripts_rightclick/$1\\script_tools/;

open(INCLUDE, "<$common_dir\\common_rightclick.prl") or do_exit("error 
opening include file '$common_dir\\common_rightclick.prl'"); 
$buf = "";
while(<INCLUDE>) {

$buf = $buf . $_;
}
close(INCLUDE);
eval $buf || do_exit("error on eval of include file 
'$common_dir\\common_rightclick.prl'"); 

if ($CLEARCASE_PN) {;}
if ($CLEARCASE_XN_SFX) {;}
if ($CLEARCASE_ID_STR) {;}
if ($CLEARCASE_XPN) {;}
if ($CLEARCASE_BRANCH_PATH) {;}
if ($CLEARCASE_VERSION_NUMBER) {;}
if ($ELEMENT_RESULTS) {;}
if ($BRANCH_RESULTS) {;}
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if ($VERSION_RESULTS) {;}
if ($debug) {;}

$first = "yes";

while(<STDIN>) {
chomp;
set_record_vars($_);

######################################################################
##
# things to be done a record at a time are done here

if ($first eq "yes") {
$first = "no";
open(COMMAND, "clearmrgman |");
while(<COMMAND>) {;}
close(COMMAND);

}
######################################################################
##
}
# things to be done with the result set as a whole go here

$results =~ s/ $//;

#print "results are $results\n";

Troubleshooting

There are two primary areas that you may need to troubleshoot:

■ Errors in the interface specification
■ Coding high-level languages other than ccperl

Errors in the Interface Specification

These are the common errors you may make when coding the interface specification
for your report procedure:

■ The interface syntax used in your program does not conform to the interface
specification.

■ Invalid parameter names are used for the parameter specification.
■ The rightclick specification calls a routine that does not exist in \right_click.
■ The print statements to STDOUT are in a different order from that defined by the

fields specification.

You can identify errors in the interface specification easily by using the testing script,
ifaces.prl. This script checks customized report procedures that have been written in
ccperl. It is available at clearcase.rational.com/contrib/ T0046/T0046.zip.
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To start the testing script, use a command of this form:

ccperl ifaces.prl <path-to-script-or-directory-tree>

We recommend that you test your report procedures before checking them in to the
shared directory tree that you have configured.

If you do not run the testing script before using your report in Report Builder and a
parsing error occurs in processing the interface specification, the new report does not
appear in the list of reports in the reports pane. There is no feedback; you see the report
description in the reports pane or you see nothing. If you do not see a description, the
parsing error is serious. If you do see a description, the interface specification is
somewhat correct, but you may still be using an invalid parameter, referencing a
nonexistent right-click routine, or sending output in the wrong order to STDOUT.

The Report Builder does not check for valid parameters. For example, consider the
interface specification for a new report procedure, my_custom_report.prl, with the
following interface specification:

description : "This test report asks for a three known parameters and 
two unknown parameters"

id : 2500

parameters : LOOKIN UNKNOWN_1 STREAMS FOO PROJECT

rightclick :

fields : "field 1"(string)

The second and fourth parameters of this interface specification are invalid. At run
time, the description for this report appears in the Report Builder reports pane, but the
second and fourth parameters are displayed as blank lines in the parameter pane
(Figure 64).
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Figure 64 Report Builder Window with Invalid Parameters

However, the testing script detects these errors because these parameter names are not
supplied with ClearCase Reports (see Table 7):

my_custom_report.prl:

desc: this test report asks for a three known parameter and two unknown 
parameters

id: 2500

parm: LOOKIN

***********************

ERROR: illegal parameter: UNKNOWN_1

***********************

continue? (y/n) > y

UNKNOWN_1 STREAMS

***********************

ERROR: illegal parameter: FOOBAR

***********************

continue? (y/n) > y
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Coding High-Level Languages Other Than ccperl

When coding report procedures in languages other than ccperl, such as Visual C++,
Java, Javascript or Visual Basic, refer to the programming examples available in the
T0046 package, which is available at
http://www.rational.com/support/downloadcenter/addins/clearcase/contrib/index.jsp.
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